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A word from the Societies Officer

Societies had an exceptional year this year with increased membership, number of events and support
structures. Achieving sponsorship from the AIB for the SocsBox the societies support, information and ticket
desk in the Hub was very exciting and a testament to the importance of societies to campus life. The
sponsorship also included a new award for events of excellence which provided a bursary of €3000 which was
divided among the six winning societies. There are 71 societies included in this report who submitted end of year
reports, there are an additional small number of societies who have not become dormant yet but who became
inactive during the year. This year also saw the formation of a number of new societies with a few more hoping
to start in September.

The Societies organised and promoted cultural events, which broadened the university experience. They
provided learning opportunities and enlightened lives by inviting thought provoking guest speakers and
organising a wide array of workshops and classes. They created communities by organising social events, team
building opportunities and away trips. The societies were also organised numerous intervarsity events and
attended and participated in intervarsities and competition at national and international level winning a number of
major awards. The Choral Society had an exceptional year winning numerous awards culminating in the national
choir of the year at Navan. According to the societies end of year reports they organised a total of 1357 events
this year. This number may not include all events as the calendar system only came on line in semester two and
not all events may have been added.

The Society awards this year moved to the Galway Bay Hotel for a gala ball and night of celebration which
proved to be a fitting end to a very productive and active year. The winning societies then went to represent the
college at the national Awards in Cork, hosted by Cork IT. NUI Galway had a fantastic night winning three of the
top awards, Best Society for Juggling Society, Best new Society for Business society and best society individual
for Donna Cummins of the Literary and Debating Society and the new Slainte Society. NUI Galway will be
hosting the national awards next year in April.

This year the societies website has been upgraded with many new facilities. The new on line secretaries report
gathers all the events from the new on line calendar and allows for the easy creation of a comprehensive and
detailed report. As you read the reports you will notice that the list of events are described mostly in the future
tense and this is because the report generator picks up the events as posted on the calendar. One of the
questions on the secretaries report was to estimate the number of members based on attendance at least two or
more of their events. A figure of 18,343 emerges which does includes duplications as members can belong to a
number of societies. The current ‘what’s happening guide’ has over 10,000 original e-mails on it so it is safe to
say that a large proportion of the campus are involved in societies on some level.

All the accounts are now done on line from funding requests through to producing comprehensive balance
sheets. Completed society accounts are archived ready to start a new year, note unreconciled cheques are not
included in this years expenditure but remain live for the following year. The societies have had another busy
year financially with expenditure of €561,420, of which €141000 came from university grants the remainder from
other sources. Societies largest expenditure this year was on charity with €184,274 being donated to various
charities which represents 32.82% of their total expenditure. This brings the total which societies have given to
charity in the last four years to €613,160. The old adage that all societies do is ‘drink their money’ was again
disproved with a meagre 3.04% spent on receptions which the societies organised in conjunction with guest
speakers and other special events.

Societies also participated in the ALIVE programme with 82 committee members receiving certificates, next year
we hope to incorporate the ALIVE module into the website and allow members to create their own reports on
line. Society training is very important and on going training is provided for the societies in all aspects of running
a society. Next year we will be also holding one day long session on the second last Saturday in September.

Thanks is also due to the University Societies Committee for their support throughout the year.

| would also like to thank David Geary and all the staff of the Socsbox for their hard work and dedication which
they brought to supporting the societies throughout the year. The SocsBox in addition to overseeing the clubs
and societies computer suite in the Hub also compile the weekly Societies ‘what’'s happening guide’ which is e-
mailed to between 10,000 - 12,000 members each weekend with a full list of all up coming events for the
following week. (the figure fluctuates as all new signups for all societies’ days are added after both societies
days and members can subscribe and unsubscribe themselves throughout the year on the website.

As you read through the societies individual reports, in their own words, you will get a sense of the many
triumphs and the sheer variety and scope of the events which they organised throughout the year. You should
also get a flavour of the commitment and joy which the hard working committee members bring to the difficult
task of running a society and the incredible contribution which they make to campus life and to the wider
community.

Riona Hughes, Societies Officer.



Archaeology Society

The Archaeology Society provides students with the opportunity to explore archaeology outside of university
lectures. We organise guided field trips including an annual trip abroad. We also invite guest speakers to talk on
their particular field of research from outside this University which presents those interested in the subject with
different ideas and approaches to archaeology. Another recent development in the society is our discussion and
involvement in heritage awareness and other topics of debate relating to archaeology. Last but not least, we give
students with similar interests the opportunity to meet up and have great craic - sure what more could you want
than that!!

Arch Soc Events

This year the society held a total of 7 events.

Burren Trip » Burren, Co. Clare on Friday, 21st of October.

Niall Brady on Medieval Rural Settlement » Colm O'hEocha theatre on Thursday, 17th of November.
Niall Brady addressed the society on Medieval Rural Settlement.

Archaeology Society » Kirwan Theatre on Wednesday, 25th of January.

We're looking for someone to fill the position of secretary, as well as some volunteers to help with the Muscailt project
and other events. Anyone with any queries or ideas should also tag along. Afterwards, we'll retire to The Kings Head
for a bit of craic, both old and new faces are welcome so come along.

Visiting Speaker » Colm O hEocha on Wednesday, 8th of February.

Christine Grant, Expert on Burren Archaeology

Archaeology Relic Project Launch » Aras na Mac Léinn Foyer on Wednesday, 22nd of February.
Explore artifacts and relics - participate and watch the exhibition grow

Visiting Speaker » Colm O hEocha on Wednesday, 8th of March.

Dr Graeme Warren, UCD, Mesolithic Archaeology

Visiting Speaker » Dillon Theatre on Tuesday, 21st of March.

Dr Stephen Harrison

Committee 2005/2006

Auditor: Tara Graham Vice-Auditor: Clare Hennigar
Treasurer: Lasairfhiona Swift Secretary: Russell O Regan
GCM: Siobhan McDermott PRO: Bride Greene

GCM: Amanda Balfe

Committee 2006/2007
Auditor: Brid Greene Secretary: Russell O Regan
PRO: Tara Graham GCM: Amanda Balfe

Archaeology Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 126.27 Bank charge €10.75
Fundraising €100 Dinner €124.95
Members Contributions €390 Equipment misc €100
Muscailt €20.53 Fundraising/charity €100
Socs box €90 Gifts €40
Societies day €49.77 Reception €90
USC Grant €583.68 Returned Money €240



Society transport €30

Speaker accommodation €350
Speaker travel €32
Teacher fees €120
Expenditure Total €1237.7
Unreconciled Cheque Total €0
Closing Bank Balance €122.55
Total €1360.25 Total €1360.25

Other Information
We held 20 committee meetings during the year and we have held our AGM. Our total membership stands at
130 members.

Art Society

The Art Society’s main aim is to include as many people as possible in its meetings and classes. We emphasise
our motto ‘Beginners are Welcome’, so as not to exclude anyone who feels they aren’t ‘good’ enough to attend
art classes.

By providing classes in as many different artistic styles as we can, we aim to further develop the artistic skills of
our members. We attempt to do this in a fun and friendly atmosphere so our members feel welcome enough to
relax and enjoy themselves enough to develop their artistic confidence, as well as to make new friends.

A new aim for this year was to set up a second weekly class to deal with the demand for the classes, and to
provide even more variety in artistic skills to our members. We held classes twice a week, which produced our
annual exhibition 'Stranger Than Paradise' and our first comic book ‘Lunatic Fringe'. The exhibition was
dedicated to our friend Tommy Cox, ArtSoc P.R.O. 04-05. The Art Society feels that it has had an extremely
successful and exciting year!

Art Soc Events
This year the society had a total of 34 events that took place.

Regular Events

This year we held 4 events that ran regularly over a number of weeks. These events were as follows:
Drawing Group ran for 7 weeks in AM109, beginning on Wednesday, 12/10/2005.

Life Drawing ran for 2 weeks in IT203, beginning on Monday, 7/11/2005.

Exhibition Class ran for 4 weeks in Art Gallery, beginning on Monday, 16/1/2006.

Comic Book Class ran for 3 weeks in AM107, beginning on Wednesday, 18/1/2006.

Special Events

This year we held 18 special events. These events were as follows:

Intro Meeting » Art Gallery on Monday, 26/9/2005.

Drawing Class » Art Gallery on Monday, 3/10/2005.

Still Life Drawing Class » Art Gallery on Monday, 10/10/2005.
'Spirited Away' » AM150 on Thursday, 13/10/2005.

Life Drawing &Party » Art Gallery & Bar 903 on Monday, 17/10/2005.
Life Drawing » Art Gallery on Monday, 24/10/2005.

Comic Book Drawing Workshop » AM109 on Wednesday, 9/11/2005.
Comic Book Drawing Class » /T203 on Monday, 21/11/2005.
Deadline Comic Book! » AM107 on Wednesday, 8/2/2006.
Deadline Exhibition » Quad Art Gallery on Monday, 13/2/2006.
Drawing Group » AM107 on Wednesday, 15/2/2006.



Exhibition and Comic Book Launch » Orbsen Building on Monday, 20/2/2006.

The Art Society's Annual Exhibition will open at 5PM in the Orbsen Building. The exhibition is entitled 'Stranger Than
Paradise' and includes work by the students of NUIG. It is dedicated to Tommy Cox. The first ArtSoc comic book,
'Lunatic Fringe', will be launched at the same time. With special guests The Contempo Quartet followed by a reception.
Everyone is welcome to attend!

Exhibition 'Stranger Than Paradise' » Orbsen Building on Monday, 20/2/2006.

Stranger Than Paradise » Orbsen Building Foyer on Monday, 20/2/2006.

Launch of Art Soc exhibition and comic book "Lunatic Fringe" with Galway's Contempo String Quartet

Cancelled » Quad Art Gallery on Monday, 6/3/2006.

Drawing Group » AM107 on Wednesday, 8/3/2006.

Caricature Class » /T204 on Monday, 13/3/2006.

Caricature Class, 2euro on the door. Learn to draw caricatures with the help of our teacher! All materials provided
AGM & reception » /T204 on Monday, 20/3/2006.

Committee 2005/2006
Auditor: Jessica Tuohy Vice-Auditor: Emma Finn
Treasurer: Roisin Ni Chonghaile
0.C.M: Gerard Coady

Vice-Auditor: Eibhlin Ni Fhallamhain

Secretary: Jenny Coleman
0.C.M.: lvan Landy
0.C.M: Kate Bluett

Committee 2006/2007
Auditor: Emma Finn Vice-Auditor: Roisin Ni Chonghaile
Treasurer: Roisin Ni Chonghaile

0.C.M.: Gerard Coady

Secretary: David Reilly
0.C.M.: Anna Kenny

Art Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 151.75 Bank charge €3.75
Greenform €148.03 Equipment misc €153.56
Members Contributions €183.75 Materials €152.53
Muscailt €169 Printing €364.8
Socs box €318.5 Prizes €60
Societies day €132 Reception €281.29
Ticket Sales €201.71 Teacher fees €1089.19
USC Grant €1710
Expenditure Total €2105.12
Not included uncashed Cheque Total (€440)
Closing Bank Balance €909.62
Total €3014.74  Total €3014.74

Other Information
We held 4 committee meetings during the year and we have held our AGM. Our total membership stands at 426
members.



Biotechnology Society

The Biotechnology society has been fortunate to have had a spectacular academic year. Its message board was
a stellar success and in the first four months it accumulated over 1,800 posts. That equates to an initial
individual posting rate of several hundred a month making it the most active society message board. What's
more, the message board allows communication and people networks to be maintained, outside the academic
and curricular regiments of student life and facilitates a global network, not bound by geography time zones, or
the individual schedules of students. In addition, our website has been continually improved over the course of
the year and now a photo album feature has been added, which contains many photos of our events. The photo
album may be accessed via the message board.

The society has also engaged in promoting science, biotechnology and cultural activities on campus. Our table
quiz in the Aula Maxima certainly stands as one of the most successful events of the year. Over 40
Biotechnology students spread across all four years of the course attended and participated in what was an
excellent event. An impressive set of prizes was awarded the winning team of Gerald Coyne, Sarah Power,
Cara Lane and Conor O Hara.

The society also has organised a variety of other outstanding events such as trips to the racing track, party’s
nights out and club nights out which have reliably and consistently attracted a large crowd of students. Our
membership number for this year is over 85 students. This is a number which we hope to grow over the coming
years and with it the events and services we provide to our members.

The committee would very much like to thank the U.S.C, the Dept of Biochemistry for its continual support and
encouragement. The society has the capability to develop skills which are not part of the conventional academic
environment, notably but not limited to entrepreneurship leadership and organisational skills. These skills are of
increasing importance to Europe and are recognised now world wide as a European challenges, in the words of
India’s wealthiest women, founder of Biocon, Dr. Kiran Mazumdar Shaw “Europe needs more scientific
entrepreneurs”. We believe that entrepreneurship can be fostered at university level through societies.

Biotech Soc Events

This year the society held a total of 3 events.

Table Quiz » Aula Maxima on Tuesday, 4th of October.

Table Quiz - make up a table of four and join us for a night of questions and great prizes.

Christmas party-night at the dogs » Greyhound Track & Fibbers McGees on Wednesday, 30th of
November.

Join us for a night at the dogs followed by a party in fibber mcGees. All welcome.

Race Night & Party » Dog Track & Cuba on Thursday, 26th of January.

All welcome to a night at the races followed by a party in Bar Cuba with passes to the night club. Entry fee €3 at the
track. See you there.

Committee 2005/2006

Auditor: Martin Melvin Vice-Auditor: Anthony Guinan
Treasurer: Lisa Flynn Secretary: Eoin Murphy
Public Relations Office: Deborha Waters General Committee Members: Pauline Conroy

Bio-Technology Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount



Opening Bank Balance 0 Dinner €50

Fundraising €70 Non Alcoholic Refresh €40
Societies day €60 Prizes €100
Sponsorship €200 Promotions €250
USC Grant €180 Reception €10
Expenditure Total €450
Closing Bank Balance €60
Total €510 Total €510

Other Information
We held 7 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
85 members.

Botany Society

The Botany Society is run in the Botany Department by 3rd and 4th year Botany and Environmental students. It
aims to present botanical issues through a number of talks. Speakers attend from universities and
organisations around Ireland bringing their own knowledge and expertise. It is hoped that this will increase
interest in the area of Botany and also to enlighten national issues to visiting students who are integral to the
society's events.

Botany Soc Events

This year the society held a total of 13 events.

EGM » Mairin De Valera room, Aras de Brun on Wednesday, 28th of September.

Irelands Birdlife & Habitat Conservation » Mairin De Valera room, Aras de Brun on Wednesday, 2nd

of November.

Gunnera-Nostoc an Ancient Association » Mairin De Valera room, Aras de Brun on Tuesday, 8th of
November.

A Natural History of Connemara » Mairin De Valera room, Aras de Brun on Thursday, 17th of
November.

"A World of Botanic Gardens" » Mairin De Valera room, Aras de Brun on Wednesday, 25th of January.
Habitat Mapping - Deborah Tiernan » Mairin de Valera, Botany Dept. Block C on Thursday, 9th of
February.

People and Nature: Galway Biodiversity » Seminar Room, Botany Dept.,Aras de Brun on
Wednesday, 15th of February.

The Botanical Ecology of Stone Walls » Mairin deValera,Botany Dept.Aras de Brun on Tuesday, 21st
of February.

Desmid-diversity in Connemara-a hot spot » Botany dept seminar room on Wednesday, 1st of
March.

Flora & Fauna of Uganda » Mairin De Valera room, Aras de Brun on Tuesday, 14th of March.

Bot Soc trip! » Aran Islands on Saturday, 18th of March.

AGM » Mairin De Valera room, Aras de Brun on Wednesday, 29th of March.

Evolution & Composition of Cell Walls » Mairin De Valera room, Aras de Brun on Wednesday, 29th of
March.

Committee 2005/2006

Auditor: Helen Carty Vice-Auditor: George Percival
Treasurer: Anne Patten Secretary: Sally Marshall
PRO: Caitriona Maher Staff liasion: Dr. Dagmar Stengel



Zoosoc Liaison Officer: Marie Duffy

Committee 2006/2007

Auditor: Kieran Hall Vice-Auditor: Niall Higgins
Treasurer: Mark Loughnane Secretary: Rory Hodd
Aine Bird: 0877829866

Botany Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 0 Bank charge €6.28
Members Contributions €240 Dinner €333.72
Societies day €3.02 Reception €529.89
Sponsorship €45 Society accommodation €338
USC Grant €2365.85  Society transport €480
Speaker accommodation €50
Speaker travel €120
Expenditure Total €1857.89
Does not include uncashed Cheque Total (€71.85)
Closing Bank Balance €795.98
Total €2653.87 Total €2653.87

Other Information
We held 7 committee meetings during the year and we have held our AGM. Our total membership stands at 185

Business Society

Our society aims to get more students thinking about business and opening their mind to new ideas. It is really
there to help any student that wants to get involved in Business in any form in the future. It's also there to simply
educate those of us that have an interest in any form of commerce and want to hear from people outside the
lecture hall, people that have had real life experiences in the workplace. We also feel that it is a very important
social society and we are proud to say that if societies are there to bring people of similar minds together, it
accomplishes this.

The society was also proud to win Best New Society at both the NUI Galway Society Awards and then in BICS
in April.

Business Society Events

This year the society held a total of 17 events.

First Meeting » Concourse on Wednesday, 28th of September.

John Lawlor Talk » Concourse on Wednesday, 5th of October.

Mr. John Lawlor Chief sales rep for Roadstone Ireland spoke about his experiences in Negotiations and informed us
how we have to think and focus in order to get what we want in not just a business situation but also in life.

Michael Keane Talk » Concourse on Wednesday, 12th of October.

Mr. Michael Keane, the newly appointed Dean of Commerce and President of our society gave his first address to the
students at Business Soc. He spoke about the need for students to get involved in societies like this and how delighted



he was to see that the university now had a group of students that were willing to promote commerce in the university.
We also had our EGM to elect first year rep.

Mcdara Hosty Talk » Concourse on Wednesday, 19th of October.

Mr. Mcdara Hosty, one of the most well known marketing gurus in Ireland came to the society. It was on this night that
we realised that we would have to move from the 100 seater Larmour Theatre as for the 3rd night in a row we had
students queuing outside and having to sit in the isles. Mcdaras speech was entitled “How to Sell yourself successfully”
and was honestly one of the most entertaining 90 minutes of my life. With massive crowd involvement he showed us
how to step out into the world with confidence, not just in business but in life in general.

Imelda Joyce Talk » Concourse on Wednesday, 2nd of November.

Mrs. Imelda Joyce, was an amazing speaker on Business psychology. She told us about how to control the mind and
showed us footage of her getting a very serious operation without using any atheistic but her mind-power. She now
runs a large amount of successful gyms throughout Dublin city. It was strange to meet a short woman in her late 50s,
that looked like she couldn’t hurt a fly and the discovering that she was also one of Irelands top Karate Fighters and
runs a marathon every month. She spoke about how she used the same psychology she uses in sport to run a
successful business.

Student Mentoring Programme » Bowling on Tuesday, 8th of November.

The JCI LINK Student Mentoring Programme had a bowling night. Here students got the chance to team up with a
person in the industry that they wished to get involved in and get to know them on a personal basis. Business Soc had
been promoting the mentoring programme throughout the year and had helped out the JCI and Student Services in
organising it. Many Business Soc members learned more about industries they would like to get involved in and also
had the chance to talk to these people in a relaxed atmosphere.

Val J. Murray Talk » Concourse on Wednesday, 16th of November.

Val J. Murray, of Goodbodies Stockbrokers came to launch our Stockbroking competition and also to give us a small
walk through the markets. Many of the members (myself included) have a large amount of interest in the markets and
finally got a chance to ask a real stockbroker questions that we had but could never find an answer to.

'Invest the best' Talk » Concourse on Wednesday, 18th of January.

Invest Like The Best came to Business society. This group, started by Rory Gillen, one of Irelands richest men and
stock market guru, told us how to invest in the markets wisely. Attendance was very good for a midday event. It was
interesting to hear this mans own experiences on the markets. He spoke about investing in shares when you think they
are at their worst and other secrets like that. Since then some society members have been in contact with Rory and
one member now works for this company.

Commerce Ball » Salthill Hotel on Thursday, 26th of January.

Business Soc :: Mr. Nick Leeson » Cairnes Theatre (Concourse) on Wednesday, 1st of February.

The collapse of Barings Bank (personal bank to HM The Queen) in 1995 and Nick Leeson's role in it, is one of the most
spectacular debacles in modern financial history. How could one trader bring down the banking empire that had funded
the Napoleonic Wars? Curiosity, intrigue and sympathy have been the various reactions to this man's incredible life
story. Following Barings' collapse, Nick Leeson was sentenced to six and half years in a gang-ridden Singaporean jail,
in conditions that defy belief, while at the same time, his wife left him and he was diagnosed with colon cancer. He
wrote the book "Rogue Trader" based on these events, which was then made into a film starring Ewan McGregor. This
will be followed by a reception in The Cellar.

Trip to Berlin » Berlin on Tuesday, 7th of February.

The Globalization Discussion » Concourse on Wednesday, 22nd of February.

Publication of The Cairnes Review » Concourse on Tuesday, 28th of February.

“The Cairnes Review” is the first Business Soc Publication, named after the brilliant economist which attended our
university. This has submissions from students, staff and minister for Trade, Enterprise and Employment, Micheal
Martins expressing his admiration of the Business Soc and what he believes students must do in order to maintain
economic growth. We hope to give an issue to every interested student as well as to businesses throughout Ireland to
promote the society and NUI Galway. Financed by external sponsors and USC.

AGM » Larmor Theatre on Wednesday, 8th of March.

Mr. O Ceide Talk » Concourse on Wednesday, 15th of March.

CEO Aer Arann. Mr. O Ceide gave an excellent speech about entrepaneurship and how the Irish economy needs
students that will not just go to university to learn how to become a doctor, an accountant or a scientist but students



that get involved in societies and create ideas and have fun. With a large amount of people below him he feels he
would hire people with more society experience than people with just high grades. He acknowledged the need for the
“Business Soceity” and was delighted to see that students are ready to think for themselves and shape their own
education. He wished that when he was a student that a society like this existed as it would have given him prepared
him a lot for the difficulties one encounters in the business world.

Rag Week Intersoc Football » NUI,G on Monday, 27th of March.

Commerce Faculty Party » Publication Launch, NUI,G on Friday, 31st of March.

Commerce Faculty Party » Publication Launch, NUI,G on Friday, 31st of March.

Committee 2005/2006

Auditor: David Keane Vice-Auditor: Darren Glynn
Treasurer: Joe Duggan Secretary: David lynch

Membership Officer: Lorraine Hosty SDO: Shane Ryan

PRO: Bryan Connolly Communication Officer: Shane Duffy

First Year Rep: Sinéad Barry

Business Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 20.53 Ball €17675
Balls €18829.22 Bank charge €18.38
Members Contributions €880 Dinner €107.8
Sponsorship €750 Entertainment €624.15
USC Grant €3252.9 Non Alcoholic Refresh €35.15
Reception €935.25
Society transport €3389
Stationary €25
Expenditure Total €22809.73
Does not include uncashed Cheque Total (€18.5)
Closing Bank Balance €922.92
Total €23732.65 Total €23732.65

Other Information
We held 26 committee meetings during the year and we have held our AGM. Our total membership stands at
700 members.

Chemistry Society
The chemistry society for the 2005/2006, has run a series of lectures aimed at postgraduate and staff levels , but
4th year undergraduates were encouraged to attend also. These lectures detailed research work carried out at
different universities in Ireland, United Kingdom and America by the visiting lecturer. Some lectures were also
carried out by the staff of NUIG.

A reception was held after all the lectures and the visiting lecturer was brought to Dinner after the reception.

A number of gatherings were organised for the postgraduates of the chemistry department, including a welcome
night for the new 1st year post grads, Christmas party and weekend away. A 4th year undergraduate party was



also held for the current 4th years , with the aim of introducing the postgraduate students and answering any
questions on postgraduate studies in the college they may have had.

Chemistry Soc Events
This year the society held a total of 13 events.

Prof. Desmond Cunningham » Dillon Theatre on Thursday, 13th of October.
Prof. Tony Barrett » Dillon Theatre on Thursday, 20th of October.

Dr. Andrew McCarthy » Dillon Theatre on Thursday, 27th of October.

Prof. Joseph Bozzelli » Dillon Theatre on Thursday, 3rd of November.

Dr. Niclaus Karlsson » Dillon Theatre on Tuesday, 29th of November.

Prof. Tadhg Begley » Dillon Theatre on Thursday, 1st of December.

Prof. Robert Woods » Dillon Theatre on Thursday, 15th of December.

Prof. Thorfinnur Gunnlaugsson » Dillon Theatre on Sunday, 1st of January.
Trip to Ballybunion » Ballybunion on Sunday, 26th of March.

Prof A.L. de Silva » Dillon Theatre on Sunday, 26th of March.

Its a Gas Life » Dillon Theatre on Tuesday, 28th of March.

Dr. Maria Navarro » Dillon Theatre on Monday, 3rd of April.

Professor Mann » Dillon theatre on Monday, 10th of April.

Dr. Stephen E.J Bell » Dillon Theatre on Thursday, 20th of April.

Committee 2005/2006
Auditor: Steven Dooley Treasurer: Laverne Mullen

Secretary: Chiara Mc Donagh P.R.O: Orla Gibbons
Corresponding Secretary: Neil Maguire

Chemistry Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 2310.33 Bank charge €44.25
Fundraising €297.97 Dinner €303.05
Societies day €104.5 Entertainment €550
Sponsorship €2651.58  Fundraising/charity €400
USC Grant €3974.35 Materials €121
Non Alcoholic Refresh €500
Printing €54.75
Promotions €35.46
Reception €1082.44
Society accommodation €932.96
Speaker accommodation €618.1
Speaker travel €373.7
Expenditure Total €5015.71
Does not include Uncashed Cheque Total (€420)
Closing Bank Balance €4323.02
Total €9338.73  Total €9338.73
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Other Information

We held 30 committee meetings during the year. We have not held our AGM yet. Our total membership stands

at 92 members.

Chess Society

Describing our society this year? Right, well, we played chess. Total members - somewhere around 150. Active

members - around 30 regulars. What did we do? Besides playing chess? Well not much. We sent a team to

intervarsities, but there again, all we did was play chess...

And we organised a charity event for RAG week. But, due to our complete lack of imagination, yet again, I'm

afraid we played chess. Yes, we played some highly successful chess this year...

Chess Soc Events

This year the society had a total of 18 events that took place. These events can be divided into two categories:

regular and special events.

Regular Events

This year we held 1 event that ran regularly over a number of weeks. This event was as follows:
Chess ran for 13 weeks in AC214, beginning on Thursday, 2/2/2006.

Special Events

This year we held 5 special events. These events were as follows:

Meeting » AC 214 on Thursday, 12/1/2006.
Chess » AC214 on Thursday, 19/1/2006.

Extra Long Chess » Smokey Joes on Monday, 27/2/2006.
Rag Week Chess Tournament » Smokeys on Monday, 27/2/2006.

AGM » AC214 initially... on Thursday, 30/3/2006.

Committee 2005/2006
Auditor: Fintan Hegarty
Treasurer: Barry Curran
P.R.O.: Claire Roche

GCM: Chris Green

Committee 2006/2007
Auditor: Zaidan Zulkipli

Treasurer: Mark Jennings

Chess Society Balance Sheet

Income
Income Category Amount
Opening Bank Balance 10
Fundraising €800
Members Contributions €80
USC Grant €839

Vice-Auditor: James Lovett
Secretary: Beartla de Burca
GCM: Sorcha Schnittger
GCM: Joe Hall-Reppen

Vice-Auditor: Fintan Hegarty
Secretary: Chris Green

Expenditure
Expenditure Category Amount
Affill/Mem fees €300
Entry fees €209
Fundraising/charity €800
Prizes €100
Reception €100
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Society accomodation €210

Expenditure Total €1719
Closing Bank Balance €10
Total €1729 Total €1729

Other Information
We held 2 committee meetings during the year and we have held our AGM. Our total membership stands at 150
members.

Chocolate Society

The chocolate society was established as a provisional society in the summer of 2004. In September of 2005 the
society was allowed to become a society with full recognition in the university. The purpose of the society is to
cater for the proportion of the student population with a passion for fin chocolate, creating a social space where
these individuals can meet. Society’s day was a success with an amazing 700 members signing up. Following a
committee of 10 members was set up at an EGM. The society was off to a slow start this year due to an entirely
new committee, made up of mostly first years and study abroad students. The committee got its bearings by
showing films to the students while having a chocolate intermission for each. The turnout at each event was
phenomenal and ended up being much higher than any of the previous year’s events. There are still many
obstacles to overcome, although it seems that getting the word out about the society has been more of a
success this year, possibly due to this being its second year. A new committee was elected at the AGM, made
up of some former members of the committee with many new ideas for the next year.

Chocolate Society Events

This year the society held a total of 5 events.

EGM » AC204 on Thursday, 22nd of September.

Film: Willy Wonka and The Chocolate Fact » AM150 O'Thuthall on Thursday, 1st of December.
Charlie+the Chocolate Factory » O'Flaherty Theatre on Wednesday, 25th of January.

AGM » [T202 on Thursday, 30th of March.

Film: Chocolat (also EGM) » McMunn Theatre on Tuesday, 18th of April.

Committee 2005/2006

Auditor: Grace Flannery Vice-Auditor: Domhnall OShuaghnessy
Treasurer: Ross Lydon Secretary: Erica Gillingham

Events Officer: Jennifer Gouailhardon Events Officer: Stephanie Perry
Events Officer: Jessica Keber Events Officer: Brian Toft

Press Officer: Chloe Farkas Events Officer: Ashley Maguire

Committee 2006/2007
Auditor: Domhnall OShaughnessy Vice-Auditor: Jessica OShaughnessy
Treasurer: Ross Lydon

Chocolate Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 1001.6 Bank charge €75
Greenform €420 Fundraising/charity €681
Societies day €453 Non Alcoholic Refresh €290
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USC Grant €200 Returned Money €420

Expenditure Total €1398.5
Closing Bank Balance €676.1
Total €2074.6 Total €2074.6

Other Information
We held 12 committee meetings during the year and we have held our AGM. Our total membership stands at
881 members.

Choral Society

The Choral society enjoyed yet another successful year. Overall the numbers of visiting students in the choir
rose as did the number of post grad. Students. Peter Mannion continued to conduct the choir and the male voice
section whilst Fiona Kenny and Mairead Crushell directed the ladies ensemble.

‘Ever Free’ the choral society new CD was released in semester Il but was recorded at the Winter Concert, held
in November. It was the second release from the group, and arguably a much better recording thanks to Mr.
Fergal Tuohy. ‘Ever Free’ contained tracks that were previously unrecorded such as ‘Ar nAthair by David
Hamilton, which the choir commissioned, and ‘Here in Cool Grott’ by Rihards Dubra. The CD also featured
beautiful photography from Emma Brennan from the Alto line.

Competition wise the year was again successful with the male voice ensemble winning the two male voice
categories at the Sligo Choral Festival whilst the mixed choir took second place in competition C (light choral
music)-just 0.5% behind Madrigal 75-the chamber choir who are current ‘Choir of the Year’ winners. Judge Greg
Beardsell commented on the performances by saying how exceptional our leader was and on the quality of the
singing, saying that the spirited performance did not come from the mouth but the body and that the excesses of
African style music was well preserved by the youth choir. He also wished he had access to our repertoire while
he was in college.

In February the group traveled to Limerick for the annual church music festival, of which the group were reigning
champions in two of the four categories. Mr. Paul McKee, adjudicator, lavished praise on the choir and in
particular the creation of space and stillness in the piece ‘O Ndit’, in his opinion the interpretation was both
arrogant and sensational, our command of the audiences attention was stunning! Despite this praise the group
finished third!.

In April the choir competed in Italy and in Cork (for the first time in 20+ years) and in May we traveled to Navan
for the choir of the year competition. We came second at the International choral competition in Riva del Garda.
In Navan at the National chori of the year competition we won best chamber choir, best ladies choir and best
choir of the year.

A new development for the choir has been the use of new line cd’s that are made by Louise Malone, Wexford,
who emails them as mp3 files which are then downloaded by the choir members who can listen and learn new
material. We have found this to be a most efficient way of learning music quickly. Rehearsals are now every
Monday night and every second Tuesday night and again this has benefited the choir immensely. We also
emailed music and newsletters to choir members as this was the most efficient way to give out both. Our bulletin
boards and ChoralSoc announce emails were used extensively during the year to keep members informed of
what was going on.

We premiered the piece ‘Tri Seanfhocail’ during our AIB event of Excellence-Spring concert in March, the piece,

by Douglas Gunn, was commissioned by the choir. We will compete with this 5minute long work in Italy, Cork
and Navan. UCC Choral Society also joined us in the concert as did the new French Choir from NUIG.
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Both Brendan O’Connor and Anne Michel Durham gave the choir workshops on how to breathe properly,
pronunciation and all things choral during the year. The choir also sang at events for the Foundation Office (gala
banquet), Societies Office (Society Awards) and ALIVE programme (Award ceremony) and performed a recital
during the Muscailt festival. We’ve also performed in the Burren and gone busking during the year.

Musically the year was very diverse with many styles of music being performed. Indeed more money than ever
was used to purchase new musical material from Canada and Iceland for example.

Choral Soc Events
This year the society had a total of 37 events that took place.

Regular Events

This year we held 1 event that ran regularly over a number of weeks. This event was as follows:

Practice ran for 30 weeks in Chapel, beginning on Monday, 5/9/2005.

Weekly rehearsal new members welcome. If you have a voice and want to sing join us. We have concerts and trips
away planned.

Special Events

This year we held 7 special events. These events were as follows:

Limerick Church Music Fest. » Limerick City on Tuesday, 3/1/2006.

Choral Society will attempt to retain their titles from the Limerick Church Music Festival.

Choral Soc Sing-a-thon » All over Campus on Thursday, 23/2/2006.

Sean Fhocail » Aula Maxima on Thursday, 23/2/2006.

Choral Soc: Spring Concert » St. Nicholas Church on Saturday, 11/3/2006.

Choral Society presents its 3rd annual springtime concert. Our visiting choir for this concert is the UCC Choral Society.
Colin Mawby, a famed composer, will conduct the choirs in his setting of 'Ave Verum Corpus'. The concert is 10/5 euro
and doors will open at 8.30pm Choral Society's CD "Ever Free" is still available to purchase from the socs box

Choral Soc: Riva del Garda Choral Comps » Riva del Garda; Italy on Sunday, 9/4/2006.

Choral Soc: Cork International Choral Festival » Cork City Hall, May 2006.

Choral Soc: Navan Chori of the Year competition » Navan May 2006.

Committee 2005/2006

Auditor: Peter Mannion Treasurer: Laverne Mullen

Choral Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance -463.27 Affill/Mem fees €150
Fundraising €958 Bank charge €61.47
Members Contributions €11130 Costumes €231
Socs box €230 Entry fees €1200
Societies day €220 Equipment misc €317
Sponsorship €1885 Hall hire €300
USC Grant €17465.68 Materials €2313.22
Performing rights €1305
Printing €1600
Society accomodation €9803
Society transport €9277
Expenditure Total €26557.69
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Does not include Uncashed Cheque Total (€1140)
Closing Bank Balance €4867.72
Total €31425.41  Total €31425.41

Other Information
We held committee meetings during the year. We have not held our AGM yet. Our total membership stands at
93 members.

Christian Union Society

We are an inter-denominational, informal society for anyone interested in exploring the Christian faith in a
relaxed atmosphere through praise, worship and bible studies. We also organise weekends away, guest
speakers and a Ball at the end of the year. We meet every Wednesday at 7pm in the common room of the
college chapel.

Christian Union Soc Events
This year the society had a total of 24 events that took place. These events can be divided into two categories:
regular and special events.

Regular Events

This year we held 2 events that ran regularly over a number of weeks. These events were as follows:

Weekly Meeting ran for 11 weeks in Chapel, beginning on Wednesday, 21/9/2005.

Meeting ran for 10 weeks in Common room in the Chapel, beginning on Wednesday, 18/1/2006.

Weekly get together, guest speakers, social events and watch out for our trips away. All welcome of all faiths and none
to explore relevant themes from the bible.

Special Events

This year we held 3 special events. These events were as follows:

Irish Conference » Kilkenny on Thursday, 3/11/2005.

Conference ran by IFES Ireland. Its a coming together of all Christian student societies around Ireland. Guest speakers
and seminars throughout the weekend.

Joint Colleges » Avoca, Wicklow on Wednesday, 8/2/2006.

Weekend away ran by IFES Ireland. Its a gathering of all Christian Student Societies in the republic of Ireland. Guest
Speaker for the weekend.

Econ » Wesley College on Friday, 7/4/2006.

Leadership training weekend.

Committee 2005/2006
Auditor: Helen Lane Vice-Auditor: Naomi Black
Treasurer: Declan Kelly Secretary: Muireann O Loughlin

Committee 2006/2007

Auditor: Naomi Black Vice-Auditor: Muireann O
Treasurer: Helen Lane Secretary: Alice Dawson
Music coordinater: Declan Kelly
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Christian Union Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 53.96 Bank charge €16.44

USC Grant €1782 Gifts €54.61
Reception €73
Society accommodation €660
Society transport €550
Speaker accommodation €65
Speaker travel €265
Expenditure Total €1684.05
Cash In Hand €27.39
Closing Bank Balance €124.52

Total €1835.96 Total €1835.96

Other Information
We held 26 committee meetings during the year and we have held our AGM. Our total membership stands at 90
members.

Classics Society

The Classics Society aims to provide a means for students (and others) to further their knowledge of Classical
Greece and Rome. Each semester we present a number of talks by visiting lecturers from both Irish and
foreign institutes of learning. We also hold social events where people who are interested in the classical world
may meet and discuss their common interests. The highlight of the year was our trip to Rome.

Classics Soc Events

This year the society held a total of 10 events.

Catullan Love Poetry » Mairtin O Thnuthail Theatre, AMB on Thursday, 15th of September.

Greek Tyrants of Sicily » Dillon Theatre, Concourse. on Tuesday, 25th of October.

Coinage and the Roman Historian » College Campus on Wednesday, 16th of November.

A G M » The Hub on Thursday, 24th of November.

Christmas Fancy Dress (with Arch Soc) » The Hub on Thursday, 24th of November.

Roman Classical Evening » Colm OhEocha theatre AMB on Tuesday, 17th of January.

This was the re-inauguration of the Margaret Heavey Lecture by special guest speake, Professor Tim Cornell.
Professor Cornell is one of the leading authorities on Archaic Rome and one of the world's greatest English-speaking
Classical scholars. The title of his lecture is History, Biography & Memoirs of Ancient Rome. This event was followed
by a special reception and dinner.

A Talk on Lucretius » Mairtin O Thnuthail Theatre, AMB on Tuesday, 7th of February.

Spartacus & fall of Roman Republic » Mairtin O Thnuthail Theatre, AMB on Tuesday, 7th of March.

Dr Theresa Urbainczyk, Dept of Classics, University College Dublin "Spartacus and fall of the Roman Republic"
Theresa Urbainczyk is a Senior Lecturer in the School of Classics at University College Dublin. Her research interests
lie in the fields of historiography, slavery and social and economic history. The author of three books, her most recent,
entitled Spartacus, was published by Bristol Classical Press in 2004.

Classics Soc AGM » Dillon Theatre on Tuesday, 28th of March.

Cultural trip to Rome » Rome on Saturday, 1st of April.
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Committee 2005/2006

Auditor: Suzanne Young Vice-Auditor: Linda Jardine
Treasurer: Patricia Bergan Secretary: Jane O'Dwyer
P.R.O.: Juile-Anne Meaney SPECIAL EVENTS: Anthony Daly

Classics Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category
Opening Bank Balance 510.37 Affill/Mem fees
Members Contributions €2945.19 Bank charge
Societies day €26.26 Dinner
Ticket Sales €460 Materials
USC Grant €3732.57 Reception

Society transport

Speaker accomodation

Speaker travel

Expenditure Total

Unreconciled Cheque Total

Closing Bank Balance
Total €7674.39 Total

Other Information

Amount
€42.94
€5.32
€466.5
€12.55
€365.59
€4033
€441.75
€304.38
€5672.03
€0
€2002.36
€7674.39

We held 9 committee meetings during the year. We have not held our AGM yet. Our total membership stands at

141 members.

Comedy Society

The purpose of our society is to promote comedy and encourage new comedy talent within the university. We
did this by putting on a series of shows, two in early October, one in January and one during Muscaillt. During
these shows we performed stand-up comedy and sketches, written and performed by the members of the
society. We also had our first ever guest comedian, David O'Doherty, who performed for us on the 13th of Feb.
Also we arrange for our members to perform stand-up at the two main comedy clubs in Galway, if any member

should wish to do so.

Comedy Soc Events

This year the society held a total of 4 events.

Comedy Show » BOI theatre on Thursday, 6th of October.

Sketch comedy » Bank of Ireland Theatre on Thursday, 26th of January.

David O'Doherty » Larmor Theatre on Monday, 13th of February.

Stand-up & Sketches » Bank of Ireland Theatre on Wednesday, 22nd of February.

Committee 2005/2006

Auditor: Kieran Lawless Vice-Auditor: Giles Brody
Treasurer: Eoin Shaughnessy Secretary: Darren Nestor
PRO: Karen Walsh
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Committee 2006/2007
Auditor: Kieran Lawless Vice-Auditor: Giles Brody
P.R.O: Karen Walsh

Comedy Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 0 Equipment misc €95
Greenform €190 Reception €70
Socs box €199 Teacher fees €555
Ticket Sales €425
Expenditure Total €720
Unreconciled Cheque Total €0
Closing Bank Balance €94
Total €814 Total €814

Other Information
We held 17 committee meetings during the year and we have held our AGM. Our total membership stands at
members.

Complementary Therapy Society

The complementary society had a very fruitful year. We had experts coming in to give talks on such varied
subjects as Prana Healing and Cleaning yourself to Death. Work began on an Organic Herb Garden which is
located at the rear of the General Practicioner's Unit on the Distillary Road. All Welcome to peruse and enjoy!
Dance Therapy courses organsied by the society in semester one was so successful it ran again in semester
two. At the end of the year we reached our apotheosis with a large Holistic Fair, which had 20 market stalls,
tharapists and various workshops inculding tribal drumming, Tai Chi and Yoga.

Complementary Therapy Soc Events
This year the society had a total of 10 events that took place.

Complementary Therapy Soc Events
This year the society had a total of 10 events that took place. These events can be divided into two categories:
regular and special events.

Modern Dance Class ran for 3 weeks in Week 1 Bank of Ireland theatre, beginning on Wednesday,
25/1/2006.

Cleaning yourself to death » Common Room, Chapel on Tuesday, 7/3/2006.

The real truth behind chemical toxicity in personal care products. Speaker is Barry O'Brien

Holistic Peace Day Fayre » Foyer Aras na Macléinn on Wednesday, 22/3/2006.

Market stalls with tasty foods, jewellery and crystals, music and a host of complementary therapies. Workshops & talks
on meditation, dance therapy, taichi, yoga & a drumming circle.

Meditation Introductory Talk&Class » Bank of Ireland Theatre on Wednesday, 22/3/2006.

Dance Therapy Workshop » Bank of Ireland Theatre on Wednesday, 22/3/2006.

Get the balance right , a dance movement therapy exploration enjoying our differences. With Bernie Divilly

Tai Chi Talk & Demo » Bank of Ireland Theatre on Wednesday, 22/3/2006.
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Yoga Talk & Demo » Bank of Ireland Theatre on Wednesday, 22/3/2006.

Find out about yogas many aspects, the postures(asanas) & breathing exercises(pranayama). Excellent for reducing
stress &increasing wellbeing. With Aisling (an seomra yoga)

Drumming Circle » Bank of Ireland Theatre on Wednesday, 22/3/2006.

Committee 2005/2006

Auditor: Ciara Brady,Andi Vice-Auditor: Eoin.M. Rabbitt -Bowles
Treasurer: Louise Gleeson Secretary: Andi Ludden Reilly
OCM: Jimmy Butler PRO: Conor Graham

Complementary Therapy Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 296.43 Dinner €250

Fundraising €40 Fundraising/charity €40

Greenform €624.75 Materials €75

USC Grant €690.4 Printing €101.75
Reception €100
Speaker accommodation €75
Speaker travel €11.9
Teacher fees €561.1
Expenditure Total €1214.75
Unreconciled Cheque Total €0
Closing Bank Balance €436.83

Total €1651.58 Total €1651.58

Other Information
We held 5 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
30 members.

Computer Society
This year proved a very successful one for the society as we continued our workshop series on web
development and alternative operating systems with tutorials on html, css and linux.

Out new techtalk event, the annual Christmas party and a number of movie nights kept ensured that new
members were made as welcome as possible and guest speakers from ICHEC, DERI, and HEANET provided
something to interest everyone during the year.

In February, we ran our IT and Motorsport Day for the third time and it once again proved very successfull,
drawing a crowd in excess of 100 people to the evening driver forum which was hosted by journalist Brian
Patterson and attended by Tarmac Champions Eugene Donnelly & Paul Kiely and their fellow competitors and
rivals Dermot O'Gorman, Derek McGarrrity, Tim McNulty and Anthony Nestor.

The highlight of the year came in April when we held the Youth Outreach Programme, sponsored by the AIB as
part of their Event of Excellence Awards. 17 Students from 4 schools. During the day the students animated
their own clay movie, composed music, setup a video conference, broadcast their own version of the news and
weather live on the Internet, built a lego robot, designed a 3D room for a game, built both a wired and wireless
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lab network, and put together a flash movie for the Internet. The society are very greatfull to Tom Callanan and
Alan Fitzpatrick from Galmac, Sean O'Brien from HEAnet, Brendan Smith from DERI, Fergal Costello and
Darren Doherty from the IT Department in NUI, Galway who all helped out on the day by giving talks, demos and
tutorials.

Compsoc Events

This year the society held a total of 13 events.

Revolution OS » McMunn Theatre on Thursday, 20th of October.

Hackers, Programmers & Rebels Unite! This Thursday, 20th October we will be showing Revolution OS in the McMunn
Theatre at 8pm. This award winning documentary tells the inside story of the hackers who rebelled against the
proprietary software model to create GNU/Linux and the Open Source movement. Featuring interviews with Linus
Torvalds and Richard Stallman, Revolution OS is the best way to get the inside story on what drove programmers into
the idea of freely available source code. We hope to see you all there!

HTML Workshop » Arts Suite on Tuesday, 25th of October.

The Pirates of Silicon Valley » McMunn Theatre on Thursday, 3rd of November.

This engaging look at the story of the rivalry of Apple founder Steve Jobs and Microsoft head Bill Gates in the early
years of both their respective companies from their garage startups to industry dominance.

TechTalk » AC215 on Friday, 11th of November.

Christmas Party! » City Limits and De Burgos on Thursday, 24th of November.

LaTex document preparation » Arts Faculty Suite - Concourse on Tuesday, 24th of January.

Document preparation using LaTeX. All welcome to attend!

Day of IT & Motorsport » Aras na MacLeinn / O'Flaherty on Thursday, 2nd of February.

Semantic Web 2.0 » /T125G on Thursday, 9th of February.

ICHEC talk » Fottrell Theatre (AM200) on Wednesday, 8th of March.

Sign Up session » Arts Faculty Suite on Tuesday, 14th of March.

Cascading Style Sheets Tutorial » Arts Faculty Suite (Concourse) on Tuesday, 14th of March.

AGM » [T125G on Thursday, 30th of March.

Youth Outreach Day 2006 » /T Building on Saturday, 8th of April.

The NUI, Galway Computer Society are offering a chance to secondary school students around Galway to participate
in a series of free technology-based workshops.

The programme will provide students with a hands-on introduction to some of the most exciting and cutting-edge
technologies in use today.

Students enrolled in the programme are invited into NUI, Galway next Saturday 8th April to participate in workshops
on:

Alternative Operating Systems e.g. Linux, Mac OS
Lego Robotics and Beginners Programming
Video Conferencing and Streaming

Game Design

Networking

Computer Hardware

Committee 2005/2006

Auditor: Patrick O Flaherty Vice-Auditor: David Gilmore
Treasurer: Shane Duffy Secretary: Fionnuala Gibney
OCM: Gabriel Garret OCM: Nicholas Geoghan

OCM: Rory Donohue
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Committee 2006/2007
Auditor: David Gilmore Vice-Auditor: Patrick OFlaherty
Treasurer: Nicholas Geoghan Secretary: Colm McLean

Compsoc Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 2053 Bank charge €3.75

Greenform €400 Dinner €307.6

Societies day €410 Equipment misc €1027.61

USC Grant €1130 Gifts €149.9
Reception €683
Speaker accommodation €180.55
Expenditure Total €2352.41
Does not include Unreconciled Cheque Total (€312.13)
Closing Bank Balance €1640.59

Total €3993 Total €3993

Other Information
We held committee meetings during the year and we have held our AGM. Our total membership stands at 632
members.

Cumann de Barra (Fianna Fail) Society

Cumann de Barra, Fianna Fail, is the largest, and most active, political society on the campus on NUI Galway.
The Cumann is named after Kevin Barry, the eighteen year old who was executed in 1920, by the British, for his
part in the War of Independence. Cumann de Barra is the oldest political cumann to exist on any campus in the
entire country, having been established in 1954.

This year, Cumann de Barra has a membership exceeding 300. The Cumann excelled under the guidance of
Chairman Darragh McShea, not only expanded its membership, but also actively engaging in Student life.
Cumann de Barra also developed a position on the National stage over the course of the last 12 months. In
October a delegation of 20 travelled the the party’s Ard Fheis in Killarney, Co. Kerry. In December, the Cumann
hosted a Christmas Party in The Cellar Bar, Eglinton Street, Galway. Representatvies from across the country
were in attendance for what can only be described as a great social occassion. The Cumann host guest
speakers on a regular basis. This affords our membership the opportunity to actively engage with politicians of
every level, including Ministers, TDs, Senators and Councilors.

In February the Cumann hosted the De Valera Debating semi-finals in NUI Galway. The Cumann also sent a
delegation just short of 40 the the National Youth Conference which took place in The West County Hotel, Ennis,
Co. Clare. The weekend was particularly important for Cumann de Barra as it had members in the final of the
public speaking competition, the De Valera Debating Finals and four Cumann members were contesting the
elections for the Ogra National Youth Committee. Furthermore, the Cumann put itself forward for the Gobnait
O'Connell Award.

The Weekend can be deemed as a huge success for Cumann de Barra. Of the four members contesting the
elections, all were returned. Darragh McShea, Chairman of Cumann de Barra, was returned as
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Connacht/Ulster Ard Chomhairle Representative, Lorcan Price as 3rd Level Ard Chomhairle Representative,
Enda Heslin as Connacht/Ulster 3rd Level Representative and Emma Brennan as Galway West/ Galway
East and Roscommon Representative. The Ard Chomhairle is the National Executive of the Fianna Fail Party
and, therefore, the Governing body of that party. This is the largest number of representatives Cumann de Barra
have ever had sitting on the National Youth Committee or Ard Chombhairle of Fianna Fail. In addition to that,
Susan Treacy won the National Public Speaking Competition for the Cumann. The Cumann was also
presented with the Gobnait O'Connell Award. The Gobnait O'Connell Award commemorates Gobnait, who was
the National Youth Officer for Ogra, up until her tragic death in 1999. The Award is presented to the best Ogra
unit in the country each year.

The Annual General Meeting took place at the end of March and elected their officer board for the upcoming
academic year. This Officer Board has already started organising its events for next year, with two major ones
already scheduled. In October, the Cumann will be launching its booklet commerating 50 years of Cumann de
Barra in NUI Galway. Furthermore, the largest event which Ogra holds every year, the National Youth
Conference, will be held in the Ardilaun House Hotel, Taylors Hill, Galway, next February. Undoubtedly these
are two events to mark into your diary.

Cumann de Barra Events

This year the society held a total of 29 events.

Senator Margaret Cox meeting » AC204 on Monday, 26th of September.

Galway Senator, Margaret Cox, will visit the Cumann to talk about the growth of the economy since the 1980s. She
then will take answers from those present. Everyone is welcome!

Ordinary General Meeting » AC204 on Monday, 3rd of October.

Cumann de Barra will hold an Ordinary General Meeting on Monday, October 3rd. It will commence at 8pm and
conclude by 9pm. It affords all those who attend the opportunity to discuss anything they consider to be of relevance.
We will also be discussing the upcoming Dail trip.

Ordinary General Meeting » AC204 on Monday, 10th of October.

Cumann de Barra will hold an Ordinary General Meeting on Monday, October 3rd. It will commence at 8pm and
conclude by 9pm. It affords all those who attend the opportunity to discuss anything they consider to be of relevance.
Also on the Agenda is the upcoming Dail Trip!

Dail Trip » Leinster House on Wednesday, 12th of October.

A delegation from Cumann de Barra will travel to the Dail on Wednesday, October 12th. The Cumann will meet the
Taoiseach, Bertie Ahern TD, at midday. At 12.30 Minister for Agriculture and Food, Mary Coughlan TD, will meet us,
followed by Minister of State, Frank Fahey TD, at 1pm. The Minister for Arts, Sport and Tourism, John O'Donoghue
TD, is scheduled to meet the Cumann at 1.30pm. We will then go for lunch with Minister for Community, Rural and
Gaelteacht affairs, Eamon O'Cuiv TD, in the Private Members restaurant, at 2pm. From 3pm-4pm the Cumann will be
given a tour of the Dail. At 4pm the Minister for Education and Science, Mary Hanafin TD, will meet us, followed by
Minister for Communications, Marine and Natural Resources, Noel Dempsey TD. We will finish the day off with Minister
of State, Pat 'The Cope' Gallagher TD in the Dail bar for an evening drink.

Ordinary General Meeting » AC204 on Monday, 17th of October.

Ard Fheis » Gleneagle Hotel, Killarney, Co. Kerry on Friday, 21st of October.

The Ard Fheis for Fianna Fail is taking place during the weekend of 21st-23rd of October 2005. It will take place in the
Gleneagle Hotel, Killarney, Co. Kerry. This is the second time that the organisation will be travelling to Kerry for an Ard
Fheis. Cumann de Barra is sending a delegation of 20 to the event. This is a great opportunity for people to actively
engage with politicians from every level, including An Uachtaran of Fhianna Fail, An Taoiseach, Bertie Ahern TD. All
Ministers, and Ministers of State, will be present over the weekend. Everyone is welcome to attend this major event.
Further information is available from the Chairman of Cumann de Barra, Darragh McShea

Senator Geraldine Feeney » AC204 on Monday, 24th of October.

Senator Geraldine Feeney will attend Cumann as a guest speaker. Senator Feeney was elected to the Seanad in 2002
on the Labour panel. She will talk about social issues and review the Ard Fheis which takes place in The Gleneagle
Hotel, Killarney, Co. Kerry, from Friday October 21st- Sunday October 23rd. She will also be happy to answer any
questions from those present. Everyone is welcome!
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Councillor Tiernan Brady » AC204 on Monday, 7th of November.

Councillor Tiernan Brady is an elected public representative close to the border in Donegal. He is also elected onto the
Ard Chomhairle (National Executive) of Fianna Fail. Clir Brady is co-opted from the Ard Chomhairle onto the sub-
committee which deals with Northern Ireland. At the upcoming meeting he will discuss his experience of the North-
South divide. He will also take questions from those present. Everyone is welcome!

Clir John Connolly » AC204 on Monday, 21st of November.

Clir John Connolly serves on the Galway City Council. John topped the poll in 2004 in his ward. He is a member of
Ogra, a former Cathaoirleach of Cumann De Barra, and an Honorary Life Member. Everyone is Welcome!

Cumann de Barra- Christmas Party » The Cellar Bar on Friday, 16th of December.

Ordinary General Meeting » AC204 on Monday, 9th of January.

Ordinary General Meeting » AC204 on Monday, 16th of January.

Convention Candidates » AC204 on Monday, 23rd of January.

On Sunday January 30th Fianna Fail are holding their convention in Galway West. The convention will select
candidates to go forward and contest the next General Election in Galway West on behalf of Fianna Fail. There have
been six people nominated to contest the convention and they are; Ministers Eamon O'Cuiv and Frank Fahey,
Councillors John Connolly, Seamus Walsh, and Mary Hoade and Udaras na Gaeltachta Representative, Val Hanly.
Each of the candidates have been invited to attend Cumann de Barra to talk about themselves and why they have
gone forward for this nomination. Everyone is welcome!

John Paul Feeley » AC204 on Monday, 30th of January.

Connacht Ulster Ard Chomhairle Representative, John Paul Feeley, is running for the position of Leas Cathaoirleach of
Ogra Fianna Fail at the upcoming National Youth Conference. He will attend our meeting to talk about the role of Ogra
and seek our support for Ennis.

Michael Shovlin » AC215 on Thursday, 2nd of February.

Michael Shovlin is the current Leas Cathaoirleach of Ogra Fianna Fail. He was elected at the National Youth
Conference in November 2004. His term is coming to an end and Michael will discuss the successes Ogra have
enjoyed over the last 15 months. He will also be happy to answer any questions.

De Valera Debating Finals » Cairnes Theatre on Monday, 6th of February.

The De Valera Debating competition is hosted every year by Ogra Fianna Fail. The finals take place at the National
Youth Conference. This year Cumann de Barra, NUI, Galway has the honour of hosting the semi-finals!

Colin Joyce meeting » AC204 on Monday, 13th of February.

Colin Joyce was re-elected to the Ard Chomhairle (National Executive) of Fianna Fail at the Ard Fheis in Killarney last
October. He will talk about "Grassroots versus Central Organisation." Everyone is welcome!

National Youth Conference » Ennis, Co. Clare on Friday, 17th of February.

Clir Bhrian O'Dombhnaill » AC204 on Thursday, 23rd of February.

Donegal Councillor, and Udaras na Gaeltachta representative, Bhrian O'Domhnaill, will visit Cumann de Barra as a
guest speaker. He will be happy to answer any questions.

Séan Dorgan Meeting » /T205 on Tuesday, 7th of March.

The General Secretary of Fianna Fail, Mr Séan Dorgan, will visit Cumann de Barra on Tuesday March 7th. Séan is the
most senior administrator in Fianna Fail and is charged with full responsibility for the organisation of Fianna Fail and
any of its events. Séan will talk about his, and Ogra's, role in the organisation, and the upcoming General Election. He
will be happy to answer questions. EVERYONE IS WELCOME!

Ordinary General Meeting » AC204 on Monday, 13th of March.

Clir Shane P. O'Reilly » AC204 on Monday, 20th of March.

Cavan County Councillor Shane P. O'Reilly is one of Irelands youngest elected public representatives. Shane was also
elected to the Ard Chomhairle (National Executive) of Fianna Fail at the Ard Fheis in Killarney last October. He will
attend the meeting, talk about the role of the youth in politics, and then take any questions from the floor. Everyone is
welcome!

Annual General Meeting » AC214 on Thursday, 30th of March.

Committee 2005/2006

Auditor: Darragh McShea Vice-Auditor: Liam O hAisibéil
Treasurer: Emma Brennan Secretary: Kate Feeney
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Membership Officer: Andrea Gilligan
Assistant Secretary: Diarmuid Mcintyre
Events Officer: Enda Heslin

Committee 2006/2007
Auditor: Darragh McShea
Treasurer: Sean Scally

PRO: Diarmuid Mclntyre
Membership Officer: Keith Browne

First Year Rep.: Philip Griffin
Joint Treasurer: Eoin O'Niallain
PRO: Vincent Lacey

Vice-Auditor: Andrea Gilligan
Secretary: Eoin O'Niallain
Joint Treasurer: Joe O'Neill
Events Officer: Susan Treacy

Cumann de Barra Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 326.17 AffilllMem fees €50

Members Contributions €3553.75 Ball €60

Sponsorship €1345 Bank charge €11.25

USC Grant €5393.5 Dinner €1331.23
Entertainment €2208.05
Entry fees €2780
Non Alcoholic Refresh €10
Promotions €79.15
Society accommodation €1980
Society transport €523.5
Speaker accommodation €550
Expenditure Total €9583.18
Does not include Unreconciled Cheque Total (€90)
Closing Bank Balance €1035.24

Total €10618.42 Total €10618.42

Other Information
We held 16 committee meetings during the year and we have held our AGM. Our total membership stands at
304 members.

Cumann Dramaiochta Society

Is iontach an deis i feabhas a chur ar do chuid Ghaeilge agus bualadh le cairde nua tri modh na dramaiochta na
bheith i do bhall den Cumann D! Ni ga duit bheith i do aisteoir chun pairt a ghlacadh in sna drdmai ach suim
agat sa teanga sin an méid. Bionn ceardlanna ar suil go rialta chun leideanna aisteoireacht a nochtadh agus do
mhuinin a mhéadu. Leanann an craic ar aghaidh do dti Club Aras na Gael ina dhiaidh. | mbliana, bhi Féile na
gColaisti ar siul anseo in Ollscoil na Gaillimhe. Chuir an Cumann D isteach ar tri cinn ahus d'éirigh thar barr
leo. Thainig na cumann dramaiochta 6 cholaisti eile ar fud na tire mar shampla Chorcaigh, Baile Atha Claith
agus Beal Feirste. Bhi an deireadh seachtaine ar fheabhas!

The Cumann D is an excellent way to improve your Irish and meet with people who speak Irish. All you need is
an interest in the language and a smile, not amazing acting skills!! The society host workshops on a regular
basis in which we reveal hints for acting and confidence boosters on stage. The craic continues then to Club
Aras na Gael. This year NUI Galway hosted the national college's festival. The Cumann D entered three dramas
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in the festival and they all succeeded very well. There were colleges from all over Ireland present including,

UCC, UCD, St. Pats Drumcondra and Belfast University. It was an excellent weekend.

Cumann Dramaiochta Events
This year the society held a total of 9 events.

Ceardlann dramaiochta » Teatar, Aras na Gael on Wednesday, 28th of September.
An Ghaeilgeoir dheireanach » An Taibhdhearc on Tuesday, 4th of October.
Ceardlann dramaiochta » Teatar, Aras na Gaeilge on Wednesday, 19th of October.
Ceardlann Dramaiochta » Teatar, Aras na Gaeilge on Wednesday, 2nd of November.

Eisteachtai » teatar arus na gaeilge on Wednesday, 18th of January.

ceardlann dramaiochta » teatar, arus na gaeilge on Wednesday, 25th of January.

feile na gcolaisti-muscailt 2006 » featar arus na gaeilge and BOI theatar on Friday, 24th of February.
beidh feile dramaiochta na gcolaisti ar siul i ngaillimh i mbliana sa teatar in arus na gaeilge agus sa BOI theatar. ma ta

suim agat a bheith pairteach chuir riomhphoist chuig an cumann dramaiochta. the irish drama intervarsities will be held

in galway this year over the weekend of the 24th and 25th. the festival will take place in the theater in arus na gaeilge

and in the BOI theater. if you are interested in taking part please email the cumann dramaiochta.

Oilitint skinny spew & na Cloigne » Amharclann Aras na nGael on Friday, 24th of February.
Féile na gColaisti » BOI Theatre & Amharclann Aras na nGael on Saturday, 25th of February.

Committee 2005/2006
Auditor: Bairbre Ni Mhaille
Treasurer: John Mullarkey

PRO: Peadar o Muircheartaigh
Webmaster: Dualta Mac Lochlainn

Vice-Auditor: Bairbre Ni Fhlatharta

Secretary: Blaithin Seoige

OCM: Aisling Dee

Irish officer: Maitiu de hAl

Cumann Dramaiochta Society Balance Sheet

Income
Income Category
Opening Bank Balance
Socs box
Sponsorship
Ticket Sales
USC Grant

Total

Other Information

Amount
772.86
€350
€1860
€560
€2675

€6217.86

Expenditure

Expenditure Category
Bank charge

Costumes

Dinner

Entertainment
Equipment misc

Non Alcoholic Refresh
Society accomodation
Expenditure Total
Closing Bank Balance
Total

Amount
€10.91
€1599
€640
€157
€109
€60
€1020
€3595.91
€2621.95
€6217.86

We held 19 committee meetings during the year. We have not held our AGM yet. Our total membership stands

at 36 members.
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Cumann Eigse Society

Ba ¢é an bhliain 2006 an bhliain is rathuil le haghaidh cupla bliain anuas. D'obair Beartla de Burca mar iniachaéir
ar son an cumann agus fuair sé cabhair 6 Mairtin O Fatharta, an runai, Padraigin Ni Ghaillchoir, an OCP agus
leas reachtaire, Fintan Hegarty a bhi mar cisteoir comh maith leis an chuid eile don choiste. Bhuail an cumann
le cheile sa téatar i Aras na Gaeilge agus i rith na bhliaba bhi ocht crinniu ginearalta ann. | Mean Fomhair bhi
an Cumann i dteagmbhail leis an gCumann Dramaiochta. Le cheile d'eagraigh muid turas go Corcaigh le
haghaidh an Oireachtas. | ndiadh sin i mi Eanair d'eahraigh muid diospoireacht mhér idir Enda Kenny agus an
tAire Eamoén 6 Ciuv comh maith le dhaoine eile. Freastail nios mé na 250 dhaoine ag an gcrinniu. Freisin bhi
cuig diche soisralta ann i Aras na Gael, cupla 6iche dansa, éiche seanchais le an tathair Eddie Bheartla agus
oraid le Donncha O hEalaithe. Mar sin seo an bhliain is fearr agus an bhlian is gnéthach le tamall fada

Cumann Eigse Events

This year the society had a total of 15 events that took place.

Oiche Séisialta ran for 4 weeks in Aras na Gael, beginning on Tuesday, 18/10/2005.

Oiche Soisalta ran for 7 weeks in Aras na Gaeilge, beginning on Tuesday, 17/1/2006.

Oiche Dansa » Téatar Aras na Gaeilge on Sunday, 11/9/2005.

Oiche Dansa » Téatar Aras na Gaeilge on Tuesday, 25/10/2005.

Teacht le cheile le haghaid dansa gaelach a dhéanamh.

Plé Poibli » Téatar Ui Chearbhalléin, Aras na Gaeilge on Friday, 20/1/2006.

Beidh an tAire Eamon O Cuiv, Eanna O Cionnaith, Ceannasai Fhine Gael, Peadar Mac an lomaire 6 Acadamh na
hOllscolaiochta Gaeilge agus Daithi Mac Carthaigh, Uachtaran Chonradh na Gaeilge ag labhairt ar an ran "An bhfuil
Maoinit na Gaeilge & chur amu?". Beidh an lucht éisteachta in ann a gcuid tuairimi a chuir i lathair agus ceisteanna a
chuir ar na cainteoiri mas mian leo. Beidh an failte fiona ag tosnu ag 7:30i.n agus beidh an plé poibli ag tosnu ag a
8:00i.n

Ceardlann i nGaidhlig na hAlban » Seomra 106, Aras na Gaeilge on Thursday, 9/2/2006.

Beidh an ceardlann seo & muineadh ag Ruairidh Maciver 6n Oilean Leodhais na hAlban, agus ta sé feiliinach do
thosnaitheoiri ar fad, cibé caighdean Gaeilge ata acu. Ta failte roimh chach!

Committee 2005/2006
Auditor: Beartla de Burca Vice-Auditor: Padraigin Ni Ghallchoir
Treasurer: Fintan Hegarty Secretary: Mairtin O Fatharta

Committee 2006/2007
Auditor: Ronan MacDiarmaida OCM: Beartla de Burca

Cumann Eigse Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 46.99 Bank charge €1.68

USC Grant €680 Prizes €100
Reception €92
Society transport €400
Expenditure Total €593.68
Closing Bank Balance €133.31

Total €726.99 Total €726.99

Other Information
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We held 15 committee meetings during the year and we have held our AGM. Our total membership stands at
354 members.

Dance Society

Dansoc is one of the largest societies on campus and it provides a variety of dance classes each week. These
range from ballet to salsa to hip hop and we provide a great way to get some exercise, meet new people and
just have fun. We do several performances each year and we have also hosted the second annual intervarsities

Dansoc Events
This year the society had a total of 58 events that took place. These events can be divided into two categories:
regular and special events.

Modern Jazz ran for 4 weeks in Raquet ball Court, beginning on Monday, 23/1/2006.

Weekly class using music from shows such as Chicago and also some Hip Hop styles were incorporated in the
routines

ballet ran for 10 weeks in Racquetball courts, beginning on Tuesday, 24/1/2006.

Ballet dancing for beginners to the musical stylings of Dido and Enya, to name but a few.

Beginners Irish Dancing ran for 10 weeks in Racquetball Court, beginning on Tuesday, 24/1/2006.
Irish dancing class geared toward those with little or no experience with Irish Dancing

Advanced Irish Dancing ran for 9 weeks in The Hub, beginning on Wednesday, 25/1/2006.

Irish dancing for those with experience beyond the beginners level

Salsa Dancing ran for 10 weeks in The Hub, beginning on Wednesday, 25/1/2006.

Hip Hop ran for 9 weeks in Racquetball court, beginning on Thursday, 26/1/2006.

Rhythm, Performance » Bank of Ireland Theatre on Monday, 14/11/2005.

Performance of varied types of dance including ballet, salsa, Hip Hop and advanced and beginners Irish dancing.
Lighting was used to enhance the performance

Rhythm » Bank of Ireland Theatre on Tuesday, 21/2/2006.

DanSoc performance. It was another great show!Open to all staff and students, sold out in minutes!!!

Rhythm » Bank of Ireland Theatre on Tuesday, 21/2/2006.

Performance by DanSoc. Evening Performance-a repeat of the show earlier, due to popular demand
Intervarsities » Aras na Mac Leinn on Friday, 10/3/2006.

Students from Cork and Maynooth will be arriving to take part in workshops and a showcase performance will take
place at the end. There will also be an after-party.

AGM » The Hub on Wednesday, 22/3/2006.

Rhythm » Bank of Ireland Theatre on Tuesday, 28/3/2006.

Committee 2005/2006

Auditor: Jennifer Coleman Vice-Auditor: Sarah-Jayne MacLaverty
Treasurer: Clare Graham Secretary: Catherine Carey
PRO: Selina McCarthy PRO: Andrea Byrne

Committee 2006/2007
Auditor: Andrea Byrne Vice-Auditor: Siobhain McMorrow
Treasurer: Gillian Healy PRO: Alison McGreevy
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Dance Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 2224 Bank charge €75

Greenform €79 Dinner €231.28

Members Contributions €811.5 Equipment misc €150

Societies day €1289 Materials €1060

Ticket Sales €385.8 Promotions €40

USC Grant €1802.25 Reception €361.22
Society transport €30
Speaker accommodation €79
Speaker travel €451
Teacher fees €865
Expenditure Total €3275
Cash In Hand €25
Closing Bank Balance €1312.45

Total €4589.95 Total €4589.95

Other Information
We held 20 committee meetings during the year and we have held our AGM. Our total membership stands at
450 members.

DJ Society

DJ Society aims to develop and promote the art of DJing amongst its members and provide members with an
outlet to enjoy themselves through music, performance, and interaction with other members. It's about people
coming together, having fun, enjoying good music, and developing a talent for DJing. DJ Society currently has
252 members - an increase of 110 from 2004/2005. A live set was performed on both Societies Days with
turntables, CD decks, PA and speakers to attract new members. Previous year's members on the mailing-list
were invited to join again. New members are always welcome to attend open-deck sessions in the Ruby Room,
which are promoted twice weekly via town and campus postering.

We also entertained in Aras na MacLeinn during the University Open Day in December. As we run regular gigs
in the Blue Note, the King’s Head and Arus na nGael, we were able to get high quality glossy color posters and
flyers sponsored. Posters for all events were put up and flyers handed out twice weekly both on campus and in
town. DJ Soc DJs promoted DJ Soc events on Flirt FM regularly. DJs playing a particular night spread the word
massively amongst friends. As the year progressed, more and more people heard of DJ Soc events through
word of mouth. Text messages were sent out to members for almost all events. 62 emails were sent to the ‘DJ
Society-announce’ mailing-list during the year. All events were submitted to the Socs Calendar Website also. As
many of our events are located off campus and open to the public, outside promotion is essential. Getting
professional DJs from the GPO, Halo and OASIS to attend the Ruby Room sessions, as well as judging internal
competitions, helps spread the word outside the college and build links with clubs in town. Again, the glossy
color posters were put up and flyers handed out in most bars and clubs in town. Many DJ Soc DJs promote DJ
Society events during their regular slots on Flirt FM, which broadcasts off-campus.

DJ Soc Events
This year the society had a total of 54 events that took place.

Regular Events

28



This year we held 3 events that ran regularly over a number of weeks. These events were as follows:
DJSoc @ Blue Note ran for 11 weeks in The Blue Note, beginning on Wednesday, 18/1/2006.
Student Night ran for 11 weeks in The Blue Note, beginning on Wednesday, 22/2/2006.
NightVision ran for 8 weeks in The Blue Note, beginning on Wednesday, 12/4/2006.

Special Events

This year we held 24 special events. These events were as follows:

Socs Day 1 » Aras na MacLeinn on Thursday, 22/9/2005.

Open Day » Aras na MacLeinn on Thursday, 1/12/2005.

ABU » Arus na nGael on Thursday, 12/1/2006.

NUIG DJ Battle » Aula Maxima on Saturday, 14/1/2006.

Socs Day 2 » Aras na MacLeinn on Wednesday, 18/1/2006.

Girls' Night Out » The Blue Note on Wednesday, 25/1/2006.

DJ Lessons & Practice Session » The Ruby Room, King's Head on Tuesday, 31/1/2006.
Classes & Practice Session » Ruby Room, King's Head on Tuesday, 31/1/2006.
NURSES’ BALL » Salthill Hotel on Friday, 3/2/2006.

Weekly Gig » The Blue Note on Wednesday, 8/2/2006.

ABU » Arus na nGael - Dominick St on Thursday, 9/2/2006.

Practice Session » The Ruby Room, King's Head on Tuesday, 14/2/2006.
Student Night » The Blue Note on Wednesday, 15/2/2006.

NUIG DJ Battle » Aula Maxima on Tuesday, 21/2/2006.

Battle of the Decks » Aula Maxima Lower on Tuesday, 21/2/2006.

Girls' Night Out » The Oasis on Friday, 24/2/2006.

DramsSoc Party » BOI Theatre on Friday, 24/2/2006.

DJ Soc DJs man the decks at DramSoc end of Muscailt Party.

RAG Week » Kings Head on Monday, 27/2/2006.

Ruby Room Sessions - LIVE » King's Head on Tuesday, 28/2/2006.

RAG Week - DISOC » College Bar on Thursday, 2/3/2006.

ABU » Arus na nGael on Wednesday, 8/3/2006.

AGM + PARTY » DeBurgho's on Tuesday, 28/3/2006.

Intervarsity D] Battle » Pod, Dublin on Thursday, 6/4/2006.

First ever Intervarsity DJ Battle. Winner receives loads of cool gear and a spot at Global Gathering.
Intervarsity D] Battle » the POD, Dublin on Thursday, 6/4/2006.

Committee 2005/2006
Auditor: Cormac Staunton Vice-Auditor: Rory Donohue

Treasurer: Eoghan OBrien Secretary: Liam Griffin

Committee 2006/2007

Auditor: Cormac Staunton Vice-Auditor: Rory Donohue

Treasurer: Eoghan OBrien

DJ Society Balance Sheet

Income
Income Category Amount

Opening Bank Balance 146.96

Secretary: Liam Griffin

Expenditure
Expenditure Category Amount

Equipment misc €760



Members Contributions €150 Non Alcoholic Refresh €430

Sponsorship €295 Society accommodation €150

USC Grant €1570 Society transport €100
Socs day expenses €120
Teacher fees €400
Expenditure Total €1960
Closing Bank Balance €201.96

Total €2161.96 Total €2161.96

Other Information
We held 15 committee meetings during the year and we have held our AGM. Our total membership stands at
252 members.

Drama Society
Dramsoc is the college dramatic society.

The society aims as stated in the Constitution are; to provide productions experience for the members of the
society, support the development of all forms of drama and dramatic production in the college, support new
writing, involve all interested members of the University to the fullest extent possible so as to create a richer and
more diverse Dramsoc and finally in all other ways to further the performance and enjoyment of drama at the
University!

This year Dramsoc put on nine productions; 'Castles for People’, | cant remember anything', 'Love or Blood',
'Adrian Writer', 'Stupid Universe', 'Georges Baby', 'Red Roses and Petrol', 'Signals' and 'Big Maggie'. This not to
mention the 11 one act plays we put on during Muscailt. We have never gotten so many people involved in the
production side of Dramsoc before. We got seven nominations and one award at ISDA the Irish Student Drama
Awards which just shows how high a standard these were. We also sent two acts down to the fringe festival at
ISDA. Every Wednesday we continued to run our weekly session, Staged and Confused, improv, games,
sketches etc. We held our 100 years celebration in November.

We feel that Dramsoc has never been better; with the amount of people we involved this year in all aspects of
what we do, the high standard of what we produced and most importantly the craic we all had while doing it. It
was a good year!

Dramsoc Events

This year the society had a total of 35 events that took place.

Staged and Confused ran for 10 weeks in BOI theatre, beginning on Wednesday, 21/9/2005.

our weekly night of improv, games, sketches and general madness. The night provides a chance to show off your
theatrical ability in a relaxed and friendly atmosphere and even if you prefer to sit back and watch proceedings the
evening always promises plenty of laughs and entertainment! So to experience the evening we'd like to invite all those
who have as of yet not made it to Staged and Confused - we can promise great craic! We hope to see all the usual
faces back needless to say also

Dramsoc 100 years » BOI Theatre on Tuesday, 1/11/2005.

This was a celebration of our 100th birthday! It took place on the first night of the first Dramsoc production for the year.
It was a mini reunion with some past Dramsoc members attending such as Paraic Breathnach. We had a wine
reception with a further reception in the College Bar after the production. We searched through the archives, found
many old programmes, photographs etc from which we got three large boards made up, depicting the last one hundred
years of the society, these are still hanging in the theatre foyer.
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Dramsoc Double Bill » BOI Theatre on Tuesday, 8/11/2005.

'Love or Blood' a play written and directed by Conall O Riain. 'l can't remember anything' by Aurthur Miller, directed by
Rebecca Ryan This double bill of plays takes place for the week in the BOI theatre. It is part of centenary celebrations.
This sees Dramsoc members performing works written by themselves and also directing for the first time.

'Adrian Writer' and 'Stupid Universe' » BO/ Theatre on Wednesday, 16/11/2005.

Two short play written by Caoimh McCarthy, a Dramsoc member. These were the last week of our centenary
celebrations.

Stupid Universe & Adrian Writer » Bank of Ireland Theatre on Thursday, 24/11/2005.

Castles for People by Henry Martin » BOI Theatre on Friday, 2/12/2005.

A play written and directed by Henry Martin, a student of NUIG, took place for four nights in the BOI Theatre. It had a
cast of seven and was the first play of the year for Dramsoc.

Auditions - Red Roses and Petrol » Bank Of Ireland Theatre on Monday, 16/1/2006.

Auditions for Dramsocs - Red Roses and Petrol Written by Joseph O'Connor and directed by Rob Mc Feely take place
this week. 4 males and 4 females needed. Mondays Auditions 13:00-14:30 and 18:00-19:30 will take place inthe Bank
of Ireland Theatre beside the College Bar. Further auditions held Tuesday and Wednesday Audition pieces available in
the Socs Box in the Hub or in the Dramsoc Pigeon hole in the Hub. Check theatre door for further info or visit
http://[dramsoc.nuigalway.ie. All welcome. call Rob 0861734074 for more info

Staged and Confused » Bank of Ireland Theatre on Wednesday, 18/1/2006.

Dramsoc's weekly night of Improv, Theatre Games and all-round madness!

Staged & Confused » Bank of Ireland Theatre on Wednesday, 25/1/2006.

Staged & Confused will be on this Wednesday (25th January) at 7pm in the Bank of Ireland Theatre (beside the
college bar).Staged and Confused is a improvisation/fun and games night. Come along for the craic and don't worry
about getting involved is totally voluntary. Its just a lot of craic really. After the night we usually head off to the Open
Mic Night downstairs in the Cellar Bar. There is often free passes to Cuba handed out. We're looking forward to seeing
everyone from last semester but as always we would love to see fresh faces. Spread the word! It's never too late to
come along for the laugh.

Dramsoc: Staged & Confused » Bank of Ireland Theatre on Wednesday, 1/2/2006.

Staged & Confused » Bank of Ireland Theatre on Wednesday, 8/2/2006.

Staged and Confused » Bank of Ireland Theatre on Wednesday, 15/2/2006.

One-Act Play Series » Bank of Ireland Theatre on Wednesday, 22/2/2006. Mary Hegarty’s Last Mass by
Shona McCarthy, Basin of Myself by Henry Martin, Strings by Danny Golden

Checkers » Bank of Ireland Theatre on Wednesday, 22/2/2006.

Checkers directed by Lauren Mikov

One-Act Play Series » Bank of Ireland Theatre on Thursday, 23/2/2006.

Empty by Candace Driskill, More Dears Than Tears by Cliona deBri, Tell Tale Tattlers by Naomi Moran

One-Act Play Series » Bank of Ireland Theatre on Friday, 24/2/2006.

The Ache by Bridget Deevey, Earthed by Deirdre Sullivan, Frozen by Terry Dineen

One Act Omnibus Edition » Bank of Ireland Theatre on Friday, 24/2/2006.

DramSoc performances of all one-act plays performed during the week. Tonight will feature the inaugral presentation
of the Jerome Hynes Memorial Award sponsored by the Alumni Office.

Alternative Staged & Confused » on Wednesday, 8/3/2006.

For the same theatre games, Improv and all-round fun be sure to come to Staged and Confused this week - in an
alternative venue...still a secret ssshhh...Keep an eye out on the website at http://dramsoc.nuigalway.ie/ for final
confirmation of the venue and also keep those eyes peeled for posters around college. Be sure to come along and
sure bring a friend - the more the merrier!

Spring Play Series - "Signals" » Bank of Ireland Theatre on Monday, 13/3/2006.

"Signals" is an adaptation of "The Jeweller's Shop", a play by Karol Josef Wojtyla (i.e Pope JP II). Joe Quinn directs
this Polish set drama dealing poetically with relationships.

Spring Play Series - Red Roses & Petrol » Bank of Ireland Theatre on Monday, 13/3/2006.

"Red Roses and Petrol" by Joseph O'Connor, directed by Rob Mc Feely. Red Roses and Petrol is a domestic Drama
set in suburban Dublin. Enda Doyle's death brings about a family reunion. An autobiographical video collection of
Enda's is found and it releases, in a whirlwind, years of familial tension. Bubbling below the surface of the Doyle family
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is a lifetime of love, hurt, joy and hate and an audience can't but find introspection as the ghost of the Doyle Family
emerges. Tickets are available in the Hub and on the door - 3euro for students and 5euro for non-students For more
information visit http://dramsoc.nuigalway.ie/

Staged and Confused » on Wednesday, 15/3/2006.

ISDA » UCC on Sunday, 19/3/2006.

Dramsoc heads to Cork with three productions to take on the other colleges at the Irish Student Drama Awards. Big
Maggie, Red Roses and Petrol and | can't Remember Anything were our three plays sent down. They did us proud and
we came away with no fewer than........... 7 nominations and 1 award!!! We got nominated for; best director (Rob
McFeely), best set, best supporting actor (Fiachra O Dubhghaill) and best supporting actress (Lucia Smith) all for Red
Roses and Petrol and best actor and actress for Dan Colley and Aimee Leevy from | can't remember anything. It was
Rebecca Ryan for | can't remember anything that took away the judges discretionary award for Best New Director! Go
on UCG Dramsoc!

George's Baby » BOI! Theatre on Sunday, 19/3/2006.

Big Maggie » Bank Of Ireland Theatre on Monday, 20/3/2006.

By John B Keane. Fresh from representing the University at ISDA.

AGM » Siobhan McKenna Theatre on Thursday, 30/3/2006.

End-of-Year Party » Richardsons, Eyre Square on Thursday, 30/3/2006.

Committee 2005/2006
Auditor: Rob McFeely
Treasurer: Ciara Norman

Vice-Auditor: Caitriona Mulhall

Secretary: Caitriona Mulhall

Production Coordinator: Ronan McMahon
PRO: Aileen Bradley

Webmaster: Andy Regan
Society Development Officer: Deirdre O Doherty
Voice of Reason: Tracy Bruen

Committee 2006/2007
Auditor: Caitriona Mulhall
Treasurer: Darragh Finn

SDO: Rob McFeely

Tech Manager: Liam Harkin

Vice-Auditor: Rebecca Ryan

Secretary: Stella Keary

PRO: Kate Conneeley

Production Co-ordinator: Emma Flaherty

Drama Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 2833.59 Affill/Mem fees €350
Members Contributions €610.07 Bank charge €3.75
Socs box €739 Dinner €1255
Societies day €114.23 Entertainment €810
Sponsorship €105.87 Entry fees €1350
Ticket Sales €1316 Equipment misc €45
USC Grant €5305 Gifts €120
Hire Bus €1046.45
Makeup/Props €340.06
Materials €894.55
Non Alcoholic Refresh €166.7
Performing rights €1045
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Phone €420

Printing €195
Reception €515
Set €586.8
Society accomm €687
Teacher fees €200
Expenditure Total €10765.85
Unreconciled cheque Total €156.3
Closing Bank Balance €257.91
Total €11023.76 Total €11023.76

Other Information
We held 24 committee meetings during the year and we have held our AGM. Our total membership stands at
600 members.

Ecology Society
Ecosoc has been very involved in a number of campaigns over the last year. We have organised talks, film
screenings, meetings, media campaigns and street theatre activism for a number of ecological issues. These
included the Pit Stop Ploughares campaign, the Shell to Sea Campaign and Buy Nothing Day.

Ecology Soc Events

This year the society held a total of 12 events.

Benefit Gig » Richardson's, Eyre Square on Thursday, 13th of October.

Benefit gig for the Rossport Solidarity Camp, with noise provided by Cub Scout Disco, Captain Spaulding, Riastradh,
Summer Disease and Council of Ten. Costing 4 yoyo's before 9pm, 5 thereafter.

Pit Stop Ploughshares meeting » Fottrell Theater, AMB on Thursday, 20th of October.

Meeting with Ciaran O'Reilly of the Pit Stop Ploughshares, Tim Hourigan who helped uncover renditions through
Shannon and Farrah, from Voices in the Wilderness.

Launch of 'Ireland from Below' » North Star Hotel, Amiens St, Galway on Wednesday, 23rd of
November.

The launch of IRELAND FROM BELOW, a new monthly newspaper reporting community struggles.

Buy Nothing Day film screenings » The Hub on Saturday, 26th of November.

Films being screened in the Hub for Buy Nothing Day. Consumer Zombies also available on shop street, trade/barter
fair in the One World Centre, anti-commercial awareness around town.

Meeting » The HUB on Friday, 13th of January.

ECOSOC: Rossport Camp Meeting » Smokies on Saturday, 28th of January.

Two Talks » Human Rights Centre on Thursday, 2nd of February.

Sr. Majella McCarron who worked with the Ogoni people and Ken Sara Wiwa in Nigeria against the environmental
destruction wrought by Shell is speaking at 3 pm. She also works with on the Rossport campaign is an amazing
woman. There's also a lunchtime seminar in the Human Rights centre the same day re. the Palestinian elections.
Shell to Sea picket » Clare on Saturday, 18th of February.

Galway Alliance Against War Meeting » Town Hall on Monday, 20th of February.

Shell to Sea workshop (GRIf\ week event) » Bank of Ireland theatre on Thursday, 9th of March.
Critical Mass » Spanish Arch on Friday, 31st of March.

AGM - Ecosoc » The Hub on Wednesday, 5th of April.

Committee 2005/2006

Auditor: David Jack Hallinan Vice-Auditor: Maeve O Connor
Secretary: Pauhla McGrane
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Committee 2006/2007
Auditor: Pauhla McGrane Vice-Auditor: David Jack Hallinan

Ecology Society Balance Sheet

Income Expenditure
Income Category Amount  Expenditure Category Amount
Opening Bank Balance 2863.27 Bank charge €3.75
Greenform €120 Society accommodation €120
Societies day €100 Speaker travel €221.85
USC Grant €842
Expenditure Total €345.6
Does not include Unreconciled Cheque Total (€425)
Closing Bank Balance €3579.67
Total €3925.27 Total €3925.27

Other Information
We held 18 committee meetings during the year and we have held our AGM. Our total membership stands at 42
members.

Engineering Society

Eng Soc Events

Engineering Ball » Galway Bay Hotel, January 19"

The annual Engineering Ball took place in the Great Southern Hotel. Tickets went on Sale on the 21%' November 05.
The evening was a great success.

The Society raised €840 for charity events throughout the year and organised a number of class parties bringing
students in the department together and providing a social forum where students could mix.

Committee 2005/2006

Eng Ball Committee: Hopkins, Caroline Eng Ball Committee: Tierney. Joanne
Eng Ball Committee: ODwyer, John Eng Ball Committee: Gillespie, Ciara
Eng Ball Committee: McRedmond, Grainne Eng Ball Committee: NiChroinin, Niamh

Eng Ball Committee: Atcheson, Mairead

Engineering Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 173.01 Ball €15604

Balls €19055 Bank charge €10.47

USC Grant €30 Dinner €840
Entertainment €1680
Fundraising/charity €820
Returned Money €30
Expenditure Total €18984.47
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Unreconciled Cheque Total €0

Cash In Hand €90
Closing Bank Balance €183.54
Total €19258.01 Total €19258.01

Other Information
We held committee meetings during the year. We have not held our AGM yet. Our total membership stands at
117 members.

Fantasy & Science Fiction Society

Fansci is NUI Galway's Fantasy and Science Fiction society. the main focus of the society is in bringing people
together for the purposes of role-playing as well as board and card gaming. Fansci meets each week for the
purposes of gaming and discussion. As well as holding these meetings throughout the year, Fansci organised a
number of once-off events, including the second year of our gaming convention, Itzacon. As well as this, we
organised a society trip to the cinema in October, a society trip to Warpcon in Cork in January and our own
convention , a stage play and a radio play in March. As well as this, we also took part in two of the Access
Programs children’s camp projects, organising games primary and secondary school children. All in all, Fansci
had a very busy year in 2006!

FanSci Events
This year the society had a total of 14 events that took place.

Regular Events
This year we held 1 event that ran regularly over a number of weeks. This event was as follows:
Games Night ran for 10 weeks in AC201, beginning on Wednesday, 28/9/2005.

Special Events

This year we held 4 special events. These events were as follows:

Men At Arms & Guard Guard » Bank of Ireland Theatre on Monday, 20/2/2006.

Performed by FanSci Society

Sandman » Bank of Ireland Theatre on Wednesday, 22/2/2006.

Sandman by Neil Gaiman, adapted and performed by FanSci Society

Itzacon » The Aula Maxmia on Friday, 10/3/2006.

ltzacon Eire is Galway's only gaming convention, now in it's second year. It shall be running from Friday the 10th of
March untill Sunday the 13th. The event shall be taking place in the Aula Maximia, and will involve lots of activties
during the day, ranging from roleplaying games to card games to a giant snakes and ladders tournament! After the
convention, we'll be heading to the town for fun and frolics for all. For more information, head on over to
www.itzaconeire.com. Friday 10th: 6pm — 9pm GURPS Horror , Werewolf , Eberron — D&D 7pm to 9pm Open Demos
Saturday 11th RPGS , Legend of the five rings, Harry Potter, Team Synergy 1.5 LARPS: Erasure: Time Travel Other:
Chez Geek Tournament 10am — 1pm Harry Potter Erasure: Time Travel 11am to 1pm , Team Synergy 1.5 Open
Demos from 1pm 2pm — 5pm RPGS: Paranoia in the Great Library , Hellboy,Spelliammer, LARPS: In Nomine 3-5pm
Munchkin Tournament 6-9pm: RPGS: Abyssals, Call of Cthulhu, Classic D & D Others: Zombies / Frag — 6pm to 8pm
LARPS: Requiem Other: Zombies / Frag — 6pm to 8pm Open Demos from 8pm Sunday 12th 10-1pm RPGS: Game of
Thrones, Serenity, Mage, LARPS: Changeling Others: Open Demos from 11am Pirates — 12pm to 2pm 2pm-5pm:
Discworld, Masque of the Red Death, Godlike. LARPS: Memories of Justice Others: Carcassone — 3pm to 5pm
Monopoly 3-5pm.

A.G.M. » AC204 on Wednesday, 22/3/2006.

Committee 2005/2006
Auditor: Padraig Murphy Vice-Auditor: Brian Dolan
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Treasurer: Keiren McGee Secretary: Karl Kavanagh
Entertainments Officer: Niamh Dolan Entertainments Officer: Edel Crowley
Librarian: Pol MacFhionngaile Games Convenor: Patrick Ryan

PRO: Yolande O Brien

FanSci Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 3352.84  Affill/Mem fees €828.55
Fundraising €230 Ball €1.96
Muscailt €47.86 Bank charge €3.75
Ticket Sales €1661 Dinner €100
USC Grant €2655 Entry fees €1568
Equipment misc €250
Promotions €280.85
Society accommodation €259
Society transport €800.32
Speaker accommodation €194
Expenditure Total €4286.43
Does not include Unreconciled Cheque Total (€947.25)
Closing Bank Balance €3660.27
Total €7946.7 Total €7946.7

Other Information
We held 12 committee meetings during the year and we have held our AGM. Our total membership stands at
168 members.

Film Society

The main aim of Filmsoc is to encourage and develop Film making and viewing on campus. We achieve these
aims through two methods. The first is the regular film screenings we put on Thursday evenings. The second
through workshops given by professional individuals in the filmmaking business. Besides this we try to
encourage a social environment where people can meet and discuss film and work and critique the work of
others with fellow students.

Film Soc Events

This year the society held a total of 25 events.

Societies Day » Aras na Macleinn on Wednesday, 21st of September.

E.G.M » AM150 on Thursday, 29th of September.

Lost in Translation » AM150 on Monday, 10th of October.

Intermission » AM 150 on Thursday, 20th of October.

Rocky Horror Picture Show » AM250 on Monday, 24th of October.

Kill Bill 1 » AM 150 on Thursday, 27th of October.

Gerry Stembridge Directors » Siobhian McKenna on Tuesday, 1st of November.
Terry McMahon Screenwriters » AM107 on Wednesday, 2nd of November.

A Night of Irish Film Shorts » Aras Na Gaelige on Thursday, 3rd of November.
Taxi Driver » AM 150 on Thursday, 17th of November.
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Pre-production meeting, script workshop » AM 107 on Thursday, 12th of January.

Martin Mc Gagh Workshops » Siobhan Mc Kenna Theatre on Tuesday, 17th of January.

Societies Day 2 » Aras na Macleinn on Wednesday, 18th of January.

The Nightmare Before Christmas » AM 150 on Thursday, 19th of January.

Inside I'm Dancing » AM 150 on Thursday, 26th of January.

Crash » AM150 on Thursday, 2nd of February.

Rosemary’s Baby » AM 150 on Thursday, 9th of February.

Film Festival » Cinema Mobile on Monday, 20th of February.

Showing: ~ The Banshee lives in the handball alley. ~Darklight Film shorts. ~Le Grande Voyage. ~ Goldfish Memory. ~
Dead Meat ~Mad Hot Ballroom ~ Howl’'s Moving Castle ~Darklight Filmshorts ~A History of Violence

There were 9 films shown in the mobile cinema which included our own films produced by the society.

Short & Bitter Sweet » Mobile Cinema near to Aras na mac leinn on Tuesday, 21st of February.

FILM: Short and Bitter Sweet - Premiere of five film shorts from Film Soc.- Wednesday by Danny Golden directed
Daniel McGill Fait Accompli written and directed by Jack Stenson Empty Glass Full written and directed by James
McWalter Body Stories by Mariel Whelan directed by Daniel McGill Clown Project written and directed by Henry Martin.
(Mobile Cinema)

Directors & Producers Workshop » Arts Millenium Building Room 107 on Thursday, 23rd of February.
Film-soc Shorts: Post-Discussion » AM 150 on Thursday, 9th of March.

The Shawshank Redemption » Kirwin on Tuesday, 14th of March.

Goodfellas » AM 150 on Thursday, 16th of March.

"THE BIG LEBOWSKI" » KIRWAN on Tuesday, 21st of March.

AGM and Reservoir Dogs » AM 150 on Thursday, 23rd of March.

Committee 2005/2006
Auditor: James McWalter Vice-Auditor: Cian Carney
Treasurer: Shaun Murray
PRO Website: Meabh Haiceid
SDO: Aimee Levey

PRO: David Burke

Secretary: Henry Martin
EQUIPMENT OFFICER: Robert Dodey
OCM: Jack Stenson

Committee 2006/2007
Auditor: Jack Stenson Vice-Auditor: Daniel Regan
Secretary: John Burke Equipment Officer: Robert Dooley

PRO: Garry Henry

Film Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 596.61 Bank charge €3.75
Greenform €100 Dinner €19.8
Muscailt €184.46 Entertainment €176.9
Socs box €15 Equipment misc €225.7
Societies day €260.78 Materials €97.5
Sponsorship €0.65 Reception €193.71
USC Grant €391.04 Socs day expenses €24.13
Speaker accomodation €100
Speaker travel €79
Stationary €9.5
Teacher fees €369
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Expenditure Total €1298.99
Closing Bank Balance €249.55
Total €1548.54 Total €1548.54

Other Information
We held 26 committee meetings during the year and we have held our AGM. Our total membership stands at
503 members.

French Society

French Soc aims to promote the French language in a fun and diverse way and allow NUIG students to interact
with Erasmus students in the college, thereby enhancing cultural awareness about other French speaking
countries whilst also making our visiting students feel welcome around our campus, allowing them also to
experience Irish culture and meet Irish people interested in their homelands. It also aims to establish links with
French universities and their English speaking societies in order to begin exchanges and allow NUI,G students
to experience the fruits of their college life by traveling abroad and putting their studies into practice and to
provide diverse mediums for learning French to cater for as many students as possible - through organizing
activities on different days of the week and by exploring many ways of introducing French and French culture;
through cinema, drama, crepe evenings, workshops, regular get-togethers through French and trips abroad. At
the moment, we currently have 222 members on our mailing list. We won best Departmental Society at the
Society Awards in March for the secondly year running. Vous dites «Pourquoi?», on dit «Pourquoi pas?»!! For a
bit more than your usual "grammaire", why not pop along to the ever-growing and exuberant French

French Soc Events
This year the society had a total of 65 events that took place

Regular Events

This year we held 5 events that ran regularly over a number of weeks. These events were as follows:

Soiree Francaise ran for 9 weeks in DeBurgo's, beginning on Wednesday, 28/9/2005.

Join us to chat in French and enjoy a cosy atmosphere with live music!

Breton Dancing Classes ran for 3 weeks in AM205, beginning on Monday, 7/11/2005.

Learn Breton dancing with an experienced teacher!

French Choir ran for 5 weeks in AM205, beginning on Wednesday, 18/1/2006.

Next Wednesday our French choir will be starting up again. Newcomers welcome. No previous experience/huge talent
required! Flavie Bondaz, our choir director, is going to introduce us to some really great contemporary French music
and this will hopefully culminate in a short lunchtime performance during the Muscailt arts festival on campus.

Soiree Francaise ran for 1 week in DeBurgo's, Augustine St., beginning on Wednesday, 18/1/2006.

FrenchSoc Choir ran for 3 weeks in AM205, beginning on Wednesday, 8/3/2006.

After a successful performance during Muscailt, the French Choir are back and are open to new members!

Special Events

This year we held 44 special events. These events were as follows:

AGM + Opening Reception » O Tnuthail Theatre+ The Hub on Monday, 26/9/2005.
Join FrenchSoc for our AGM and reception with wine, food and breton specialities!
FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 4/10/2005.
'La vie est un long fleuve tranquille'

FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 11/10/2005.
'Un long dimanche de fiancailles'

FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 18/10/2005.
'Les rivieres pourpres: les anges de l'apocalypse’

FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 25/10/2005.
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'La 317e Section'

Lorient Jazz Duo » DeBurgo's on Thursday, 27/10/2005.

Jazz duo all the way from Lorient, Brittany!

FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 8/11/2005.

'La Bataille d'Alger’

La Cantatrice Chauve » Town Hall Theatre on Wednesday, 9/11/2005.

FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 15/11/2005.

'Jeux d' Enfants'

FrenchSoc Choir » Teatar Aras na Gaeilge on Wednesday, 16/11/2005.

Learn modern French songs!

French Film » Town Hall Theatre on Sunday, 20/11/2005.

'the Last Mitterand'

French Film » Larmor theatre on Monday, 21/11/2005.

'Le pere noel est une ordure'

Auditons » AM205 on Tuesday, 22/11/2005.

Auditions for French play 'le pere noel est une ordure'

FrenchSoc Soiree Cinema » Patrick Fottrell Theatre on Tuesday, 22/11/2005.

'Harry, he's here to help'

FrenchSoc Choir » AM205 on Wednesday, 23/11/2005.

Learn modern French songs!

5 Course Meal » The HUB on Thursday, 24/11/2005.

French Meal » The Hub on Thursday, 24/11/2005.

5-course French meal!

Soiree Cinema » O Tnuthail Theatre on Tuesday, 17/1/2006.

Film: Etre et Avoir (2002). Director: Nicolas Philibert A documentary portrait of a one-room school in rural France,
where the students ranging in age from 4 to 11 are educated by a single dedicated teacher. Official selection Cannes
2002. Winner of the Prix Louis Delluc: best French film of 2002.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 17/1/2006.

Societies Day » Aras na Mac Leinn on Wednesday, 18/1/2006.

If you know any friends that would like to sign up to FrenchSoc, Societies Day is next Wednesday all day in Aras na
Mac Leinn. We'll be happy to chat to you about any any queries or more importantly any ideas that you may have!
Soiree Cinema » O Tnuthail Theatre on Tuesday, 24/1/2006.

Film: L'auberge espagnole (2002) Director: Cedric Klapisch A great film about going on Erasmus to Barcelona!

Soiree Cinema » O Tnuthail Theatre (AMB) on Tuesday, 31/1/2006.

Le Diner de cons (1998) Directed by Francis Veber Synopsis: Each week, Pierre and his friends organize what is
called as "un diner de cons". Everyone brings the dumbest guy he could find as a guest...

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 7/2/2006.

Les Choristes (2004) Huge hit last year in France and a great soundtrack! Directed by Christophe Barratier Synopsis:
The new teacher at a severely administered boys' boarding school works to positively affect the students' lives through
music.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 14/2/2006.

French Film » Town Hall Theatre on Sunday, 19/2/2006.

French Film in a travelling cinema! » Mobile Cinema near to Aras na mac leinn on Monday, 20/2/2006.
French Film in a travelling cinema! » Cinemobile outside IT building on Tuesday, 21/2/2006.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 21/2/2006.

Wine Tasting » The Hub on Thursday, 23/2/2006.

FrenchSoc Choir Performance » Aula Maxima on Friday, 24/2/2006.

Choir Performance » Upper Aula Maxima on Friday, 24/2/2006.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 28/2/2006.

Pétanque Tournament » BKs wine bar, Spanish Parade on Wednesday, 1/3/2006.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 7/3/2006.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 14/3/2006.
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La Bete Humaine (1938) Directed by Jean Renoir Based on a novel by Emile Zola Plot Summary: Séverine and her
husband Roubaud kill their former employer in a train. Engineer Jacques watches them...

FrenchSoc Eve of St. Patrick Parade » Outisde Tigh Choili's Pub on Thursday, 16/3/2006.

A unique parade involving the coming together of all the Celtic nations in music. The parade will start at the Spanish
Arch and continue up Shop Street to Courthouse Square. There there will be a pyrotechnics display with a St. Patrick's
theme! There will be a FrenchSoc contingent to welcome the Bretons in the parade meeting outside Tigh Coili's pub.
We will follow the parade up and then meet them in the Town Hall Theatre after the display. All FrenchSoc members
welcome!

FrenchSoc Ceili Fest-Noz » Black Box Theatre on Friday, 17/3/2006.

St. Patrick’s Night at the Black Box in Galway will see a great celebration of the Breton-Irish connection, bringing
together the craic of an Irish ceili with power and spectacler of a Breton Fest Noz. This special event was tried for the
first time ever last May when a large group from Galway’s twin city of Lorient came to Galway for a weekend and the
cultural fusion proved to be a huge success. For St. Patrick’'s weekend 2006 another large group from Brittany is
visiting our city and from locals and vistors alike there was an immediate demand for another Ceili- Fest Noz. A Fest
Noz (literally "festival of the night") is probably the most important and distinctive aspect of Breton culture, a great
coming together of the whole community in a series of large scale participatory dances. Be part of the human chain in
motion, which constitutes the core of Breton dancing! From the Irish side, there will be plenty of seasoned dancers in
attendance who will be happy to take a learner on the floor for a step or two. Music for the evening will be provided by
the Bagad de Lorient and a special Ceili band put together for the occasion by Mick Crehan. A special wooden dance
floor is being installed for the occasion, but there will be a pub type atmosphere as well with tables and seats arranged
around the dance floor and, of course, the "secret weapon" Galway’s own in-house creperie, serving up delicious
Breton crepes and cider throughout the evening Proceedings will kick off at 9pm and don’t come late, because the
serious dancing will start soon afterwards. Admission is €7 and capacity is limited — so book in advance at the Town
Hall Box Office 091-569777

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 21/3/2006.

International Farewell Party » Bazaar on Wednesday, 22/3/2006.

Play by Lorient students » Siobhan Mc Kenna Theatre on Thursday, 23/3/2006.

French Film » Town Hall Theatre on Sunday, 26/3/2006.

Le Pere Noel Est Une Ordure » BOI/ theatre on Monday, 27/3/2006.

FrenchSoc Soiree Cinema » O Tnuthail Theatre on Tuesday, 28/3/2006.

trip to Lorient » Lorient, Brittany on Saturday, 1/4/2006.

Committee 2005/2006

Auditor: Chloé Diskin Vice-Auditor: Eoin O Cuilinn
Treasurer: Caitriona Joyce Secretary: Rory Spellman
OCM: Nicola Doyle OCM: Sheenaz Ahmadnia
PostGrad Rep.: Maura Stewart T.O.: Louise Derrien

PRO: Adam White OCM: Edel Carrigy

Committee 2006/2007
GCM: Catriona Joyce GCM: Adam Whyte

French Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 761.08 Affill/Mem fees €313.56
Fundraising €560 Bank charge €6.27
Members Contributions €1600 Dinner €223.81
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Ticket Sales €19.9 Entertainment €152.63

USC Grant €2410 Equipment misc €18.05
Society transport €4138.2
Stationary €11.99
Teacher fees €60
Expenditure Total €4924.51
Closing Bank Balance €426.47

Total €5350.98 Total €5350.98

Other Information
We held 24 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 466 members.

Geology Society
RocSoc- We host a lecture series throughout the year covering topics from Dinosaurs to mountain building. This
year we had several guest speakers including Prof. lan Sanders and Prof. Patrick Orr and we also managed to
squeeze in a few movie nights and a weekend away in Bundoran, Co. Donegal. (It may have been dubbed

"tacky" by the lonely planet guidebook but we loved it!)

Geology Soc Events

This year the society held a total of 10 events.

stone, bones axes and collapses » AC206 Geology dept. The Quad on Thursday, 6th of October.

A virtual excursion to the Gregory Rift East Africa

Committee meeting » Ac206 on Thursday, 10th of November.

Finalising details for the fieldtrip ie. Travel times, accomodationodation and researching information on various
localities in the area

Snowball Earth » AC206, Geology dept in the Quad on Thursday, 17th of November.

Quartz welding and a late snowball earth phenomenon in Scandanavia

Weekend away (field study) » Bundoran, Co Donegal on Friday, 18th of November.

The first day will be an early-ish rise to utilise the little light and head off for a day's activities along the Sligo coast and
Leitrim. We'll be stopping at Streedagh point (world famous fossil site), Mullaghmore head (Carboniferous Deltaic
Sandstones), quick peek at Ben Bulben and a trip and tour around Arigna mine and museum (heritage coal mine).
Then its back to Bundoran for more evening socialising. The second day its off to The Marble Arch Caves (one of
Europes leading showcaves) Ailwee caves style but better so | hear. The caves are now closed for winter but the
caves' Geologist will open it specifically for us and give us a tour, including sections navigable only in a boat. She has
also agreed to lead us on a tour of the surrounding areas Geology for the rest of the day. Then its back to Galway in
the evening time.

Committee meeting » AC206 Geology dept in the Quad on Wednesday, 23rd of November.

The how where + when of the solar system » Main teaching lab AC213, Geology dept on Saturday, 26th of
November.

Dr. lan Sanders from Trinity College Dublin explains the mysteries of the birth of the solar system.

Committee meeting » AC206 Geology dept in the Quad on Wednesday, 18th of January.

To discuss what events will be held in semester 2

Movie Night » AC206 Geology dept in the Quad on Tuesday, 7th of February.

Watching Jurassic Park from a palaeontological and geological approach. Dinosaurs are no longer extinct!!!
committee meeting » AC203 Geology dept In the Quad on Thursday, 16th of March.

Passing information to incoming committee members.

'The ecology of the Cambrian Radiation' » A206 - Geology Dept., Quadrangle on Thursday, 23rd of March.
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Dr. Patrick Orr from UCD will present a humorous and informative discussion on the sudden and widespread

diversification of complex life at the base of the Cambrian (some 543 Million years ago).

Committee 2005/2006

Auditor: Milo Barham

Secretary: Rachel griffin
Vice P.R.O.: Niamh McMahon

Public Relations Officer: Anna Bunyan

Committee 2006/2007
Auditor: Edward Lynch
Treasurer: Warren Beattie

Geology Society Balance Sheet

Income Category
Opening Bank Balance
Members Contributions
USC Grant

Total

Other Information

Amount
43.29
€350
€929

€1322.29

Treasurer: Aoife Brady

WEB CONSULTANT: Aileen Fitzgerald
WEB CONSULTANT: Rachel Griffin

Vice-Auditor: Daithi MacGearailt

Secretary: Rachel Griffin

Expenditure

Expenditure Category
Dinner

Entertainment

Entry fees

Non Alcoholic Refresh
Reception

Society accommodation
Society transport
Speaker accommodation
Speaker travel
Expenditure Total
Closing Bank Balance
Total

Amount
€120
€25

€76
€13.15
€15
€500
€200
€124
€117.5
€1190.65
€131.64
€1322.29

We held 4 committee meetings during the year. We have not held our AGM yet. Our total membership stands at

212 members.

German Society

Germansoc aimed to promote aspects of German, Austrian and Swiss life in NUI, Galway. Through running
various events we hoped to establish and encourage an international environment on campus.
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German Soc Events

Bar Abend ran for 12 weeks in Bierhaus, beginning on Tuesday, 4/10/2005.

Weekly indoor soccer! ran for 11 weeks in Sportshall, beginning on Thursday, 12/1/2006.

Bar Abend ran for 8 weeks in The Living room, beginning on Tuesday, 31/1/2006.

Boat trip » Corrib Princess on Friday, 30/9/2005.

Oktoberfest » De Burgos on Tuesday, 8/11/2005.

Christmas Party » De Burgos on Tuesday, 27/12/2005.

kick-off party 2006! » De Burgos on Tuesday, 17/1/2006.

Germansoc would like to invite all members and friends to our big kick-off party for 2006! We are hoping to attract as
many people as possible! There is always plenty of international students and its a great chance to get a slice of
international culture! Specifically, there will be plenty from Germany and some from France but we hope to see all
nationalities on the night! All are welcome! Its on in De Burgos and there is alot of drink promotions on offer as well as
much much more! | will email all subscribers with details and posters will be pinned up! | hope to see you there!

1st Barabend of 2006 » DeBurgos on Wednesday, 25/1/2006.

The Burren Weekend » The Burren, Co. Clare on Friday, 17/2/2006.

The Germansoc Burren Weekend is a long lasting annual tradition dating back some 15 years. Its open to members to
spend a german speaking weekend away at the Burren. Tickets cost €20 and that includes 2 nights
accomodationodation, transport to and from NUIG, and meals. Its always proved thoroughly enjoyable!

INTERSOC 7 ASIDE FOOTBALL TOURNAMENT » Dangan Sports Complex on Monday, 27/2/2006.

The German Play » Bank of Ireland Theatre on Tuesday, 7/3/2006.

'Was kostet das Eisen' and 'Die Kleinbuergerhochzeit' by Bertolt Brecht Two one act plays presented by the German
Society. We hope to see you all there to support all involved. Runs from march 7th - 9th 8pm in the Bank Of Ireland
Theatre.

Irishe Fussball Meisterschaften 2006 » Dublin on Saturday, 11/3/2006.

10 German societies from universities and institutes in Ireland will be participating in a 6-a-side soccer tournament in
Dublin!

International Farewell Party! » Bazaar on Wednesday, 22/3/2006.

Committee 2005/2006

Auditor: Eoin Kelly Vice-Auditor: Breda Kelly

Treasurer: Cliona Murray Hon. Treasurer & Departmental Liason Officer: Vincent O Connell
P.R.O: Brian O Connell

German Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 6.92 Costumes €270
Fundraising €990 Entertainment €2614.4
Socs box €995 Makeup/Props €230
Sponsorship €0.09 Materials €572.2
Ticket Sales €1079.83 Non Alcoholic Refresh €168
USC Grant €965
Expenditure Total €3854.6
Closing Bank Balance €182.24
Total €4036.84 Total €4036.84

Other Information
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We held 16 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 250 members.

GiGSoc (Gay in Galway)

GiGSoc (Gay in Galway) strives to create a safe environment for Igbt staff and students on campus. By hosting
various social and educational events throughout the year and contributing to the regional development as well
as national US| LGBT policy, GiGSoc (Gay in Galway) facilitates the development of a real community spirit.
Working with people at all levels of the coming out process, GiGSoc (Gay in Galway) provides a conduit through
which Igbt people can communicate, learn about relevant issues and have fun. This year GiGSoc (Gay in
Galway) have produced numerous events ranging from serious to completely informal. Highlights of the year
included the first gay wedding ceremony (GiGSoc accepted no responsibility for the participants accidentally
getting married), GiGSoc Idol, Smells Like Queen Spirit and a production of The Birdcage.

GiGSoc (Gay In Galway) Events

This year the society held a total of 23 events.

Societies Day » Aras na Mac Léinn on Wednesday, 21st of September.

First meeting » /T204 on Tuesday, 27th of September.

DJ Dance-off » Strano on Thursday, 6th of October.

Smells Like Queen Spirit » Eden nightclub, Warwick Hotel, Salthill on Wednesday, 19th of October.

EGM & 'The Hours' » IT204 on Tuesday, 25th of October.

Pink Pages » /T204 on Tuesday, 1st of November.

Bowling » Meet outside IT204 on Tuesday, 8th of November.

GiGSoc Idol » The Stage Door, Woodquay on Tuesday, 15th of November.

Complementary Therapy Night » /T202 on Wednesday, 23rd of November.

Christmas Party » Club deBurgos, Augustine Street on Tuesday, 29th of November.

Mind, Body, Soul » Cindy Dring's Office, The Hub on Monday, 23rd of January.

First Meeting :: Who Are We? » IT204 on Tuesday, 24th of January.

GIG Soc: Smells Like Queen Spirit » An Pucan (upstairs) on Thursday, 2nd of February.

USI Discussion Group » /T204 on Tuesday, 7th of February.

Auditions for 'The Birdcage' » /T202 on Wednesday, 8th of February.

Gay Acceptance Week » NUI, Galway on Sunday, 12th of February.

Weekly Events Monday : Stall in Aras na Mac Leinn 9-5 Tuesday : Wedding Day! Aula Max, upstairs @ 8.30pm.
Wednesday : Stall in Aras na Mac Leinn 9-5 Thursday : AidsWest Meeting. A meeting will be held in the Harbour Hotel,
Lough Atalia road, Galway on Thursday 16th February from 2pm until 5pm (tea & coffee provided). The plan is to
discuss an LGBT community project for Galway city & to help promote the LGBT presence in the West.

Gay Wedding Invitation » Aula Maxima, NUI, Galway on Tuesday, 14th of February.

GiGSoc Cordially invites you to join in celebrating NUI, Galway’s first Gay Wedding Ceremony on St Valentine’s Day
@ 8.30pm in Aula Maxima, NUI, Galway. The reception/afters will be in The Stage Door, Woodquay. Please Note: No
recording equipment at grooms’ request.

Film Night :: The Bird Cage » /T 204 on Tuesday, 21st of February.

Charity Slave Auction » Club Aras na nGael on Tuesday, 28th of February.

GiGSoc Unplugged » Buskers Browns on Tuesday, 7th of March.

Blind Date » Stranos on Tuesday, 14th of March.

The Birdcage » Town Hall Theatre Studio on Wednesday, 22nd of March.

AGM » IT 204 on Tuesday, 28th of March.

Committee 2005/2006

Auditor: Jo Treasurer: Sean
Secretary: Liam Auditor: Alan
Education Officer: Jeff Extraordinary Committee Member: Liz
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New Members Liason Officer: Daire

Committee 2006/2007

Auditor: Jeffrey Treasurer: Raymond

Secretary: John New Members Liason Officer: David
Co-Auditor: Rachel Public Relations Offficer: Amy
Extraordinary Committee Member: James Education Officer: Kiran

GIG Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 494.9 Affill/lMem fees €784.16

Fundraising €176 Bank charge €8.38

Greenform €600 Costumes €304.89

Ticket Sales €694 Dinner €70

USC Grant €1663.17 Entry fees €111.3
Equipment misc €490
Makeup/Props €81
Materials €70
Non Alcoholic Refresh €38.7
Printing €50
Prizes €40
Promotions €55
Reception €271.7
Society accommodation €14.8
Society transport €225
Socs day expenses €100

Teacher fees

Other Information
We held 10 committee meetings during the year and we have held our AGM. Our total membership stands at 75
members.

Goal Society
Throughout the year we helped to raise funds for GOAL projects abroad and helped to raise awareness of those
projects on campus. The year was a very successful one with the society handing over €3,000 to GOAL in April.

Goal Soc Events

This year the society held a total of 3 events.

Table Quiz » College Bar on Monday, 24th of October.

Leg Waxing » College Bar on Thursday, 17th of November.

Goal Soc put on a very original night for collecting for charity. Students came from near and far. Some willing
and eager others petrified and nervous. A great night was had by all.

Speed Dating » College Bar on Wednesday, 8th of February.

Committee 2005/2006
Auditor: Alan Dunne Vice-Auditor: Colin Lyons
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Treasurer: Laverne Mullen Secretary: Crona Glynn

Committee 2006/2007
Auditor: Colin Lyons

Goal Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 493.08 Bank charge €1.12

Fundraising €2424.53 Fundraising/charity €3200

Sponsorship €400 Prizes €100

USC Grant €300 Reception €140
Expenditure Total €3441.12
Closing Bank Balance €176.49

Total €3617.61 Total €3617.61

Other Information
We held 18 committee meetings during the year and we have held our AGM. Our total membership stands at
210 members.

The Green Party Society

The NUIG Young Greens aim to provide a forum for debate on social, environmental, economic and
international issues. We aim to campaign for a just, sustainable and free society with decision making in the
hands of the people. We fight against racism and the exploitation of countries and people by corporations, and
government inaction on key issues. We give young people the best opportunity to partake in politics and
activism with our organisation run from the members up. We are linked to the Green Party/ Comhaontas glas,
who we see as the best party to achieve change in Ireland.

Green Party Soc Events

This year the society held a total of 39 events.

Guest speaker, Trevor Sargent » Dillon Theatre on Tuesday, 20th of September.

Green Party Leader Trevor Seargent will address the society to talk about the Greens in government, the role younger
members have to play in the party, the present and future of the Greens in Irish politics, all welcome, a reception will
follow.

Guest speaker, Trevor Sargent » Dillon Theatre on Tuesday, 20th of September.

Green Party Leader Trevor Sargent will address the society to talk about the Greens in government, the role younger
members have to play in the party, the present and future of the Greens in Irish politics, all welcome, a reception will
follow.

EGM » AM108 on Wednesday, 28th of September.

Weekly Meeting » AM108 on Wednesday, 5th of October.

Weekly meeting » AM108 on Wednesday, 12th of October.

Weekly Meeting » AM108 on Wednesday, 19th of October.

Regular meeting » AM108 on Wednesday, 26th of October.

Weekly meeting » AM108 on Wednesday, 2nd of November.

Regular meeting » AM108 on Wednesday, 9th of November.

Waste/Energy week, event1 » Larmor Theatre on Monday, 14th of November.

A Panel discussion on energy, Lars Tutterson from Scanhomes, Grattan Healy an energy consultant and Larry Stuart
from the Centre for Renewable Energy in Dundalk IT will be on the panel.
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Waste/Energy week, "The End of Suburbia” » Dillon theatre on Tuesday, 15th of November.

A documentary film on oil depletion and the future of America and the world in a world without cheap oil.

Regular meeting » AM108 on Wednesday, 16th of November.

Waste/Energy week, waste discussion » McMunn Theatre on Wednesday, 16th of November.

Green City Councillor Niall O'Brolchain, Prof. John Simmie from the NUI, Galway combustion group, Prof Emer
Colloran from the Environmental Change Institute will be on the panel.

Trip to National convention » Eire square on Friday, 18th of November.

Regular meeting » AM108 on Wednesday, 23rd of November.

Fairtrade Fr. Ted » /T125 on Wednesday, 30th of November.

A chance for students to relax for a while at this stressful time of year, we will be showing classic episodes of Fr. Ted
and Fairtrade and fairly traded tea and coffee will be available. All welcome.

Meeting » AM108 on Wednesday, 11th of January.

Society meeting » AM108 on Wednesday, 18th of January.

Young Greens Meeting » AM108 on Wednesday, 25th of January.

Slow Food Week » Aras Na Mac Léinn on Tuesday, 31st of January.

A series of events highlighting the subject of "Slowfood", which encompasses subjects such as; organic food,
sustainable agriculture, sustainable local food etc. An information stall will be in Aras na Mac Léinn all week.
Slowfood Week; "What is Slowfood?" » Tyndall Theatre on Tuesday, 31st of January.

Seamus Sheridan from Slow food Ireland and former governor of "Slow Food international" will give a talk on the
subject of slow food. A reception will be held afterwards, all welcome.

Weekly meeting and open forum » AM708 on Wednesday, 1st of February.

Film; "The Future of Food" » /T125 on Thursday, 2nd of February.

The film is a documentary on GM food and where our food will come from in the future, won among other awards the
2005 Ashland Independent Film Festival's "Audience Award for Best Documentary." The director, writer and producer
of The Future of Food is Deborah Koons Garcia, widow of the Grateful Dead’s Jerry Garcia. A reception will follow.
Weekly meeting » AM108 on Wednesday, 8th of February.

Weekly Meeting » College Bar on Wednesday, 15th of February.

Film Fleadh » /T125, AM250, IT125G on Monday, 20th of February.

The First annual Young Greens @ NUI, Galway International Independent Film Fleadh. A week long series of films on
various issues.

Film; The Corporation » /T 125 on Monday, 20th of February.

Film; Empire of Juramidam » AM250: Colm O hEocha Theatre on Tuesday, 21st of February.

Film; Chavez: Inside the Coup » AM250: Colm O hEocha Theatre on Wednesday, 22nd of February.

Film; The kidnapping Of Ingrid Betancour » /T125G on Thursday, 23rd of February.

Film; Life and Debt » /T125G on Friday, 24th of February.

Young Greens Spring Convention » Siobhan McCenna Theatre on Saturday, 25th of February.

Deligates from Young Greens groups around the country will be attending a day of events, including workshops on
canvassing and the work of the Galway Rape crisis centre. Environmentalist and presenter Duncan Stewart will be
addressing the convention on energy. All are welcome and refreshments will be served.

Weekly meeting » AM108 on Wednesday, 8th of March.

Regular Meeting » AM108 on Wednesday, 15th of March.

AGM » AM108 on Wednesday, 22nd of March.

Trip to the Green Party Convention » Eire Square on Friday, 24th of March.

A group of our society members will be attending the Green Party convention in Kilkenny from Friday to Sunday.
Fairtrade Fr. Ted. Il » IT125 on Tuesday, 18th of April.

Committee 2005/2006

Auditor: Joanne Coffey Vice-Auditor: Andrew Murphy
Treasurer: Micheal Mac Donnchadha Secretary: Shane Connolly
OCM: Rachel Sukeforth OCM: James Hope

Liaisons Officer: Jean Hamilton PRO [Press]: Niamh Mulvey

47



PRO [Posters]: Paul Finnegan Irish Officer: Eoin Golden

Green Party Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 0 Affill/Mem fees €120

Balls €122.5 Reception €102.3

Sponsorship €120 Returned Money €122.2

USC Grant €1311.3 Society accommodation €383
Society transport €120
Speaker accommodation €250
Speaker travel €295
Expenditure Total €1392.5
Closing Bank Balance €161.3

Total €1553.8 Total €1553.8

Other Information
We held 18 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 116 members.

History Society

An Cumann Staire / The History Society is one of the most well established societies on campus and enjoys
consistent support from Roinn na Staire. The society welcomes speakers and aims to aid in our mission to
indoctrinate a love of history, and secure world domination. The society annually is responsible for the smooth
running of everyone's favourite dress ball, The Arts Ball. Is Cumann dha-theangach é an Cumann Staire agus is
aoibheann linn gach deis chun ar dteanga alainn a chur chun cinn.

This year we continued to provide Students with lecture both on and off campus, we continued with the Ruby
Room Lecture series began last year in the Kingshead. This year we had interesting lectures on topics from
"Vietnam and Iraqg and the American collective attitude to War by Dr. David Ryan" to "Travelers: people
persecuted Historical In Ireland north and South?" on Campus. While in the Ruby Room we had a Lecture by
Maura Walsh of our Own Department on Early Medieval Music which was followed by an impromptu seisiu
Cheaoil.

The Society also traveled to Dun Eidin/ Edinburgh in January in an attempt to create a link between the History
Soc Here at NUIG and the one at the University of Edinburgh unfortunately we are sill in discussion about this
and noting has been arranged fully. But luckily for us and those who joined us on our weekend in Edinburgh
there is plenty of Historical monuments in the City and we did manage to visit a few, including the beautiful
Castle and we were treated to a private guided tour of The House of Parliament by the Scottish Nationalist
Party and we also showed the residents some Irish Craic.

Also thanks to the help of the Department who encouraged links with Edinburgh, Prof. Steven Ellis and a
counterpart from the University of Mainz, Germany, Prof Ludolf Palizaeus the society is forging links with the
University of Mainz, History society and we hope to visit them and return visit from them to Galway in the next
academic year. This link is supported and encouraged by the Departments in both universities. Both these are
attempts to aid those who wish to pursue post grad work but with the possibility
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The Society also sent five post grad speakers to the Annual (Irish History Societies Conference)in Limerick,
these were supported by three members of the Committee and the Head of The Department Steven Ellis.

And how could we forget the hugely successful Arts Ball at the Radisson SAS in Galway at which 900 students
attended, the number was originally 700 but demand was so great we had to provide 200 more. with purchase of
the ticket everybody received a booklet containing the upcoming events of the Fleadh Imboilg of Which the Ball
was the Centerpiece. The evening was a fantastic success with pre-reception at Bar-903 and then Dinner and
Dancing in the Radisson to the music provided by some musician from Trad Soc who organised a céili after the
meal, then the Lewd Tunes a popular local Band and final DJ Byrno played tunes for us into the small hours of
the Following morning. The next a discounted breakfast was organised for those who had wristbands from the
night before in Bar903 and entertainment in the Collage Bar after which the wristbands allowed free entry to the
Cuba* nightclub that night.

History Soc / Cumann Staire Events

This year the society held a total of 12 events.

Early Irish Music » Ruby Room, Kings Head on Wednesday, 25th of January.

Arts Ball Tickets Queue » http.//brockman.nuigalway.ie/~historysoc on Wednesday, 1st of February.

Arts Ball tickets go on Sale » Aras na MacLéinn on Thursday, 2nd of February.

Arts Ball » Radisson SAS on Thursday, 2nd of February.

The Arts Ball at the Radisson SAS in Galway was a tremendous success with over 900 students attending, the
number was originally 700 but demand was so great we had to provide 200 more. With purchase of the ticket
everybody received a booklet containing the upcoming events of the Fleadh Imboilg of Which the Ball was the
Centerpiece. The evening was a fantastic success with pre-reception at Bar-903 and then Dinner and Dancing in
the Radisson to the music provided by some musician from Trad Soc who organised a cgili after the meal, then
the Lewd Tunes a popular local Band and final DJ Byrno played tunes for us into the small hours of the
Following morning. The next a discounted breakfast was organised for those who had wristbands from the night
before in Bar903 and entertainment in the Collage Bar after which the wristbands allowed free entry to the
Cuba* nightclub that night.

Vietham", Victory Culture and Iraq » Téatar Fottrell Theatre (AM200) on Wednesday, 22nd of February.
"Vietnam", Victory Culture and Iraq: Struggling with Lessons, Constraints and Credibility from Saigon to Falluja
Guest lecturer: Dr. David Ryan of UCC

Guest Speaker: Dr. Ludolf Palizaeus » O'Tnuthail theatre A.M. Building on Wednesday, 8th of March.

A very interesting guest speaker is visiting NUI, Galway this Wednesday and | know you will be very dissapointed if you
missed him. The speaker in question is Dr. Ludolf Palizaeus from Mainz and his topic is on Philip Il and the British
Isles. All are welcome to attend.

James VI & | and the Witches of Macbeth » Tyndall Theatre on Tuesday, 14th of March.

The Real Naomh Padhraig » Ruby Room of the Kings Head on Wednesday, 15th of March.

Travellers and the State 1922-70 » /T125 on Monday, 20th of March.

Travellers and the State (North and South) 1922-70' By Dr Aoife Bhreathnach IRCHSS Post-Doctoral Fellow
Department of Modern History NUI Maynooth Dé Luain 204 Marta 20:00 ait: IT125

"Sensuality without responsibility"?: » AC214 on Wednesday, 22nd of March.

Reconstructing French identity, 1944-46 » CSHSHC on Monday, 27th of March.

The response of the Allied Powers in Eur » CSHCHC on Tuesday, 28th of March.

CCB - AGM » IT207 on Thursday, 30th of March.

Committee 2005/2006

Auditor: Tadhg O Broin Vice-Auditor: Tommy O Murchu
Treasurer: Duibhir Secretary: Fiona Nic Eoghain
lonadai Trit Bliana/3 Year Rep: Grace Ni Shealbhaigh  Oifigeach IHSA: Diarmuid O hUrthuile

lonadai iarchéime/Postgrad Rep: Rose Anne de

Runai Chomhfhreagrais/Secretary: Claire Ni Ghallchoir Faoite
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lonadai Chéad Bliana/1 Year Rep: Enda Breathnach
Oifigeach Chaidreamh Poibli/PRO: Eoghan Mac

Siurtain

Oifigeach Seirbhisi Teicniula: Pait O Flaitheartaigh

Committee 2006/2007
Auditor: Tonai O Roduibh
Secretary: Tadhg Byrne

lonadai Bhliain Deirneach /Final Year Rep:
Claire Ni Ghallchoir

Oifigeach Chaidreamh Poibli/PRO: Russel

History Society Balance Sheet

Income

Income Category

Opening Bank Balance

Greenform

Members Contributions

Sponsorship
USC Grant

Total

Other Information

Amount
177.83
€50
€585.67
€200
€2028.5

€3042

Treasurer: Sorcha Turner

lonadai Dara Bliana/2 Year Rep: Michael Barter

Eagrai don Arts Ball 2006: Tonai O Roduibh

lonadai Dara Bliana/2 Year Rep: Enda Breathnach

Rose Anne de Faoite

Expenditure Category

Bank charge
Dinner

Entry fees
Equipment misc
Reception

Returned Money

Society accommodation

Society transport

Speaker accommodation

Speaker travel

Expenditure Total

Not included Unreconciled Cheque Total

Closing Bank Balance

Total

Expenditure

lonadai larchéime agus IHSA /Postgrad and Ihsa Rep.:

Eagraitheoir don Arts Ball 2007: Sé O Duibhir

Amount
€13.66
€192.1
€165
€20
€356.04
€108
€1042.16
€330

€95
€145
€2466.96
(€30)
€575.04
€3042

We held 15 committee meetings during the year and we have held our AGM. Our total membership stands at

596 members.

Horse Racing Society
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The Horse Racing Society is delighted to report yet another year of outstanding success, cementing our position
as one of the Colleges' leading societies in terms of Charity Fundraising.

Our main event, as ever, was our Cheltenham Preview night, held this year on the 6th of March in the Salthill
Hotel. The night was a record breaking success, with a crowd of approximately 550 attending. In the region of
€20,000 was raised for Direct Aid For Africa on the Night, and the Society would like to thank all those who
contributed time and money to this worthy cause, especially our many sponsors. All this was achieved solely
through the work of society members.

In terms of other society activity, we also held a trip to Limerick races on March 2nd, which was thoroughly
enjoyed by all who attended.

Horse Racing Society Events

This year the society held a total of 4 events.

Committee Trip to Punchestown » Punchestown Racecourse on Thursday, 27th of October.
Meeting » The Hub on Wednesday, 11th of January.

Limerick Races » Limerick Racecourse on Thursday, 2nd of March.

Cheltenham Preview » Salthill Hotel on Monday, 6th of March.

Committee 2005/2006

Auditor: William Morris Vice-Auditor: David McElroy
Treasurer: Bobby Glavin Secretary: Brian Morris
PRO: Ronan Byrnes

Committee 2006/2007
Auditor: William Morris Vice-Auditor: David McElroy

Treasurer: Brian Morris Secretary: Bobby Glavin

Horse Racing Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 1075.17 Bank charge €15

Fundraising €500 Fundraising/charity €19903

Sponsorship €19903 Hire Bus €605
Expenditure Total €20523
Closing Bank Balance €955.17

Total €21478.17 Total €21478.17

Other Information
We held 3 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
150 members.

The Human Rights Society

51



The Human Rights Society this year had a quieter year than last. Support was high as it always is however
participation was lower. The year started of with an Introduction to Human Rights Law from Dr. Kathleen
Cavanaugh a lecturer from the Human Rights Centre here in college. The campus unfortunately then had to wait
until March for the next Human Rights Soc event which was the running for the second time of the hugely
popular and successful GRA (Global Rights Awareness) Week. The week this year remained in the same format
as the award winning event last year and featured many notable speakers including Michael D Higgins T.D. .
The week covered various topics including the AIDS crisis in Africa, the Rossport Five campaign, and Women's
rights, and attracted more than two hundred people in total to the events over the four days. Although a quiet
year for the Human Rights Society there is support in the college and the issues involved in the protection of
international Human Rights are going to be always available for future committees to tackle.

Human Rights Soc Events

This year the society held a total of 8 events.

Introduction to Human Rights Law » McMunn on Thursday, 1st of December.

Dr Kathleen Cavanaugh giving a brief introduction to the legal aspects of the protection of human rights around the
world.

Gra week » McMunn theatre on Saturday, 4th of March.

Gra Opening Ceremony » Siobhan McKenna on Monday, 6th of March.

The opening Ceremony for this year's Gra (Global Rights Awareness) week, which in its second year is only getting
bigger and better. The week is being launched this year by Michael D Higgins, and other speakers will include
Donnacha O'Connel Dean of the Law Faculty, Sam Butt of Amen fathers rights group, Ciara Smith who will speak on
the troubles in Cambodia, Luke McDonagh who will speak on cultural rights, Stephen Nganga who will give us an
insight into AIDS in Kenya and immigration rights along with a speaker from the Irish centre for Human Rights.
Entertainment will be incorporate Irish, African, Roots music with some poetry and juggling thrown in for good measure.
A reception after will also allow discussion.

Gra » Accross Campus on Monday, 6th of March.

Gra week » AC215 on Tuesday, 7th of March.

Gra week » Art gallery in the Quad on Wednesday, 8th of March.

Gra week » Art Gallery in the Quad on Wednesday, 8th of March.

Gra Week: Film: Yasmin » McMunn Theatre, Concourse. on Wednesday, 8th of March.

UK Film for International Women's Day tell the story of Yasmin, a midlands woman of Pakastani extraction who's life is
changed by the events of September 11th. 'The first casualty of war may not be truth but trust'

Committee 2005/2006
Auditor: Laura Heneghan Vice-Auditor: Patricia Descambes
Treasurer: Joanne Coffey Secretary: Thomas Meehan

Human Rights Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 0 Dinner €97.21

USC Grant €550 Makeup/Props €9.4
Non Alcoholic Refresh €81.35
Printing €60
Reception €167.89
Society transport €40
Speaker travel €46
Stationary €48.15
Expenditure Total €550
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Total

Other Information

Closing Bank Balance

€550 Total

€550

We held 5 committee meetings during the year. We have not held our AGM yet. Our total membership stands at

375 members.

International Students Society

The International Student’s Society is open to all visiting and Irish students. We encourage multicultural activities
and the sharing of diverse cultures. We do this through planning trips, social events and our famous ‘Dincert’
which celebrates food, culture and music of the world. Our committee meets every Thursday at 5pm in the Hub.
We are always looking for new ideas and members. We meet socially every Wednesday at 9pm at the Kings

Head. All are welcome.

International Students Soc Events

This year the society held a total of 8 events.

Trip to the Cliffs of Moher » Cliffs of Moher on Saturday, 1st of October.
Trip to Belfast » Belfast on Friday, 4th of November.

Trip to Burren » Burren on Thursday, 10th of November.

Trip through Connemara » County Galway on Monday, 21st of November.
Trip through Connemara » County Galway on Monday, 21st of November.
Trip to the Cliffs of Moher » Cliffs on Friday, 27th of January.

AGM » Aula Maxima on Wednesday, 8th of February.

international student society dincert » Aula maxima on Wednesday, 8th of February.

Committee 2005/2006
Auditor: Gamuledu Nthaba
Treasurer: Lisani Ntoni

Additional Members: Ali Al-Sharek

Vice-Auditor: Ashfaaq Maher

Secretary: Faridah
Mentor: Saud Al

International Students Society Balance Sheet

Income

Income Category Amount
Opening Bank Balance 726.43
Members Contributions €2500
Socs box €1250
Ticket Sales €725.48
USC Grant €1325
Total €6526.91

Other Information

Expenditure
Expenditure Category
Bank charge
Dinner
Society accomodation

Society transport

Expenditure Total

Does not include Unreconciled Cheque Total
Closing Bank Balance

Total

Amount
€75
€200
€3354.55
€480

€4042.05
(€1650)

€2484.86
€6526.91
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We held 20 committee meetings during the year and we have held our AGM. Our total membership stands at
500 members and we have submitted our list of members to the Societies Office.

Italian Society

The ltalian Society has this year succeeded in creating awareness throughout the college of presence and
activities. With a committee composed mainly of returned Erasmus students, we felt it was highly important to
bring some of the culture we experienced last year to the university, as well as to promote greater links with the
Italian community at NUIG.

The society focused on social events such as meetings in Massimo's, a Carnivale masquerade ball, and a table
quiz. It was felt that we needed to emphasise the social aspect of the society, as it is in this way that connections
can best be made between Italian and Irish students. Whether between Irish people, or with Italians involved,
everyone made an effort on these evenings to make some practical use of the language we study in college.

The Carnivale event was perhaps our best event focused on culture. Italians in Galway seemed delighted that
they didn't miss out on what in Italy is one of the biggest events of the year. Arus na nGael proved a highly
successful venue, allowing us to ask along a group of Neapolitan musicians who made sure we were all dancing
by the end of the night.

Our ltalian History lecture drew a large crowd, comprising of Italians, Irish students, and a surprising number of
non-students who came along out of interest. It proved that good advertising can go a long way! It was
followed by a wonderful, spontaneous debate on the nature of Italian identity, and a wine reception.

This year we also organized for third year students taking orals to visit italy and meet up in Turin for a few days
before the orals to improve their Italian conversational skills.

Italian Soc Events

This year the society held a total of 6 events.

AGM/Welcome Party » Arus na nGael on Saturday, 15th of October.

Table Quiz » Massimos on Saturday, 5th of November.

Get Together » massimos on Wednesday, 25th of January.

History Talk » Siobhan McKenna Theatre (first floor AM) on Thursday, 26th of January.
Carnevale » Arus na nGael on Thursday, 16th of February.

Italian Trip » Turin, May 2006.

Committee 2005/2006

Auditor: Eanna Conneely Vice-Auditor: Sinéad Geoghan
Treasurer: Lisa Leahy Secretary: Eilis Ryan
P.R.O: Michael Nolan Honorary Treasurer: Maeve Egan

Italian Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 50.84 Affill/Mem fees €30.85
Members Contributions €861 Bank charge €3.75
Ticket Sales €40 Entertainment €327.15
USC Grant €1132 Gifts €21

54



Society accomodation €232

Society transport €1192
Socs day expenses €16
Expenditure Total €1822.75
Closing Bank Balance €261.09
Total €2083.84 Total €2083.84

Other Information
We held 8 committee meetings during the year and we have held our AGM. Our total membership stands at 160
members.

Juggling Society

The main aim of the Juggling society is to encourage and develop juggling, other circus skills and physical performance in
NUI, Galway. In particular, we seek to provide a space for practice, socializing, skill sharing and performance. Also, we
organise trips to Juggling events and host our own. In doing this, we hope to provide an alternative means of recreation which
is physically and mentally active, productive, progressive, yet non-competitive.

The juggling society juggles things, spins things, throws things, and swings things. We teach and learn juggling, diablo, poi,
acrobalance, spinning plates, devil sticks, staff, cigareboxes, hacky sack, Yo-Yo, Rola-bola, Frisbee and anything else we can
think of.

It is one of the few performing arts societies in the college. We provide a medium for the expression of visual and skills based
performance on a non-competitive level. We encourage active participation from students from all departments and walks of
life.

The social aspect of the society is especially fostered in the skills sharing sessions. We have attracted numerous foreign
students to the sessions to learn diverse skills and make new friends while visiting our country and university.

We are very proud and delighted for our members to have won best society in NUI Galway and to have gone on to win best
Society at the national awards hosted by Cork IT on April 13",

Juggling Soc Events
This year the society had a total of 95 events that took place.

Ball-Passing Workshop ran for 5 weeks in Circus Culture, beginning on Wednesday, 7/9/2005.

Ball-passing Workshop with Circus Culture

Cup of Tea and Relax in the college bar ran for 12 weeks in College Bar, beginning on Tuesday, 10/1/2006.
Acrobalance classes ran for 3 weeks in Art Gallery in the Quad, beginning on Wednesday, 25/1/2006.
Acrobalance in association with Mind body soul program and circus culture in the Art Gallery

Open Session of Juggling ran for 9 weeks in Bank of Ireland Theatre, beginning on Thursday, 2/2/2006.

Open Session of Juggling ran for 2 weeks in Aras Na Mac Leinn Sports Hall, beginning on Tuesday,
28/3/2006.

Open Session of Juggling ran for 2 weeks in BOIl Theatre or Aras na Mac Léinn Atrium, beginning on
Thursday, 30/3/2006.

Ball-Making Workshop » The Hub on Sunday, 4/9/2005.

Anyone who still doesn't own 3 balls has a chance to make their own: Ingredients provided.

Socs open day » Aras na Mac Leinn on Wednesday, 21/9/2005.

Introduction to 3 Ball Juggling » Bank of Ireland Theatre on Monday, 26/9/2005.

An invitation to all new members of the society to take the first steps in learning to juggle 3 balls.

Workshops: 3 Ball and Acro-balance. » Aras na Mac Léinn Sports Hall. on Tuesday, 27/9/2005.

A further workshop on juggling 3 balls for beginners as well as in introduction to acro-balance. Open juggling session
for those not involved in the above.

Clonakilty Juggling Convention » Clonakilty on Friday, 30/9/2005.

Clonakilty Juggling Convention » Clonakilty on Saturday, 1/10/2005.
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Open Session of Juggling » BO/ Theatre on Monday, 3/10/2005.

An open session for all members to share skills and have fun.

Workshops: Acro-Balance and Poi » Aras na Mac Leinn Sports Hall on Tuesday, 4/10/2005.

A workshop hosted by the experienced Kiki who is from a circus school in Berlin. Open session of juggling for all those
not involved.

Open Session of Juggling » BOI Theatre on Monday, 10/10/2005.

Workshop: Devil Stick and Advanced Poi » Aras ma MacLeinn Sports Hall on Tuesday, 11/10/2005.
CircusCulture will give a beginners workshop in this discipline. We only have enough sticks for 20 people so come on
time if you want to participate. Also this week we are joined by Ronan, Ireland’s premier poi swinger, who will be
teaching at an advanced poi workshop.

Open Session of Juggling » Ardas ma Mac Leinn Racquetball Courts on Monday, 17/10/2005.

Workshop: Beginners' Poi » Aras ma Mac Leinn Sports Hall on Tuesday, 18/10/2005.

Beginners' Poi workshop. Bring your own if you can. Open session of juggling for those not involved.

Society Party! » Bar903 on Tuesday, 18/10/2005.

There will be a JugglingSoc Party in Bar 903 (under Cuba). There will be free food and passes to Cuba afterwards.
Everyone is welcome & it should be great craic!!

Cluain Mhuire Fundraising in the Warwick » Warwick Hotel on Thursday, 27/10/2005.

Open Session Of Juggling » BOI Theatre on Monday, 31/10/2005.

Workshop: Beginners's Staff » Aras ma Mac Leinn Racquetball Courts on Tuesday, 1/11/2005.

Bring your own Staffs, mop and broom handles or whatever else and we'll supply the rest! Open session of juggling for
those not involved.

Tralee Juggling Convention » Tralee on Friday, 4/11/2005.

This will take place from Friday November 4th ‘til Sunday November 6th. We are arranging transport,
accomodationodation and convention registration. Tune into further emails or talk to Nick or Colm at meetings for more
info on price and convention details

Toby Walker: World's Greatest Juggler » Siobhan McKenna Theatre on Monday, 7/11/2005.

Juggling Performance from the LEGENDARY TOBY WALKER, the world's finest club juggler and friends in
RENEGADE SHOW.

Workshop: Advanced 3 Club » Aras na Mac Leinn Sports Hall on Tuesday, 8/11/2005.

Club Juggling workshop given by Toby Walker. Places will be limited to 25 so make sure to be there early and bring
your equipment.

ABU with DJ Soc » Aras na Gael on Thursday, 10/11/2005.

Fire performance in Aras Na Gael.

Open Session of Juggling » BOI Theatre on Monday, 14/11/2005.

Workshop: Acro-Balance » Aras na Mac Léinn Sports Hall. on Tuesday, 15/11/2005.

This week CircusCulture, featuring Ronan from Paris, will run an Acrobalance workshop.

Open Session of Juggling » Aras na MacLeinn Racquetball Courts on Monday, 21/11/2005.

Skill Sharing Session and Workshop » Aras na Mac Léinn Sports Hall on Tuesday, 22/11/2005.

Open Session Of Juggling » Ar as na Mac Leinn Racquetball Courts on Monday, 28/11/2005.

Open Session Of Juggling » BOI Theatre on Tuesday, 29/11/2005.

University Open Day Performance » Aras na Mac Leinn Atrium on Thursday, 1/12/2005.

Juggling for future prospective members of the university!

Open Session Of Juggling » Aras Na Mac Leinn Sports Hall on Monday, 5/12/2005.

Open Session of Juggling » BOI Theatre on Tuesday, 6/12/2005.

Night out in Roisin Dubh » Roisin Dubh on Wednesday, 7/12/2005.

Open Juggling Session » BOI theatre on Monday, 12/12/2005.

Christmas Party! » Kayak Shed in Fisheries Field on Friday, 16/12/2005.

This year again, Juggling Soc are joining the Kayak club for a Christmas Party to round off the year and put an end to
the exams. All are welcome!! Remember to bring your own nutrition and as it's a shed, to dress for warmth. It promises
to be a great night so come along!!!

Juggling equipment arrival &distribution » Bank of Ireland Theatre on Wednesday, 4/1/2006.

Juggling equipment order arrival and distribution from passepasse retailers
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Open Session of Juggling » Aras na Mac Leinn Racquetball Courts on Monday, 9/1/2006.

Society Party (New members welcome!!) » 5 New Avenue Wood on Monday, 9/1/2006.

Juggling Party Our first party of the year. All are welcome.

Workshops: Beginners' 3 Ball and 3 Club. » Aras na Mac Leinn on Tuesday, 10/1/2006.

A chance for newbies to learn the basics and dive heads-first into the wonderful world of juggling! Open Skills Sharing
Session for those not involved.

Teddy Bear Hospital Juggling Performance » Aras na Mac Leinn Sports Hall on Friday, 13/1/2006.

A new society, DocSoc, are looking for us jugglers to entertain kids aged from 3-7 at their Teddy Bear’s Hospital. The
day involves children having their teddy bears examined by nursing and med students. They'll then get a "prescription”
which they'll take to the “Pharmacy” to get fruit to make their teddies better. 365 children are expected to attend. The
kids don’t expect world class jugglers so everybody is welcome to come and perform. They will be an appreciative
audience! (i.e. easy to impress) It would be great if society members would give one hour to entertain some children! It
should be a great day.

Intermediate Poi workshop » Aras na Mac Léinn Sports Hall on Tuesday, 17/1/2006.

Societies' Day 2 Floor Show » Aras Na Mac Leinn Atrium on Wednesday, 18/1/2006.

Come along for a juggle. We'll have a stand setup & all the equipment will be there. Remember to bring any friends or
random strangers that may be interested in signing their lives away to the juggling society.

Workshops & an Open Session of Juggling » Aras Na Mac Leinn on Monday, 23/1/2006.

W'shops in HulaHooping & 3-ball Juggling » Aras na Mac Léinn Sports Hall. on Tuesday, 24/1/2006.
Workshops in Hula-hooping and Beginners 3-ball: This week we will host an Introduction to 3-ball juggling alongside a
beginners Hula-hoop workshop. Marion from Sicily will be joining us to teach the Hula-hooping. As always feel free to
come along and practice whatever else you like and don't be afraid to ask others for help.

Devil-stick Workshop » Aras na Mac Léinn Sports Hall. on Tuesday, 31/1/2006.

This week, in association with Circus Culture we will host a beginners Devil-stick workshop. We only have enough
sticks for 20 people so come on time if you wanna participate. Following juggling we will be heading to the bar for
Tea/minerals! Come along!!

Muscailt Launch & Photoshoot » The Quadrangle on Monday, 6/2/2006.

Muscailt Arts week is being launched this Monday. Come along for a Juggle. A professional photographer will be
present to shoot for the upcoming brochures. Its a great photo opportunity for the society and will be a fun day out.
New members are welcome to come along! Wear: Ideally Juggling hoodies or Bright coloured T-shirts and black / dark
coloured trousers (not essentialll)

Beginners Diabolo Workshop » Aras na Mac Léinn Sports Hall. on Tuesday, 7/2/2006.

This week we will host a beginners Diabolo ( http://www.diabolotricks.com/) workshop. Again please bring your own
diabolos if you have any!!

Belfast Juggling Convention » Belfast on Friday, 10/2/2006.

Intermediate Diabolo Workshop » Aras na Mac Léinn Sports Hall. on Tuesday, 14/2/2006.

This week we will be joined by Eimhin; a professional juggler who will teach an Intermediate Diabolo Workshop. Again
please bring your own diabolos if you have any!!

Beginners/Intermediate Poi Workshop » Aras na Mac Léinn Sports Hall on Tuesday, 21/2/2006.

This week we will host a beginners/intermediate Poi (http://www.homeofpoi.com/ ) workshop. We'll supply the
equipment but bring your own if you have it.

Muscailt Impromptu performance on campus » All over Campus on Wednesday, 22/2/2006.

Outdoor Extravaganza & Fire Show » Outside Bank of Ireland Theatre on Wednesday, 22/2/2006.

Juggling Soc Outdoor Extravaganza & Fire Show

Soccer - Juggling soc v. NCBES p'grads » St. Anthony's Soccer Pitch on Friday, 24/2/2006.

Chinese State Circus » Black Box on Friday, 24/2/2006.

If you have paid for your Circus ticket, we will be meeting at the Black Box @ 7:30 . Following the show, we will be
going to Salthill for a Society Party. Everybody welcome!

Competed in Intersoc soccer tournament » Daingean sports complex on Monday, 27/2/2006.

Ball-passing workshop » Aras na Mac Léinn Sports Hall on Tuesday, 28/2/2006.

This week we will host a ball-passing workshop. We'll supply the balls but bring your own if you have any so that we
have enough.
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Open Session of Juggling » Arts Millenium Building Atrium on Monday, 6/3/2006.

Intermediate Ball-passing workshop » Aras na Mac Léinn Sports Hall. on Tuesday, 7/3/2006.

Open session of juggling » Aras na MacLeinn Atrium on Thursday, 9/3/2006.

Dublin Juggling Convention » Dublin on Friday, 10/3/2006.

Dublin Juggling Convention: Fire show on Friday night 8-10 in Market Square, Temple Bar. Workshops and open
session of juggling in Larkin Hall, Cathal Brugha Street, 10a.m. - 6p.m., juggling show in Ambassador Theatre 7:30-
9:30, then games and workshops from 11-5 in Larkin Hall on Sunday.

3-Club Workshop » Aras na Mac Léinn Sports Hall. on Tuesday, 14/3/2006.

This week we will host a beginners and intermediate 3-club juggling workshop. Bring your own if you have any.

Open session of Juggling » BOI Theatre on Thursday, 16/3/2006.

St. Patrick’'s Day Parade » Galway and Westport on Friday, 17/3/2006.

Members participated in parades in Galway with Macnas and also in Westport.

Contact-Staff workshop. » Aras na Mac Léinn Sports Hall on Tuesday, 21/3/2006.

This week we will host a Contact-Staff workshop. We'll supply the staff but bring your own (broomstick even!) if you
have any.

Committee 2005/2006

Auditor: Richare Lyons Vice-Auditor: Brendan Fahy

Treasurer: Colm Pattwell Secretary: Lousie
Events/SocietyDevelopment: Anna Events/SocietyDevelopment: Rachael Mahon
Events/SocietyDevelopment: Katie Equipment Team member: Philip McVeigh
Equipment Team member: Stephen Rourke New Members Liaison: Conor

New Members Liaison: Liza Event Co-Ordinator: Nich Dolan
Equipment Team member: Luke Dillon Secretary/ Web master: Daniel McGill
Health & Safety Officer: Orla Curry Photographic Officer: Stevie Boyd
Events/SocietyDevelopment: Eimhin Shortt OCM: Liz

OCM: Fiona OCM: Dave

Committee 2006/2007

Auditor: Brian Mc Ginley Vice-Auditor: Nick Dolan
Treasurer: Richie Lyons Secretary: Seamus Cawley
Equipment Officer/P.R.O: Stephen Rourke Photographic Officer: Stevie Boyd
Equipment Officer/P.R.O: Luke Dillon Event Co-Ordinator: Colm Pattwell
Equipment Officer/P.R.O: John Heavey Safety Office: Orla Curry

New Members Liaison: Laura Heneghan Co-Secretary: Daniel McGill
Co-Secretary: Rachael Mahon Co-Secretary: Brendan Fahy

Juggling Society Balance Sheet

Income Expenditure
Income Category Amount  Expenditure Category Amount
Opening Bank Balance 20.17 Bank charge €6.84
Members Contributions €1199 Costumes €1293.73
Socs box €825 Dinner €60
Societies day €180 Entertainment €885
Sponsorship €250 Entry fees €480
USC Grant €5073 Materials €66
Non Alcoholic Refresh €120
Society accommodation €930
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Society transport €144

Speaker accommodation €105
Speaker travel €105
Teacher fees €600
Expenditure Total €4795.57
Does not include Unreconciled Cheque Total (€2698.77)
Closing Bank Balance €2751.6
Total €7547.17 Total €7547 .17

Other Information
We held 8 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
528 members.

Karting Society

The Karting Society was started up and run by enthusiasts of the sport of Go-Karting and motor sport in
general. During the societies first full year of activity we provided opportunities for people to get involved with
motor sport in both recreational and competitive settings. In the future however, we see that it may be necessary
to include a broader spectrum of people in the society. The focus of next year will be to maintain and expand the
sporting activity, while also providing a social and educational aspect for people who are interested in the artistic
and intellectual spheres so abundant in the world of competitive motor sport and throughout the diverse
automotive world.

Karting Soc Events

This year the society held a total of 4 events.

E.G.M. » AC203 on Wednesday, 25th of January.

An introduction to the karting society and a run-down of events that will be taking place over the next semester. Also
we will be looking for competitors interested in trying out for one of two teams to go the Intervarsities.

Trip to Pallas Karting » Pallas Karting, Tynagh on Monday, 13th of February.

A thrilling afternoon of high speed, high action go-karting at Irelands and Europes largest Go-Kart track! Spending our
entire budget means the cost is only €26 and the bus is free!!! A must for anyone interested in ksrting.

Playstation Competition » Back room, college bar on Tuesday, 28th of February.

This event, in support of rag week, was held in the college bar on the Tuesday evening of rag week. We held a
Playstation competition with the Formula One 2005 game. Two contestants at a time competed against each other in
front of the big screen with points earned for placed finish and a winner stays on format. Contestants could then re-
enter and increase their overall points tally with the chance at the end of the night of winning one of 6 amazing prizes
which included: 200 euro sponsored by Eagle Star Life; dinner for two at Milano; 65 euro voucher for Charlie Byrnes;
50 euro voucher for Ryan Man; wash and cut at MRHC and wash and cut at Savoy Barbers. There were also spot
prizes available on the night from Hanley Menswear, John Deeley Menswear, Hairy Legs and Zhivago Music Store.
We'd like to thank all our sponsors for their generosity and everyone who showed up on the night and took part.
Karting Intervarsity » Edgewothstown, Co. Longford on Saturday, 4th of March.

All-Ireland competition against some of the very best amature karters in the country including the current Irish national
Karting champion Adrian Fallon. One of three individual events run throughout Semester Two. A team event with four
per team in a grand prix style race preceded by 8 timed heat laps.

Committee 2005/2006

Auditor: David McDonagh Vice-Auditor: Enda OConnor

Secretary: Sean Healy Health & Safety Officer: Jason McNamara
Public Relations Officer: Colum Charlton

59



Committee 2006/2007
Auditor: David McDonagh

Karting Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance AffilllMem fees €610
Members Contributions €154 Prizes €200
Socs box €260 Stationary €4
Sponsorship €200
USC Grant €200
Expenditure Total €814
Closing Bank Balance €0
Total €814 Total €814

Other Information
We held 12 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 502 members.

Labour Youth Society
The Labour Youth society has striven to increase engagement with the political process amongst the student
body. We have firmly believed that such engagement is a fundamental element of a Democratic state.
Throughout the year our campaigns, meetings, forums, discussion groups and conferences have been as open
as possible to facilitate such interaction and we have been extremely pleased with the high level of input from
students.

This year we felt rewarded at the positive response to the different campaigns we highlighted. The Breast cancer
awareness campaign which saw Deputy Liz McManus, Deputy Leader of the Labour Party and its spokesperson
on Health address a meeting in conjunction with several other societies. The Workers Rights Awareness Week,
a winner of a society’'s award of excellence proved immensely informative and provided a safe and
knowledgeable forum for students to explore their employment rights with representatives from all the major
Trade Unions in Ireland.

Labour Youth Events

This year the society held a total of 19 events.

Colombia - The Untold Story » O'Flaherty Theatre on Thursday, 15th of September.

The current situation in Colombia from the Irish delegation that visited the country ths summer. David Geary Chair of
the Branch who went on the delegation will give a short talk followed by Augustine O Donoghue of the Socialist
Workers in NCAI. A video of the delegations trip and a report will also be covered. Please note that some elements of
the video are quite emotional and it would be remiss of the society not to warn sensitive people. All welcome to attend.
Cellar Bar reception afterwards.

Societies Day Meeting » The Hub on Thursday, 22nd of September.

Annual Campaign Meeting » AM105 on Thursday, 29th of September.

The Dail visit » Leinster House, Dublin on Thursday, 6th of October.

General Meeting » Am105 on Thursday, 20th of October.

Liz McManus, Labour Health Spokesperson » Am250 on Tuesday, 25th of October.
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Launching Breast Cancer awareness week in conjunction with the Political Discussion Society. A discussion on Breast
Cancer care in Ireland, BreastCheck and the Marie Keating Foundation. Speakers include Liz McManus TD, Senator
Margaret Cox and a representative from the Marie Keating Foundation. All Welcome to attend.

Conference Planning » Am105 on Thursday, 3rd of November.

National Conference » The Arts Millenium Building on Saturday, 5th of November.

Labour Youth's National Conference hosted by the Noel Browne (NUIG) branch of Labour. A high standard of debating
and policy formation is expected. For a programme please log onto www.labouryouth.ie. Delegates must be registered
by October 31st. People wishing to attend ( no voting entittements) must register between 9am and 11:30am each day.
Workers Rights Awareness Week » AM Building on Tuesday, 8th of November.

A workers rights fair featurung union reps from accross the board in the Arts Millenium Building and Aras na Mac
Leinn. In the evenings we will have meetings in the Siobhan McKenna Theatre. For a programme of events please
check out our posters around the campus.

General Meeting » AM105 on Thursday, 17th of November.

General Meeting » venue to be confirmed on Wednesday, 11th of January.

Meeting » AM105 on Wednesday, 25th of January.

Labour Youth » AM105 - Arts Building on Wednesday, 1st of February.

Film Night & Meeting » AM105 on Wednesday, 8th of February.

EGM & General Meeting » AM105 on Wednesday, 15th of February.

General Meeting » AM105 (Arts Mill Building) on Wednesday, 22nd of February.

General Meeting » AM105 (Arts Millenium Building) on Friday, 10th of March.

The Future of the left in Ireland » TBC on Thursday, 30th of March.

National Conference » The Helix, DCU on Friday, 31st of March.

Committee 2005/2006

Auditor: David Geary Vice-Auditor: Eilis Fallon
Treasurer: Fiona Coyle Secretary: Sinead Magee

Staff Treasurer: Dr. Brendan Flynn Press Secretary: Ronan Moyles
Equality Officer: Jenny Hickey OCM: Nicola McGarry

Committee 2006/2007

Auditor: David Geary Vice-Auditor: Fiona Coyle
Staff Treasurer: Dr. Brendan Flynn

Labour Youth Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 216.38 Bank charge €14.66

Sponsorship €900 Dinner €159.8

USC Grant €1525.2 Equipment misc €495.2
Reception €1294.45
Returned Money €455
Speaker accomodation €170
Expenditure Total €2589.11
Closing Bank Balance €52.47

Total €2641.58 Total €2641.58

Other Information
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We held 20 committee meetings during the year and we have held our AGM. Our total membership stands at
210 members.

Law Society

Although one of the oldest Societies in the University, the Law Society of NUI, Galway continues to remain one
of the most progressive and vibrant on campus. The society promotes learning and interaction among law
students through a range of academic and social events. Meeting on Wednesdays in the Cairns Theatre, the
Law Society provides a forum for discussion of day to day national and worldwide issues and hears speakers on
both the more academic and practical sides of law and the legal system.

This year the Society hosted Gerald Kean, Solicitor, The Honourable Mrs Justice Catherine McGuinness,
President of the Law Reform Commission, John Lonegan, Governor of Mountjoy Prison, and speakers from
Kings' Inns and Blackhall Place to advise members on career opportunities. The Society also co-hosts a
Debating Intervarsity, the National Law Debates, with the Literary and Debating Society.

The Law Society organises purely social events as well. A Faculty Party was held in September and the hugely
successful Law Ball in January.

The Society is proudly sponsored by Matheson Ormsby Prentice.

Law Soc Events

This year the society held a total of 19 events.

Maiden Speakers' Competition » Cairns Theatre on Thursday, 29th of September.

Gerald Kean » Cairns Theatre on Wednesday, 5th of October.

Gerald Kean is a famous celebrity lawyer from Dublin and is head of Kean & Co Solicitors. He will adress the Law
Society on Media Law.

How to Study Law » /T 250 on Tuesday, 18th of October.

King's Inns Information Lecture » Siobhan McKenna Theatre on Tuesday, 18th of October.

Presentation by Sarah McDonald Dean of Education and Marcella Higgins, Director of Education at the Honorable
Society of the King's Inns.

Presentation by Sarah McDonald Dean of Education and Marcella Higgins, Director of Education at the Honorable
Society of the King's Inns.

Author Cox » Held on Tuesday, 18th of October.

Presentation by partners and trainee solicitors at one of Ireland's leading law firm.

Author Cox » Held on Wednesday, 19th of October.

A & L Goodbody » TBA on Thursday, 20th of October.

Presentation by partners and trainee solicitors at one of Ireland's leading law firm.

William Fry » IT Building on Tuesday, 25th of October.

Patrick King » Cairns Theatre on Wednesday, 9th of November.

Mrs. Justice Catherine McGuinness » Cairnes Theatre on Wednesday, 16th of November.

Law Society in conjunction with the Law faculty presents Mrs. Justice Catherine McGuinness, Supreme Court Justice
and President of the Law Reform Commission.

Law Ball » Bar903 and the Galway Bay Hotel on Tuesday, 24th of January.

Tickets on sale for the Law Ball at Smokies on the Concourse 10AM- 6PM and 6-7PM 24th-27th January. Law Ball
takes place in the Galway Bay Hotel on Thursday the 2nd February. Full tickets - €60.00 Afters Tickets - €25.00

Donal Toolin and Grainne Archer » /T202 on Wednesday, 25th of January.

Nuala Kelly fron the ICCL » AC214 on Wednesday, 8th of February.

National Law Debates » Arts Concourse on Friday, 10th of February.
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Debating Intervarsity. This event was run in conjunction with the Literary and Debating Society and won Best
Intervarsity in the NUIG Society Awards.

John Lonergan » Cairnes Theatre on Wednesday, 8th of March.

Gerard Quinn » Cairns Theatre on Wednesday, 15th of March.

Gerard Quinn » TBA on Wednesday, 22nd of March.

A.G.M. » Cairnes Theatre on Wednesday, 22nd of March.

Committee 2005/2006

Auditor: Laura Cunningham Vice-Auditor: Patrick Lloyd

Treasurer: Eoghan Kenny Secretary: Michael Walsh

Education Officer: Daniel Curran Speakers Convenor: Cathal Grennan
Marshall of the House: Amy Kelly Social Secretary: Aisling Whelan

PRO: Cathal MacDonncha Assistant Social Officer: Cacimhe Mullins
Communications Officer: Orla Molloy Debates Convenor: Sharon Dillion-Lyons

Committee 2006/2007

Auditor: Orlaith Molloy Vice-Auditor: Cathy Egan
Treasurer: Sarah Bruen Secretary: Christopher Campbell
Social Secretary: Michael Clancy Education Officer: Michelle Daly
PRO: Christopher Lynch Speakers Convenor: Cathal Grennan
Debates Convenor: John Moriarty Marshall of the House: Lisa Flood

Law Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 628.77 Affill/Mem fees €1464.1
Balls €21070 Ball €12949.8
Members Contributions €300 Bank charge €32.21
Socs box €125 Dinner €1676
Sponsorship €7085.35 Entertainment €142.2
USC Grant €2163 Entry fees €213.06
Fundraising/charity €3000
Gifts €315
Hire Bus €360
Prizes €350
Promotions €3400
Reception €1021.61
Society transport €454
Speaker accommodation €176
Speaker travel €140.42
Income Total €25694 .4 Expenditure Total €25694.4

Other Information
We held 9 committee meetings during the year and we have held our AGM. Our total membership stands at
1,487 members.

63



Life Society

The 2005/06 academic year was a somewhat quieter one than recent years for the society. On the whole, the
year was made up of small meetings with a greater emphasis on charity fundraising events. In all, the society
raised around 1200 euros in three events: two fundraising collections outside Aras na Mac Léinn, one in aid of
AWARE and the other going towards the Samaritans as part of Rag Week. The latter raised around 630 euros
alone. A table quiz, with the proceeds going to Special Olympics Ireland was a success with around 160 euros
raised.

The society sent a delegation of seven to the Life Issues Conference in NUI, Maynooth in late February where
journalists Ronan Mullen, David Quinn, Dr. Berry Kiely of the Pro-Life Campaign and British pro-life activist Peter
Mallon discussed various currant topics relevant to the pro-life cause. In October, the society was well
represented at a public information meeting at the Ardilaun House Hotel on the topic of Stem cell research
hosted by the REMEDI Institute based in NUI, Galway. A range of speakers gave a variety of informative
presentations on this contentious issue.  The society also re-forged links with the World Youth Alliance (WYA),
an international voluntary body based on theme of the dignity of human life. Society members received training
packs as well as the chance to work on the WYA'’s “Habitat” project in Romania next August, involving the
building and orphanage.

In November, the society successful disassociated in “SIN” from the controversial Ultrasound-organised (a
Youth Defence linked body) tour of pro-life meetings where two American speakers, one of whom was Gianna
Jasson, discussed their experiences of surviving abortion. The meeting, which flagrantly breached university
societies regulations, was successfully prevented from taking place. Despite this incident, the Life society will
continue to strive to highlight the pro-life cause in a compassionate and rational manner without religious and
political bias.

Life Society Events

This year the society held a total of 6 events.

Society Day social gathering » Galway on Wednesday, 21st of September.

Collection for Aware » On campus on Friday, 30th of September.

Stem cell conference » Ardilaun House Hotel on Friday, 11th of November.

Table Quiz in aid of Special Olympics » Collage Bar on Wednesday, 8th of February.
Rag Week Collection For the Samaritans » On Campus on Thursday, 23rd of February.
Life issues conference » NUI Maynooth on Tuesday, 28th of February.

Committee 2005/2006

Auditor: Sean Clancy Vice-Auditor: Katie O Driscoll
Treasurer: Myles Monaghan Secretary: Maria O hAodha
HLM: Paul Smith P.R.O.: Anthony Doherty
0.C.M.: Sean Small 0.C.M.: Colin Smith

HLM: Sarah O Driscoll 0.C.M.: Sarah Pickering

HLM: Eilis Donohue

Life Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 216.55 Bank charge €14
Fundraising €860 Fundraising/charity €2144.33
Members Contributions €1327.73 Printing €35

64



USC Grant €740 Prizes €100

Returned Money €300
Society accommodation €198
Socs day expenses €15.75
Expenditure Total €2794 .48
Closing Bank Balance €349.8
Total €3144.28 Total €3144.28

Other Information
We held 40 committee meetings during the year and we have held our AGM. Our total membership stands at
180 members.

Literary & Debating Society

The 159th Session of the Literary & Debating Society was all in all a quite successful year. The society exists in
two parts, the external competitive element, and the internal meetings we run. We have taken on new schools
competitions, and re-invigorated our workshop training programme for novice debaters, ensuring that Committee
Members always had something to do.

From a competitive side several Galway has had notable success, particularly at the UCD and TCD intervarsity
competitions, where teams reached the semi-final stages, at the UCC IV, where a fresher team reached the final
of the Novice Competition, and at the UL IV, where another fresher team made it to the final of the main
competition. we have also have participants in break rounds at the World University Debating Championships, in
the semi finals of the Irish Times and Irish Mace Competition, and more recently, in both the Final of the London
School of Economics Intervarsity, and the Inner Temple Intervarsity. The Vice Auditor is the Irish Representative
on Worlds Council, and the Connaught Rep on the Irish World Schools Council.

The internal organisation of the society is the other half of our activities. Several high profile, and well received
events were organised most notably The lIrish Times Final, chaired by Senator David Norris, and a huge
undertaking for the society and The Republicanism Debate, which pitted Michael McDowell against
representatives from both branches of Sinn Fein. We also had meetings on issues such as Immigration policy,
with Patrick Eston, leader of Veritas, and Philip Watt, chair of the National Consultative Council on Racism,
Abortion, with Frank Crummey of the Marie Stopes Foundation, and Ronan Mullen of the Irish examiner, as well
as a host of internal competitions, and student led debates, on topics such as US Foreign Policy, Educational
Policy in Ireland and Censorship of the Media.

Lit & Deb Events

This year the society held a total of 24 events.

GIB's Night » Kirwan Theatre on Thursday, 22nd of September.

Our annual competition for First Year speakers will be held on the Thursday of Freshers Week. First Prize, a PSP.
Colors Debate » Kirwan Theatre on Thursday, 29th of September.

Oxford Run-Off's Final » Kirwan Theatre on Thursday, 6th of October.
George Bush Debate » Kirwan Theatre on Thursday, 13th of October.

Internal student debate on the topic, This House Believes George Bush Is Unfit To Rule.
Staff Vs Students » Kirwan Theatre on Thursday, 20th of October.
Halloween Debate » Kirwan Theatre on Thursday, 27th of October.

Iran Debate » Kirwan Theatre on Thursday, 3rd of November.

Inter Socs » Kirwan Theatre on Thursday, 10th of November.

Literary Evening » Kirwan Theatre on Thursday, 17th of November.

65



Christmas Meeting » Kirwan Theatre on Thursday, 24th of November.
TP O'Connor Competition » Kirwan Theatre on Thursday, 12th of January.

The Republicanism Debate » Kirwan Theatre on Thursday, 19th of January.

Maiden Speakers Final » Kirwan Theatre on Thursday, 26th of January.
Immigration Debate » Kirwan Theatre on Thursday, 2nd of February.

Richard E Kirwan Final » Kirwan Theatre on Thursday, 9th of February.

Inter Facs » Kirwan Theatre on Thursday, 16th of February.

Criterion Launch » Kirwan Theatre on Thursday, 23rd of February.

Irish Times Debate Final » Kirwan Theatre on Friday, 24th of February.

Debating Workshops » IT Building on Tuesday, 7th of March.

Schools Final » Kirwan Theatre on Thursday, 9th of March.

Denny West Of Ireland Schools Final » Kirwan Theatre on Thursday, 9th of March.
Abortion debate » Kirwan 8 p.m. on Thursday, 16th of March.

"THIS HOUSE WOULD LEGALISE ABORTION." Speaking pro-life is Irish Examier Journalist, Ronan Mullen. Mullen is
a high profile memeber of the pro-life movement who is anti-abortion. He has also won the prestigious Irish Times Final

debating competition. Eoghan Casey also joins the pro-life side fresh after his win at the National Law Debates 2005

where he gave a passionate and emotional speech against abortion in all its forms, convincing 80% of those in

attendance that abortion is wrong. Speaking on the pro-choice side is Frank Crumey who is currently director general

of the Marry Stopes foundation, an organisation that gives pre and post abortion conselling. Owen Feehan is speaking

on the pro choice side of this debate. He is a student of NUIG and a member of the labour party.
Speaker Of The Year » Kirwan Theatre on Thursday, 23rd of March.
This annual competiton is to decide on the best speaker in the society for a given year. The motion will be announced

on the Night.

AGM » Kirwan Theatre on Thursday, 30th of March.

Committee 2005/2006

Auditor: Steven Nolan

Treasurer: Sean Butler

Public Relations Officer: Jeffrey Rockett
Corresponding Secretary: Robert Rooney
Literary Officer: Anthony Doherty
Promotions Officer: Steven Lydon
External Convenor: John Moriarity

Committee 2006/2007
Auditor: Donna Cummins
Treasurer: Vincent Lacey

Vice-Auditor: Sharon Dillon Lyons
Secretary: Patrick B. Cluskey IV

Schools Convenor: Roisin McGrogan
Society Development Officer: Cathy Egan
Clerk of the House: Vincent Lacey
Internal Convenor: Donna Cummins

Vice-Auditor: Patrick Cluskey
Secretary: John Moriarty
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Literary and Debating Society Balance Sheet

Income

Income Category
Opening Bank Balance

Fundraising

Greenform

Members Contributions
Muscailt

Sponsorship

USC Grant

Total

Other Information

Amount
262.92
€1250

€3368

€360

€992

€2200

€16878.59

€25311.51

Expenditure

Expenditure Category
Bank charge

Costumes

Dinner
Entertainment
Entry fees
Equipment misc
Fundraising/charity
Materials

Printing

Prizes

Reception

Society transport
Speaker accommodation
Speaker travel

Stationary

Expenditure Total

Unreconciled Cheque Total

Closing Bank Balance

Total

Amount
€22.89
€484

€5116.91

€904

€8582

€240

€50

€202.2

€992

€375

€2142.45

€4373.67

€956.42

€313.5

€30
€24785.04

€419

€526.47

€25311.51

We held 24 committee meetings during the year and we have held our AGM. Our total membership stands at

300 members.
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Malaysian Society

Malaysian Society (MSNUIG) is a fully registered society under NUI, Galway and the Malaysian Student
Department (MSD). This society was formed recently, on the17th of October 2005. Malaysian Society is formed
mainly for the Malaysian students in NUIG. Our primary aim is to bring all the Malaysians in Galway together,
including all races, cultures and religions. This includes the promotion of mutual helpfulness and recreation
between the Malaysian students and to provide a support base for newly arrived Malaysian students.As it was
apparent that the Malaysian students in Galway did not have a society under the university, a few Malaysians
came up with the idea of forming one, where all the students will unite, and thus, providing a place for everyone
to gather. The Malaysian Society also aims to liase with the Malaysian Students Department in Dublin (MSD)
and relay information on the latest events and inform members about relevant issues. In other words, Malaysian
Society will be acting as an intermediary; should the students themselves have any concerns that would like to
be enlightened to the MSD, we will be happy to convey it for the students.Not many people may realize this, but
Malaysia is actually a multi-cultural country. Not every Malaysian is of Malay heritage. There are about 30% of
Chinese and 8% of Indians that make up the 25 million population of Malaysia. Though of different cultures, we
are happy to announce that our country is very much integrated and united. Thus, this society aims to add the
integration towards the Malaysian students in Galway, the same way it felt back home. The Malaysian
Government has sent students all over the world in hopes that each and every individual did not segregate from
the Malaysian community. Of course, this does not mean that the Malaysian Society completely ignores the Irish
students. This society has joyfully gathered 60 Irish students to join. Because of this, we are very pleased to
introduce this type of integration towards the Irish students.

Malaysian Society Events

This year the society held a total of 7 events.

Eid Mubarak, Deepavali and Launching of » Aula Maxima, Lower on Saturday, 12th of November.
Visit of Deputy Health Minister and dele » Large Lecture Theatre, CSI on Monday, 30th of January.
Meeting of the MSNUIG Committee Members » Stephanie's place, Dunaras on Tuesday, 31st of

January.

International Student Supper and Concert » Aula Maxima, Upper and Lower on Wednesday, 8th of
February.

MSNUIG's Survey Form -Malaysian Students » http://www.malaysian.nuigalway.ie on Saturday, 1st
of April.

Malaysian Society Website Construction » http.//www.malaysian.nuigalway.ie on Sunday, 2nd of
April.
MSNUIG's Survey Form -Malaysian Students » UK and Ireland on Friday, 21st of April.

Committee 2005/2006

Auditor: Zool Raimy Abdul Ghaffar Vice-Auditor: Adilla Nur Halim

Treasurer: Chee Peng Hor Secretary: Izzatul Aini Mohamad Idris

General Committee Member: Sarinah Hamidon Events Coordinator: Sheila Bingkasan

Events Coordinator: Noor Farahnadiah General Committee Member: Esther Sumi Anak Lis
General Committee Member: Nasrul Hadi Omar Public Relations Officer: Nurafza Ahmad Hisham
Public Relations Officer: Stacey Tan Webmaster: Ahmad Fairuz Abdul Shokri

General Committee Member: Stephanie Cinthu

Committee 2006/2007
Auditor: Zool Raimy Abdul Ghaffar Vice-Auditor: Adilla Nur Halim
Secretary: Izzatul Aini Mohamad Idris
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Malaysian Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 0 Bank charge €6.55
Members Contributions €230 Reception €300
Sponsorship €935.86 Socs day expenses €200
USC Grant €200
Expenditure Total €506.55
Closing Bank Balance €859.31
Total €1365.86 Total €1365.86

Other Information
We held 19 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 160 members.

Marine Society

The NUI Galway Marine Society was established in order to highlight marine related issues on campus and
indeed around Galway. Although it is a relatively small society it is full of ambition as it seeks to attract students
to the wonderful world of marine life. Dolphins, Sharks, Jellyfish, Squid, Octopuses and many more. Learn more
about their life, threats to their existence and insanely interesting facts about marine life.

Although we had a quiet year this year we did have a table on Societies day and we organised a Halloween
party in the Cellar Bar. We donated €500 to the Royal National Lifeboat Institution which the society felt strived
to promote and protect that which the society dedicates itself to as well as actively saving lives at sea. The
Society was thrilled to be a position to support this noble organisation and looks forward to forging closer links
with the group in the future.

Marine Soc Events

This year the society held a total of 2 events.

Halloween Party » The Cellar Bar on Thursday, 27th of October.
Halloween Party » The Cellar Bar on Thursday, 27th of October.

Committee 2005/2006

Auditor: Michael Devaney
Treasurer: Deirdre Duggan

Post. Grad. Rep.: Lonneke Goddijn
Third Year Rep: Mark Quinn
Webmaster: Hazel Farrell

P.R.O: Darragh Moran

Staff Treasurer: Martin White

Marine Society Balance Sheet

Income
Income Category Amount

Opening Bank Balance 603.52

Vice-Auditor: Rory O Connell
Secretary: Celine Mangan

Second Year Rep.: Micheal Devaney
Ass. P.R.O.: Margaret O Callaghan
First Year Rep: Caroline Heaney
Fourth Year Rep: Naomi Soffer

Expenditure
Expenditure Category Amount

Fundraising/charity €500
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USC Grant €80

Expenditure Total €500
Closing Bank Balance €183.52
Total €683.52 Total €683.52

Other Information
We held 1 committee meeting during the year and we have held our AGM. Our total membership stands at 15
members.

Math’s Society
The newly reformed Math’s Society got going this year in semester two when we were granted provisional
recognition as a society. Our aim is to provide a social forum for all interested in all thing mathamatic and to
further debate in our subject.

Math’s Soc Events

This year the society held a total of 2 events.

Guest Speaker » Larmor Theatre on Wednesday, 8th of March.

The Invisible Interpreter: Sir William Rowan Hamilton as Poet and Philosopher. Guest Speaker Dr Thomas Duddy on
the life of Ireland's greatest mathematician.

Guest Speaker » Larmor Theatre on Wednesday, 15th of March.

Why Philosophy can't afford to ignore Mathematics. Guest speaker Prof Pashcal O'Gorman on the influence of
mathematics on philosophy.

Committee 2005/2006

Auditor: Jennifer Cruise Vice-Auditor: Ciara Phelan
Treasurer: Jim Lovett Secretary: Liam Naughton
OCM: Aine Houlihan OCM: Patrick Farrell

OCM: Antje Luebke Webmaster: Ciara Fitzgerald
OCM: Darragh Ryan OCM: Dave Higgins

OCM: Erica Bolo

Math’s Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance -3.75 Gifts €25
USC Grant €150 Reception €121
Expenditure Total €146
Closing Bank Balance €0.25
Total €146.25 Total €146.25

Other Information
We held 3 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
30 members.

70



Mature Student Society

The aim of this society is to provide a peer network to support mature students and to also offer advice on
coping with the stress of college life. This was a good year for mature students as there was an information
evening on 24th January and there was a good attendance of about 30 people it was giving advice on exams
and post grad courses and fees and grants which was very beneficial to all students. Then in March 15th there
was a race night in the college bar this was a huge success with very good attendance and there was also good
spot prizes. Then the highlight of the year was the trip to Paris this took place on April it was from the 2nd to the
5th. It was a wonderful and very enjoyable experience. 13 mature student including myself went. We got to see
the Eiffel Tower, a boat cruise on the Seine and also the Louvre and other interesting historic sites. So being
part of the mature students committee has been a very beneficial experience from an academic and social one.

Mature Students Events

This year the society held a total of 2 events.

Information Meeting » AM250 on Tuesday, 24th of January.
Race Night » College Bar on Wednesday, 15th of March.

Committee 2005/2006

Auditor: Martin Power Vice-Auditor: Ann Marie Leonard
Treasurer: Eugene Jordan Secretary: Anna Cunningham
Committee: P. O Flatharta Committee: Annette Neary
Committee: B. ni Loidgain Committee: Eoin Dillon
Committee: Michelle McCormack Committee: Geraldine

PRO: Eugene Jordan Committee: Pat Hynes
Committee: John Rafferty Committee: Marie Lavin
Committee: Fiona Gavin Committee: Brendan Fahy

Mature Students Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 16.36 Printing €50

USC Grant €1493 Prizes €50
Promotions €100
Reception €50
Society transport €1259
Expenditure Total €1509
Closing Bank Balance €0.36

Total €1509.36 Total €1509.36

Other Information
We held 3 committee meetings during the year and we have held our AGM. Our total membership stands at 160
members.

71



Medicine Society

Our main role as a society is to plan the med ball, our official role is to let students know what they are up
against for the year and act as an intermediary between the dean and students. If students have any complaints
we pass the information on and hopefully find a solution. The various class reps organize the class trips and let
the class know about cancelled lectures, tutorials and events etc.

Medicine Soc Events

This year the society held a total of 6 events.

First and second year introduction night » CS/ on Wednesday, 28th of September.

Third and fourth year introduction night » CS/ Large lecture theatre on Wednesday, 5th of October.
Final year introduction talk » CSl/ large lecture theatre on Wednesday, 12th of October.

Fifth year introduction talk » CS/ large lecture theatre on Thursday, 13th of October.

Medball » Radisson SAS hotel on Tuesday, 13th of December.

Research meeting » CSI/ large lecture theatre on Wednesday, 8th of February.

Committee 2005/2006

Auditor: Ruth Martin Vice-Auditor: John Morley
Treasurer: Anne Marie Ni Chualain Secretary: Adrienne Rogers
IMSA rep: Paul Sexton Entertainment Officer: Emily O Halloran
International Students Officer: Kheshwant Gill Press Officer: David Coyle

International Students Officer: Mohd Farris Mohd Roslan  Sports Rep: Niall Kelly

Medicine Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 1875.33 Ball €28419.98
Balls €24408.72 Bank charge €3.75
Members Contributions €2645 Dinner €122
Societies day €302.6 Entertainment €1331
Sponsorship €6150 Printing €1415
USC Grant €1700 Society accommodation €2620
Society transport €800
Expenditure Total €34711.73
Does not include Unreconciled Cheque Total (€460)
Closing Bank Balance €2369.92
Total €37081.65 Total €37081.65

Other Information
We held 12 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 600 members.
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Microbiology Society

The Microbiology society is basically a community of students within the microbiology department that share a
keen interest in microbiology. The society acts by bringing all its members together, to engage in various
activities both leisure and academic. Throughout the year micro soc has organised many events, all of which
have seen great attendance. The Annual Fancy Dress Christmas Party was once again well attended with most
people dressing up and getting into the Christmas spirit. For the first time this year Micro soc organised a bingo
night in the college bar which was a huge success and enjoyed by everyone. Also in collaboration with 4th year
Microbiology, a trip to the Aran Islands was organised. Of course the fortnightly microbiology seminars continue
to attract large crowds and attendance from micro soc is always strong. All in all this year micro soc has been
busy trying to integrate the whole of the microbiology department while trying to have a bit of craic in doing so.

Microbiology Soc Events
This year the society had a total of 17 events that took place. These events can be divided into two categories:
regular and special events.

Regular Events
This year we held 1 event that ran regularly over a number of weeks. This event was as follows:
Seminars ran for 14 weeks in Dunican Lecture Hall, beginning on Friday, 21/10/2005.

Events

This year we held 3 special events. These events were as follows:

Micro Christmas Party » Kings Head on Thursday, 8/12/2005.

Micro Soc Fancy Dress Christmas Party. Theme this year is Cartoons. Come along as anyone from Mickey Mouse to
Spiderman, finger food and prize for best costume. Great night in store.

Bingo » College Bar on Thursday, 16/2/2006.

Microbiology Bingo Night,spot prizes for both lines and full houses. Plenty of craic and entertainment guaranteed.
Aran Trip » Aran Islands on Friday, 10/3/2006.

Microsoc together with 4th year Microbiology are organising a trip to the wild and wonderful Aran Islands. Chance to
meet up with all the members and also explore the island. A must for everyone.

Committee 2005/2006

Auditor: Pamela Ryan Vice-Auditor: John Fox

Treasurer: Siobhan Heanue Secretary: James McGarrigle

Website coordinator: Paul McCay Public Relations Officer: Carina Hosty
Society Development Officer: Christina Forbes Public Relations Officer: Ruth Hanrahan

Micro Biology Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 349.3 Dinner €230

Fundraising €579.2 Entry fees €50

USC Grant €1415.41 Non Alcoholic Refresh €76.13
Society transport €1417
Expenditure Total €1773.13
Closing Bank Balance €570.78

Total €2343.91 Total €2343.91

Other Information
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We held 15 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 70 members.

Musical Society

This year, began with a positive start in that our society G.U.M.S. was recognised as an official society
in the college. The main event organised by the musical society, was a performance of one of the longest-
running Broadway musicals of all time “The Little Shop of Horrors”. This ran in the Black Box theatre from the 7"
to the 11" of February. This musical was a great success thanks to a huge team effort. In March 2005 our AGM
was held where committee representatives were elected and a plan for the year ahead was set into action.

Meetings were held every Tuesday at 6pm. With a whole committee on board many more fresh, new
vibrant ideas became available. Due to the success of hiring a professional director last year we decided to do
the same again by hiring Fiona Kelly. This proved to be very helpful and was a great idea. Our musical director,
Mairead Crushell, played a huge part in the success of this show. There were also a team of choreographers on
board, so the styles of dance varied. The topics for discussion at the meetings were mainly relating to promotion,
funding, sponsorship, set design, costume design, and the plant. Closer to the show itself, items on the agenda
included band, patrons, props, light and sound etc.

It was evident from the onset of the academic year 2004/2005 that GUMS generated huge interest
amongst the student body. This was highlighted by the abundance of students who signed up for the musical on
society’s day. From there, auditions were held and fifty students were selected as cast. Rehearsals began
immediately. Singing took place in Aras Ui Chathail most Tuesdays. Dancing took place most Wednesday’s in
the Aula Maxima, and acting took place on Thursday evenings in a range of different venues. Many friendships
were quickly cultivated during these rehearsals between cast members from all over the country and indeed the
world.

On the 27" of October and again on the 22" of February a fundraising show was put on in the Bank of
Ireland Theatre. Nicola Coughlan, our societies liaison officer contacted Dramsoc to see if they were interested
in a joint performance. They agreed, and the show was a success. It was called “GUMS vs. Dramsoc”. The
audience was small, mainly consisting of friends and families of society members that could make it. The price
at the door was €2 per person. The money rose from this allowed us to begin work on sets and costumes. A
table quiz was also held in the college bar on the 20™ of March, as part of this fundraising initiative. This was
great fun with a 1% prize of €100.

In the weeks leading up to the show, the committee, under the leadership of Yvonne Jacob, Jennifer Keane and
Liam Hennelly concentrated on promoting the show. Posters were put up all over campus and around town. The
cast dressed up and did a run through town singing songs from the show. This proved successful as we sold a
number of tickets on the street, it was also great fun. The week of the show came around very quickly, but
thanks to the hard work of the cast, director, musical director and choreographers we were well prepared. Our
matinee show, on the Tuesday, did not sell as well as hoped but it was a great experience to get a full run
through the show with an audience, even if small. Pat O’Reilly and Mike Dervan provided lighting and sound
respectively. The band was organised by Jen Sheahan and incorporated a range of musicians both from the
college and locally. The band had a number of rehearsals before the beginning of the show.

The musical was a great success. However, we did experience a slight debt at the end of term. This was
rectified by patronage money and also the implementation of a quiz. Great friendships were formed during the
time of the show through set building weekends, cast trips out and promotional events, and also those many
nights out on the town. This has hopefully created lasting memories. We had a musical ball on the 7" of March
in the Galway Bay Hotel where we watched a DVD recording of the musical, ate to our hearts content, and then
danced the night away. It was a fantastic year for the official GUMS, and hopefully it will continue that way well
into the future.

Musical Society (GUMS) Events

This year the society held a total of 4 events.

Ticket on Sale for Musical » The Black Box Theatre on Tuesday, 24th of January.

Little Shop of Horrors! » Black Box Theatre on Tuesday, 7th of February.

This year GUMS present Little Shop of Horrors, the classic story of boy meets girl, plant eats world... The show will
begin on Tuesday 7th of February and continue until Saturday the 11th. There are two 11pm matinees (for all you early
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birds!) and the rest are evening shows which begin at 8pm sharp! Student tickets are only €7 and are available from

the SocsBox, the Town Hall Theatre or on the door.

Variety Show: GUMS vs. Dramsoc » BOI! Theatre on Thursday, 23rd of February.
Dramsoc turn into all-singing all dancing Broadway wannabes? GUMS take on straight acting? This year for Muscailt

two of the biggest Performing Arts societies on campus go head to head in a battle of talents! Where the main point is

generally to take the mickey out of one another! Its worth coming along if not only to see Musiclees grapple with

Shakespeare, but until you've seen Dramsoc try to dance, you've seen nothing. Tickets for this event are only €3 and

are available from the SocsBox.

Fundraising Quiz » College Bar on Tuesday, 21st of March.
Quiz tookes place in the College Bar to help raise funds for GUMS. the Musical Society who recently brought us The

Little Shop of Horrors. Fun guaranteed!

Committee 2005/2006

Auditor: Jenneifer Sheahan

Treasurer: Elaine Flynn

PRO: Yvonne Jacob

Ordinary Committee Member: Conor Feehily
Promotions Assistant: Liam Hennelly

Staff Treasurer: Sean O Leanchain

Committee 2006/2007

Vice-Auditor: Katie McAnena
Secretary: Ciara Murphy

Socs Liason Officer: Nicola Coughlan
Mistress of Costumes: Maeve Gormley
Promotions Assistant: Jennifer Keane
Sets: Delia Lowery

Auditor: Conor Feehily
Secretary: Alison McGreevy
PRO: Kelly McDermott

Staff Treasurer: Sean O Leanchain

Musical Society Balance Sheet

Income

Income Category Amount
Opening Bank Balance 355.33
Fundraising €1216.1
Greenform €4983.1
Muscailt €3900
Socs box €2115
Sponsorship €1005
Ticket Sales €3470
USC Grant €1000
Total €18044.53

Treasurer: Cara Walsh

Socs Liaison Officer: Jennifer Bannon

PRO Assistant: Kathleen Garrity

Expenditure
Expenditure Category Amount
AffilllMem fees €65
Bank charge €33.56
Costumes €1170
Equipment misc €80
Gifts €100
Hall hire €4000
Lights €713.6
Makeup/Props €553
Materials €350
Performing rights €1813.46
Printing €1028
Reception €130
Set €1739.81
Sound €2383.5
Teacher fees €3158
Expenditure Total €17317.93
Unreconciled Cheque Total €0
Closing Bank Balance €726.6
Total €18044.53
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Other Information
We held 20 committee meetings during the year and we have held our AGM. Our total membership stands at
300 members.

Music Society

Music soc is a society that hopes to promote music in college. Throughout the year this has been achieved by
the organising of gigs, table’s quizzes, trips and our main battle of the bands type of competition, Witless.

MusicSoc Events

This year the society held a total of 15 events.

Meeting » Smokey Joes on Tuesday, 10th of January.

We will be discussing plans for the coming semester and of course witless

Witless Launch » College Bar on Monday, 16th of January.

Launch of Witless! Bands performing include - Zero Moda, Aula Maxima and the Quads and Tahitis Dream. MC -
Fintan Murphy

Witless- Heat 2 » College Bar on Monday, 23rd of January.

Witless Solo Heat » Roéisin Dubh, Dominick St. on Tuesday, 24th of January.

Witless » College Bar on Monday, 30th of January.

Witless- Heat 4 » College Bar on Monday, 6th of February.

Ghostwood Project » College Bar on Monday, 20th of February.

Galway band provide the music for the opening night of the Muscailt festival, the Monster Mosh. Prizes for fancy dress
too plus Zombie DJ and classic horror movies!!!!

Acoustic Gig » The Hub, Aras na Mac Léinn on Tuesday, 21st of February.

Witless Solo Competition Acoustic Gig » The Hub Aras na Mac Léinn on Tuesday, 21st of February.
Original Music Showcase » De Burgos, Augustinian St. on Wednesday, 22nd of February.

Acoustic Gig » De Burgos, Augustinian Street on Wednesday, 22nd of February.

Busking » Campus wide on Thursday, 23rd of February.

Witless Final » College Bar on Thursday, 23rd of February.

Witless Showcase » Roéisin Dubh on Monday, 13th of March.

AGM » The Cellar bar on Thursday, 30th of March.

Committee 2005/2006

Auditor: Brid Ryan Vice-Auditor: Ronan Moyles

Treasurer: Ciara Clancy Secretary: Edel McCormack

Society Development Officer: Kevin Bergin Radio Show: Jenny De Lacy, John Moriarty
Webmaster: Niall Farrell Event Managers: James Keaveney, Dermot Moran
OCM: Peadar Mac Donncha OCM: David O Leary

P.R.O.: Rosa Ladner

Committee 2006/2007
Auditor: Ronan Moyles Vice-Auditor: Dave O' Leary
Treasurer: Ciara Clancy
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Music Society Balance Sheet

Income Expenditure
Income Category Amount  Expenditure Category Amount
Opening Bank Balance 1320.58 Dinner €116.24
Fundraising €188.6 Equipment misc €248.2
Greenform €166.98 Fundraising/charity €188.6
Muscailt €1295 Reception €361
Societies day €106.71 Society accommodation €1000
Ticket Sales €600 Society transport €425
USC Grant €625 Socs day expenses €20
Sound €680
Stationary €182.13
Expenditure Total €3221.17
Does not include Unreconciled Cheque Total (€80)
Closing Bank Balance €1081.7
Total €4302.87 Total €4302.87

Other Information
We held 15 committee meetings during the year and we have held our AGM. Our total membership stands at
200 members.

Muslim Youth Society

Our mission is to unify, foster brotherhood and represent Muslim students of NUI Galway. We also work to
promote better understanding of Islam and Muslims in the university and society. We have 111 members, of
which are Muslims and non-Muslims students of NUIG. As a means to develop Islamic knowledge, character
and skills of Muslim students, we organize a weekly meeting with the local Islamic Leader in the Clinical Science
Institute, as well as a weekly Arabic Class for our members. We are also involved in giving a warm welcome to
the Muslim fresher in NUIG last September and organized a freshers’ trip to the Cliffs of Moher. MYS acts as a
medium for communication between Muslim students and the university staff, the press as well as other
societies, both inside and outside the university.

We are also actively involved in collecting charity for the victims of natural disasters around the world and other
needy groups of people. This year, for the first time ever, MYS organized a trip to Spain, bringing 21 students to
re-live and understand the history of Muslims of Andalucia, Spain and their impact they left on today’s world
civilization.

Muslim Youth Soc Events

This year the society had a total of 130 events that took place.

Seerah Class ran for 60 weeks in CSI, beginning on Wednesday, 13/4/2005.

This Seerah Class is conducted by the Imam of Galway (Syeikh Khalid) who teaches us about the life of the prophet
Muhammad, his family and companions.

Arabic Language Class ran for 59 weeks in CSI, beginning on Friday, 22/4/2005.

Arabic Language Class with Brother Saud Al-Azmi

Booksale » Sports Centre on Sunday, 1/5/2005.
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This event was done in conjunction with the Malaysian Food Fair which was held in the sports hall foyer on 1st May
2005. Since we had a lot of books left from the ICW event, we took this opportunity to sell them during this occasion.
MYS was given a booth which mainly sold books and a few other things such as the "End the Occupation” t-shirts, the
holy Quran, and hijabs.

MYS Introductory session to the freshers » CS/ on Saturday, 17/9/2005.

introductory session

Freshers trip to Cliffs of Moher » Cliffs of Moher on Saturday, 1/10/2005.

As a show of our warm welcome to the new students who arrived in Galway in September 2005, we organised a trip to
the Cliffs of Moher to show them the wonderful views of Ireland. We prepared lunch for the freshies, had a breaking the
ice session and within a short time, we managed to tighten the bond between the old and new members. It was a
successful trip and we plan to organize more succesful trips in the near future.

One Day Fast Programme » CS/ on Wednesday, 19/10/2005.

During this event, we invited everyone regardless of their religion to fast with us on this day while collecting charity
money for the victims of Kashmir Earthquake. For those who agreed to fast, we provided them with the guidelines on
fasting during the day and at what time they are able to break their fast. We held a small reception in the CSl on 19
October 2005 to show our appreciation towards those who had participated. We worked in collaboration with VSA and
Human Appeal International, as well as a few of the students from GMIT who had contributed their time and energy for
the success of the One Day Fast event. This year we managed to collect a total of ~6000 euros and hope to collect
more in 2006.

Trip to Spain » Andalucia, Spain on Saturday, 17/12/2005.

Trip to Andalucia, Spain... to re-live and understand the history of Muslims of Andalucia, Spain and their impact on the
world civilization. This trip was a 1 week trip. One of the most memorable trips that all of us have ever had. We took
back a lot of knowlegde with us. Our initial intention about going to Spain was to find materials for the ICW in January,
since our ICW theme for this year was Islamic Civilization. At the end of the trip, we not only found the materials we
were looking for, but we found and realised the importance of history in everyone's life. A lot can be learnt from history,
no matter how good or bad the history is, as long as a lesson can be learnt from it to prevent future downfalls. We
managed to convey our knowledge and materials we brought back from Spain during the ICW and not only it was a
successful event, but it was our most memorable one since tons of effort were put into it. It was a grand trip and if time
and budget allow, we'll definitely organize another trip somewhere else in the coming future.

Islamic Cultural Week » Aras Na Mac Leinn Foyer on Tuesday, 24/1/2006.

FINAL JOURNEY PROGRAMME » IT 125 on Saturday, 28/1/2006.

Muslims Role in the West : ZiaUllah Khan » CS/ on Thursday, 16/2/2006.

ICW Appreciation Ceremony » Hub, Sports Centre on Friday, 3/3/2006.

After all the hard work for the ICW, the MYS committee agreed to hold a ceremony just to forward our gratitude and
appreciation towards the MYS members who had contributed so much for the grand event of the year. A food reception
was held in the Hub in the sports centre. At the end of the food reception, we had a discussion and evaluation on all
the activities that we had done throughout the year. Weaknesses and strenghts were pointed out, and we discussed
about how we could make next year a better year for all of us. A short photography session was done at the end of the
whole ceremony.

AGM » CSl on Friday, 10/3/2006.

MINDA programme » Cong, County Mayo on Friday, 7/4/2006.

Committee 2005/2006

Auditor: Mohd Adzreil Bakri Vice-Auditor: Mardiah Masharuddin
Treasurer: Mohd Rafig Mohd Taib Secretary: Fadzilah Hahim Rahim
Public Relations Officer 2: Wan Noor Aida

Sports & Recreation Officer: Mohd Zaquan Arif Mohd Idris

Dawah and Tarbiyyah Officer: Sharifah Najwa Syed Public Relations Officer 1: Adilla Nur Halim

Mohamad
Events Officer: Mohd Qamarul Azzam Razali Campaigns Officer: Md Syazwan Md Amin
Webmaster/FOSIS Rep: Shahzad Javid Publication Officer: Adzleen Mohmood
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Committee 2006/2007
Auditor: Mohd Rafig Mohd Taib
Treasurer: Qamarul Azam Razali

Tarbiyyah Officer: Amira Amir

Webmaster: Rushd Bajwa

Public Relations Officer: Liyana Yasmin Mohd
Razi

Muslim Society Balance Sheet

Income

Income Category Amount
Opening Bank Balance 1797.16
Fundraising €6280.01
Members Contributions €750.19
Sponsorship €651.09
USC Grant €5381
Total €14859.45

Other Information

We held 11 committee meetings during the year and we have held our AGM. Our total membership stands at

111 members.

Vice-Auditor: Adzleen Mohmood

Secretary: Sharifah Najwa Syed Mohamad
Student Affairs Officer: Siti Hazrina Mohamed

Hanafi

Campaigns Officer: Adilla Nur Halim

Publication Officer: Aman Akbar Adam

Expenditure

Expenditure Category

Bank charge
Dinner
Fundraising/charity
Gifts

Prizes

Society transport

Speaker accomodation

Speaker travel
Stationary
Teacher fees
Expenditure Total
Cash In Hand

Closing Bank Balance

Total

Orchestra Society

The Orchestra Society has had a very successful year. We are continuing to expand and this year had a
woodwind and brass section for the first time. This enabled us to perform a symphony, by Haydn, which was our
ultimate goal from the beginning. We performed three Irish premieres and hope to continue this trend of finding
new and old unheard music and bringing it to Galway. We had a trip to Clifden and played a concert there. We

also had a very educational workshop with the Con Tempo quartet.

Orchestra Soc Events
This year the society held a total of 4 events.

Open Day » Aras na MacLeinn on Thursday, 1st of December.

Orchestra Muscailt Concert » Orbsen Building Foyer on Tuesday, 21st of February.

End of Year Concert » Church of Ireland, Clifden on Sunday, 26th of March.
End of year Concert » Aula maxima, Upper on Monday, 27th of March.

Amount
€22
€4824
€6370.01
€7.26
€388.72
€3019
€265
€615
€229.64
€400
€11779.23
€170.51
€2909.71
€14859.45



Committee 2005/2006
Auditor: Johnny Berrill Treasurer: Hazel Fahy
Secretary: Conor Hurley

Orchestra Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 1777.21 Affill/Mem fees €1700
Fundraising €250 Dinner €468
Muscailt €200 Equipment misc €625.35
Sponsorship €350 Hall hire €200
Ticket Sales €1040 Materials €148.5
USC Grant €3105 Printing €59.58
Society accommodation €1807
Teacher fees €1500
Expenditure Total €6508.43
Closing Bank Balance €213.78
Total €6722.21 Total €6722.21

Other Information
We held 3 committee meeting during the year and we have held our AGM. Our total membership stands at 43
members.

Philosophy Society

The Philosophy Society had a fun and successful year, starting as we did from scratch. Weekly talks were given
on philosophical themes by experts, such as The Phenomenology of Technology, Adventure, and
lllusion, followed by discussions. There was an emphasis on simplicity, getting not just students of philosophy,
but philosophical students involved. With that sentiment, we had a fortnightly discussion forum on topics of
universal interest: love, truth, and freedom. We were the first Irish philosophical organisation to get the showing
rights of the new movie on Heidegger. Students enjoyed a trip to a Zen dojo. Feedback was positive on the
talks, and the objective was achieved: a substantial amount of non-philosophy students were thrilled with the
talks, getting thoroughly involved and subsequently interested in reading and living philosophy.

Philosophy Soc Events

This year the society had a total of 10 events that took place.

Informal Discussion forum ran for 2 weeks in AM204, beginning on Monday, 21/11/2005.
We meet to discuss topics of universal interest..love..truth...freedom...... All welcome.

Informal Discussion Forum ran for 5 weeks in AM204, beginning on Monday, 30/1/2006.
We meet to discuss topics of universal interest..love..truth...freedom...... All welcome.

Dan Bradley: Illusions » Philosophy Dep, Seminar room on Thursday, 2/2/2006.

Dan Bradley of the Philosophy department will convince us that everything is an illusion....... Join us.
Phenomonology of Technology » Philosophy Dept. Seminar Room on Monday, 6/3/2006.
There will be a post graduate talk on how the technology of any given age reflects on the culture and morality of the
people.

Phenomonology of Adventure » Philosophy Seminar Room on Thursday, 16/3/2006.

Committee 2005/2006
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Auditor: Conor Graham Vice-Auditor: Austin Dwyer
Treasurer: Lee Hughes Secretary: Rachelle McCaney
Liaison Officer: Shane Connolly Public Relations Officer: Daniel Leufer

Philosophy Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 0.13 Bank charge €0.28

Societies day €32 Costumes €0.56

USC Grant €440.4 Dinner €100
Materials €130
Non Alcoholic Refresh €30
Reception €60
Expenditure Total €320.84
Closing Bank Balance €151.69

Total €472.53 Total €472.53

Other Information

We held 4 committee meetings during the year. We have not held our AGM yet. Our total membership stands at

20 members.

Photo Society

This year we ran black and white photography tutorials as well as holding talks giving tips on how to take better
photographs. A day trip to Ballinasloe horse fair last autumn was also organised. Members had some of their
work published in SIN newspaper as well as the alumni magazine. We also took part in the 'What Is Ireland?'
exhibition as part of the Washington Ireland Inititative.The highlight of our year was when students got the

chance to display some of their work in the 'Focus '06' exhibition held as part of the Muscailt Festival.

Photography Soc Events

This year the society held a total of 17 events.

Meeting » /T 202 on Wednesday, 28th of September.

Guest Speaker » /T 250 on Wednesday, 5th of October.

Guest Speaker » /T 250 on Wednesday, 12th of October.

Meeting » /T 250 on Wednesday, 19th of October.

Meeting » /T 250 on Wednesday, 26th of October.

Meeting » /T 250 on Wednesday, 2nd of November.

Meeting » /T 250 on Wednesday, 9th of November.

Meeting » /T 250 on Wednesday, 16th of November.

First Photosoc Meeting Of The Semester » AM 2714 on Wednesday, 25th of January.
Meeting » /T 250 on Wednesday, 1st of February.

Meeting » /T 250 on Wednesday, 8th of February.

What Is Ireland Exibition » NUI Galway and Galway City on Friday, 10th of February.
Meeting » /T 250 on Wednesday, 15th of February.

Focus '06 Exhibition » Aras na Mac Léinn Foyer on Monday, 20th of February.

'Focus '06' » Aras Na MacLeinn Foyer Area on Tuesday, 21st of February. To February 25th
Meeting » /T 250 on Wednesday, 8th of March.
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AGM » [T250 on Wednesday, 15th of March.

Committee 2005/2006
Auditor: Catherine Carey
Treasurer: Elizabeth Helliesen
Darkroom Tutor: Ben Ruddy
Darkroom Tutor: Cylene Padley

Vice-Auditor: Lee Hughes
Secretary: Mihai Basa

Darkroom Tutor: Charity Shumaker
Darkroom Manager: Nat Cafolla

Photography Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 513.41 Affill/Mem fees €874.5
Members Contributions €165 Bank charge €13.39
Muscailt €130 Materials €213.15
Socs box €110 Speaker travel €110
USC Grant €650
Expenditure Total €1211.04
Closing Bank Balance €357.37
Total €1568.41 Total €1568.41

Other Information
We held 13 committee meetings during the year and we have held our AGM. Our total membership stands at
1224 members.

Physics Society

The Physics Society, NUI Galway hosts meetings and talks on this exciting area of Science.

Physics Soc Events

This year the society held a total of 5 events.

Science Ball » Galway Bay Hotel on Monday, 3rd of October.

Pre drinks starts at 6pm. Dinner at 8pm. Piano by Sacha and Band 'Blue Moose' and Alan Quinn DJ from Cuba.
Science Ball » Galway Bay Hotel on Thursday, 3rd of November.

Christmas Party » McSwiggans on Tuesday, 13th of December.

Join us for festive fun! All welcome.

New Years Get Together » Massimos on Monday, 9th of January.

What beter way to start of the year than joining us in Massimos. All welcome.

Speaker: Matt Redmond » Siobhan McKenna Theatre on Thursday, 16th of March.
Topic: 'How to make a star'. Join us afterwards in Massimos for a St paddys Day Party. All Welcome.

Committee 2005/2006
Auditor: Don Phelan
Treasurer: Andrew Cronin

Vice-Auditor: Larry Murray
Secretary: Mark Foley
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Physics Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 16328.52 Ball €17112.24

Socs box €840 Dinner €325.55

Ticket Sales €4177 Reception €1663.6
Expenditure Total €19101.39
Closing Bank Balance €2244.13

Total €21345.52 Total €21345.52

Other Information
We held 5 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
55 members.

Poker Society

The aim of the Poker Society is to promote the increasing popularity of Texas Hold Em Poker in NUIG, and to
organise friendly and low cost poker tournaments, during our first year we have run weekly poker tournaments in
the Hub. They have been well attended and the proceeds for the evenings have been divided each week as
winnings.

Poker Events
This year the society had a total of 15 events that took place. These events can be divided into two categories:
regular and special events.

Regular Events

This year we held 2 events that ran regularly over a number of weeks. These events were as follows:
Poker Tournament ran for 9 weeks in The HUB, beginning on Monday, 19/9/2005.

Poker Tournament ran for 6 weeks in The HUB, beginning on Monday, 30/1/2006.

Committee 2005/2006
Auditor: John Daly Vice-Auditor: Oisin Murray
Treasurer: Neill Kennedy

Committee 2006/2007
Auditor: John Daly Vice-Auditor: Neil Kennedy
Treasurer: Cathal Grennan Secretary: Caitriona DePaor

Poker Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 0 Bank charge €3.75
Fundraising €7035 Equipment misc €112
Societies day €112 Prizes €6760
Expenditure Total €6875.75
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Unreconciled Cheque Total €0
Closing Bank Balance €271.25
Total €7147 Total €7147

Other Information
We held 15 committee meetings during the year and we have held our AGM. Our total membership stands at
360 members.

Political Discussion Society

This year we had a specific aim to improve student involvement and participation. To this end we insured that all
meetings had events had a question and answer period at the end when the floor was open to ant member to
ask or discuss a topic with those participating in the event. We felt that this would help students feel more
involved in the event and engage them more with the discussion We also tried and move away from the past
forms of meeting where a politician would speak on a topic of their choice when finished them leave without any
student involvement or participation.

Political Discussion Soc Events

This year the society held a total of 20 events.

Country V City » O Flaherty Theatre on Monday, 26th of September.

Eyre Square Meeting » O Flaherty Theatre on Monday, 3rd of October.

Ann Summers Party » Cellar Bar,Eglington Street on Monday, 10th of October.

Breat Cancer Awareness Meeting » O Flaherty Theatre on Monday, 17th of October.

Senator Magaret Cox , Liz Mc Manus T.D. and Phil Keating from the Marie Keating Foundation discussion the situation
of Breast Cancer in Ireland.

Trip to Question and Answers » RTE Studios on Monday, 24th of October.

Ringu Tulku Rinpoche » O Flaherty Theatre on Monday, 7th of November.

Political Awareness Week » All over Campus on Monday, 14th of November.

InterParty Debate » O'Flaherty Theatre on Monday, 23rd of January.

Inter-Party Debate » O Flaherty Theatre on Monday, 23rd of January.

Speaker Competition » O'Flaherty Theatre on Monday, 6th of February.

Public Speaking Competition » O Flaherty Theatre on Monday, 6th of February.

Haughey the DVD » O Flaherty Theatre on Monday, 13th of February.

Trip to Westminster Abbey » London on Wednesday, 1st of March.

HM Ambassador to Ireland » O'Flaherty Theatre on Monday, 6th of March.

British Ambassador Mr Stewart Eldon will address the Society on the role of embassies, the role of the United Kingdom
in Northern Ireland as well as taking questions on areas of interest from the student body. Reception afterwards in the
Cellar Bar.

SU Hustings » O'Flaherty Theatre on Wednesday, 8th of March.

Lunch Time Meeting with Tanaiste Mary Ha » Siobhan Mc Kenna Theatre on Monday, 20th of
March.

Mark Little » O'Flaherty Theatre on Monday, 20th of March.

Prime Time presenter Mark Little will address the second last meeting of the Political Discussion Sociity tonight.All
welcome to attend. Reception afterwards in the Cellar Bar.

Schools programme » Siobhan mckenna Theatre on Thursday, 23rd of March.

The PDS schools programme in which juniour certificate schools are invited on to campus to meet political figures and
interact with the society to gain a deeper understanding of Civic Socail and Political Education. The event won first
place in the AIB NUI Galway Society Event of Excellence Award.

Annual General Meeting » O Flaherty Theatre on Monday, 27th of March.
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Committee 2005/2006

Auditor: Pamela Prendiville Vice-Auditor: David Geary
Treasurer: Jeffrey Rockkett Schools Conveyner: Claire Mc Gowan
PRO: Steven Lydon Promotions Officer: Stephanie Joyce

Committee 2006/2007
Auditor: Claire Mc Gowan Vice-Auditor: Jack Evans
Treasurer: Niall O Tuairisg

Political Discussion Society Balance Sheet

Income Expenditure

Income Category Amount  Expenditure Category Amount

Opening Bank Balance 490.52 Bank charge €3.75

USC Grant €2472.55 Dinner €327.2
Gifts €1174.77
Prizes €100
Reception €477.65
Society accommodation €400
Society transport €40
Speaker travel €87
Teacher fees €342
Expenditure Total €2952.37
Does not include Unreconciled Cheque Total (€97)
Closing Bank Balance €10.7

Total €2963.07 Total €2963.07

Other Information
We held 10 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 347 members.

Presidents Award Society (Gaiscesoc)

The President's Award (Gaisce) Society aims to help students and staff attain their goals towards recieveing the
Bronze/Silver/Gold President's Award. The Presidents Award is the only state award of excellence available to
Irish people. Our hope this year is to bring 8 students to Estonia to literally "build bridges". The President's
Award (Gaisce) Society encourages young people to set and achieve a demanding challange for themselves in
each of four different areas -

1. Community involvement (eg. helping the elderly),
2. Skill (eg learning to plya a new instrument),

3. Physical (e.g. swimming)

4. An adventure project.

Each memeber is assigned a PAL to help them along their journey. Through society events such as trips to
Petersberg and Estonia we encourage personal development, teambuilding, and self confidence.

Presidents Award (Gaisce) Soc Events
This year the society held a total of 2 events.
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Petersberg » Mayo on Saturday, 18th of February.
AGM » |T 202 on Wednesday, 22nd of March.

Committee 2005/2006

Auditor: Aoife Kernan Vice-Auditor: Jill Masterson
Treasurer: Ann Browne Secretary: Una Duffy
OCM: Caitriona Callanan Public Relations Officer: Nick Geoghegan

OCM: Geardid O Treasaigh

Committee 2006/2007

Auditor: Aoife Kernan Vice-Auditor: Elizabeth Reidy
Treasurer: conor Burns Secretary: ann Browne
OCM: Marian Slattery PRO: Gearoid O Treasaigh

Presidents Award (Gaisce) Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 56.97 Affill/lMem fees €2636
Fundraising €906.45 Entertainment €65
Members Contributions €640 Fundraising/charity €464
USC Grant €1585
Expenditure Total €3165
Closing Bank Balance €23.42
Total €3188.42 Total €3188.42

Other Information
We held 18 committee meetings during the year and we have held our AGM. Our total membership stands at 56
members and we have submitted our list of members to the Societies Office.

Psychological Society

The Psychological Society was set up to promote the study and understanding of Psychological issues on
campus, to host meetings on topics related to the study of the discipline and to maintain close links with the
Psychological Department.

Psychological Soc Events

This year the society held a total of 9 events.

EGM » AM250 on Sunday, 2nd of October.

Emergency General meeting to elect new committee, Followed by reception. all members welcome.

Psychopathy: The mean side of the Dark T » AM 250 on Monday, 10th of October.

A lecture by Prof Robert Hare on the ongoing research into Psychopathy. A rection to follow in the foyer of the building
all welcome.

General Knowledge Table Quiz. » Students Bar. on Monday, 17th of October.

A Table Quiz in order to raise funds for the Society. Prizes for the winning team and Best Name of team, teams of four
required.

Talk on Sri Lanka. » Lecture Theather 1, St Anthonys. on Monday, 24th of October.
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A talk on the situation in Sri Lanka by Graduates who spent some time working there. Reception after in foyer, all
welcome.

Fancy Dress Halloween Party » The Living Room on Thursday, 27th of October.

A fancy dress party in the Living Room, prizes given for the best costumes. All welcome.

Emergency General Meeting » AM 250. on Monday, 23rd of January.

Emergency General Meeting, called to elect new members of the committee. Reception after, all welcome.

Sucide: all you want to know. » AM250. on Monday, 6th of March.

Prof Kevin Malloy will give a lecture on the latest studies on sucide. Reception afterward in foyer, all welcome.

End of Year Party. » The Living Room. on Thursday, 23rd of March.

Time to unwind after a hard year. Free finger food and prizes. All wellcome.

Psychological Students of Ireland Congre » NU/ Maynooth on Friday, 7th of April.

PSI Congress 2006, held in NUI Maynooth. Leaving by bus at 11.00, staying at the Glen Royal Hotel, Maynooth. Prize
giving Dinner on Saturday night at 20.00. Return by bus on Sunday morning.

Committee 2005/2006

Auditor: Kevin Hogan Vice-Auditor: Remona Roper-Hurst
Treasurer: Cormac Duffy Sharon McHugh: PRO

Niall Lally: Web Administrator Peter Collins: PRO

Remona Roper-Hurst: Safety Officer Caoimhe Speakman: Event photographer

Eimear Lee: PRO

Psychological Society Balance Sheet

Income Expenditure
Income Category Amount  Expenditure Category Amount
Opening Bank Balance 316.54 Bank charge €7.5
Fundraising €470 Entertainment €61
Socs box €3180 Entry fees €830
Societies day €165 Society accommodation €500
USC Grant €1630 Society transport €300
Speaker accommodation €3248
Expenditure Total €4946.5
Does not include Unreconciled Cheque Total (€225)
Cash In Hand €120
Closing Bank Balance €695.04
Total €5761.54 Total €5761.54

Other Information
We held 26 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 20 members.

Quiz Society

Quizsoc are the finest purveyors of interesting trivia and thought-provoking questions this side of the Atlantic
seaboard, we're a young society (only our third year in college) but we've a strong and loyal group of supporters.
We've been known for our various challenging quiz features in the past, and this year was no exception: We
planned on having a big event every month and has succeeded in doing so, with new and innovative events like
the Quizsoc Gameshow and Weakest Link theatre quizzes proving a huge success, as well as our old favourite,
the pub table quiz.
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As proud as we were of hosting such events that thankfully went down very well, we're equally proud of our
contributions to charity this year. So far we've raised just under €1,000 for various charitable organisations, like
Enable Ireland, Console, Special Olympics and the Irish Wheelchair Association, at different events over the
course of the year. But we're not ones to rest on our laurels at Quizsoc, and we've already got some great plans
set up for next year!

Quiz Soc Events

This year the society held a total of 6 events.

Inter-County Table Quiz » College Bar on Tuesday, 27th of September.

Represent your county, state, province or principality with pride in an intense bout of territorial quizzing action, and win
some big money prizes! All proceeds go to Enable Ireland.

Quizsoc Gameshow » /T 125 on Monday, 24th of October.

Paying homage to such classics as Fifteen to One, Countdown, Going for Gold and Blockbusters, the innaugural
Quizsoc Gameshow is a brand new innovation this year in our series of Theatre Quizzes. For this event, a large and
plucky group of Galway's finest quizzers battle it out in an attempt to win the most prestigious prize of the year: The
Richard Whiteley Memorial Trophy...

Weakest Link, Galway Style! » McMunn Theatre on Wednesday, 30th of November.

The Weakest Link, but without the narky gingers! Twelve students go down, only one shall come up, but who will be
the Strongest Link? Come along to find out!

Disability Awareness Week Table Quiz » College Bar on Thursday, 26th of January.

QuizSoc's first event of the year takes place in aid of Disability Awareness Week (starting 23rd January). € 20 per table
of four with big money prizes at stake! All proceeds going to Enable Ireland and Irish Wheelchair Association.
Muscailt Performance Table Quiz » College Bar on Tuesday, 21st of February.

It's that time of year again, and to celebrate the wonderful week that is Muscailt we are putting on the jewel in
Quizsoc's crown: The Performance Table Quiz! Now in it's third glorious year, the Performance Quiz is always
entertaining, pleaseantly suprising and just a little bit mental...So come along to join in the craic!

Now That's What I Call Quizsoc! » College Bar on Monday, 27th of March.

To culminate what has been a busy but thoroughly enjoyable year, we're joining forces with MUSIC SOC to create an
end of year extravaganza: 'Now That's What | Call Quizsoc!" will be ten rounds of musicky mayhem, with special
rounds, performances and lovely, lovely, prizes on the night. All proceeds going to charity, so come along and shake
off those study blues, quiz stylee!

Committee 2005/2006

Auditor: Paddy Duffy Vice-Auditor: Andrew Gibbons
Treasurer: Duffy/Gibbons Secretary: Liam Harkin
Superman: Patrick Mulrennan President for Life: Michael Coyne

Committee 2006/2007

Auditor: Ruth McNally Vice-Auditor: Emma Conway
Treasurer: Liam Harkin Secretary: Nora McMahon
Quizmaster General: Paddy Duffy Executive Supervisor: Liam Harkin
President for Life: Michael Coyne Quizsoc Enforcer: Andrew Gibbons

Quiz Society Balance Sheet

Income Expenditure
Income Category Amount  Expenditure Category Amount
Opening Bank Balance 601.12 Fundraising/charity €800
Fundraising €620 Prizes €90
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USC Grant €160 Society transport €30

Expenditure Total €920

Does not include Unreconciled Cheque Total (€80)

Closing Bank Balance €461.12
Total €1381.12 Total €1381.12

Other Information
We held 16 committee meetings during the year and we have held our AGM. Our total membership stands at
200 members.

Radio Society

This year we wanted to give our members the chance to learn new skills in radio broadcasting and production.
Also to obtain the knowledge of the wider media marketplace.

For example our speakers, Maria McGonagall (Media Law Lecturer, NUI Galway), Alison Curtis (The Last
Splash, Today FM) and Andrew O' Baoill (1st Flirt FM Manager) gave an insight into what it takes to be a
presenter and producer on Irish radio and how radio in Ireland is changing rapidly.

As a society we aimed to facilitate the development of student journalism and to promote radio in the
University as it is a substantial part of media in Ireland.

This society has been successful in forming a stronger bond with Flirt FM and its members. This has helped us
give our members an opportunity to be involved and to learn about radio broadcasting and production first hand.
Be it through training or taking part in our live broadcasts during Rag Week.

In addition to our objectives we are a society which promoted involvement at all levels with the development of
skills and friendships. Hopefully this society has helped many to see their true potential and help them to work in
radio in the future.

Radio Soc Events
This year the society had a total of 29 events that took place.

Acoustic Wednesdays ran for 4 weeks in De Burgos, beginning on Wednesday, 18/1/2006.

The Radio Society presents: Acoustic Wednesdays at De Burgos. This week we give you papercupsongs and Big
Danny Gallagher, two great acts in an intimate setting. Doors at 9pm and entry is free.

EGM » AC214 on Monday, 26/9/2005.

Media Law Lecture » Dillon Theatre on Wednesday, 28/9/2005.

This is a lecture given by Marie McGonagle, a media law lecturer. This was obligatory for anyone who wants to go on
air. This lecturer will distinguish between slander and lible and how many ways you can get sued if you don't know
what to say. This was followed by a reception in De Burgos for the 10th Anniversary of Flirt FM.

Alison Curtis » Aras Ui Cathail on Friday, 21/10/2005.

Presentation and Interview Training » Flirt FM on Wednesday, 26/10/2005.

Presentation and Interview Training » Flirt FM on Wednesday, 26/10/2005.

Halloween Party » De Burgos on Wednesday, 26/10/2005.

Desk Training » Flirt FM on Thursday, 27/10/2005.

Desk Training » Flirt FM on Tuesday, 1/11/2005.

Cool Edit Training » Flirt FM on Wednesday, 2/11/2005.

Presentation and Interview Training » Flirt FM on Monday, 7/11/2005.

Minidisk Training » Flirt FM on Tuesday, 8/11/2005.
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Minidisk Training » Flirt FM on Monday, 14/11/2005.
Cool Edit Training » Flirt FM on Tuesday, 15/11/2005.

Cool Edit is a computer programme which is designed to edit mainly minidisks. You will mainly be using this

programme to edit interviews, vocs pops, pre-recorded shows, promos and jingles. Given by Aidan McEvilly
Christmas Party » Leisureworld on Wednesday, 23/11/2005.

Andrew O'Baoill » /T Building on Wednesday, 11/1/2006.

EGM and Introduction » SC200A (near Smokies) on Wednesday, 18/1/2006.
Desk Training & Presentation Skills » Flirt FM on Monday, 20/2/2006.
Mini Disk & Cool Edit Training » Flirt FM on Tuesday, 21/2/2006.

Irish Radio Production Training » Flirt FM on Thursday, 23/2/2006.

Irish Radio Production Training » Flirt FM on Thursday, 23/2/2006.
Presentation & Desk Training » Flirt FM on Thursday, 23/2/2006.

Rag Week Special » Flirt FM on Monday, 27/2/2006.

RAG WEEK: Acoustic Wednesday » DeBurgos on Wednesday, 1/3/2006.
AGM » [T125G on Thursday, 30/3/2006.

End of Year Party » The Bierhaus on Thursday, 30/3/2006.

Committee 2005/2006
Auditor: Emma Doyle Vice-Auditor: Aidan McEvilly
Treasurer: Patrick O Flaherty Secretary: Corina Duggan

Committee 2006/2007
Auditor: Corina Duggan Vice-Auditor: Aidan McEvilly
Treasurer: Patrick O'Flaherty

Society Balance Sheet

Income Expenditure

Income Category Amount  Expenditure Category Amount

Opening Bank Balance 48217 Dinner €95

Greenform €129 Entertainment €198.65

USC Grant €974.06 Equipment misc €376.99
Reception €214.3
Returned Money €182.93
Society transport €20
Speaker accommodation €129
Expenditure Total €1216.87
Does not include Unreconciled Cheque Total (€134.56)
Closing Bank Balance €368.36

Total €1585.23 Total €1585.23

Other Information

We held 5 committee meetings during the year and we have held our AGM. Our total membership stands at 270

members.
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Ogra Sinn Fein Society

Over the past year Sinn Féin has been extremely active around college and the city. This year we have
managed to build on the solid base of last year by acquiring a large number of new and committed activists, we
immediately solidified our membership by throwing the full resources of the Cumann into both the ‘Rossport &
and ‘Shell to Sea’ campaigns, soon we became the driving force behind both campaigns. Over the period of
R5’s incarceration we took part in a number of well supported pickets at the Newcastle Statoil Station. Our
protests culminated with our members marching in protests in both Dublin and Galway, soon after the leader of
the Rossports, Miceal O’Seighin, addressed supporters in college as Gaeilge, although not our first speaker of
the year he proved by far the most popular.

While Sinn Féin remained at the centre of this cause we also immersed ourselves in other just causes around
Ireland, on the 24th of September members took part in the Irish Unity March on the streets of Dublin. Soon
after our members went to Belfast to take part in political and cultural tours of the city and the surrounding area.
Over the past year our cumann took part in many events around the country, these included, the Bloody Sunday
Commemoration March in Free Derry and the Ogra Shinn Féin National Congress on the 3rd and 4th of
February.

One very important event the society played an active role in was the Frank Stagg 50th Anniversary
Commemoration, the cumann provided both party members and marchers for this event, which was very well
received by both the Stagg family and the local community in Ballina Co. Mayo. By our support we helped,
along with Republicans from all over Ireland, to mark a very special man who died on Hunger Strike for his
country.

Only one week after the Ballina Commemoration our cumann supplied three delegates and a number of visitors
to the Sinn Féin Ard Feis, at this hugely important event members helped to decide future party policy on the
possibility of coalitions in the 26 counties and policing issues in the occupied 6 counties.

Over the last year Sinn Féin has worked tirelessly to both politicise and radicalise the student body of the
college, most of our work has centred around the 25th Anniversary of the 1981 H-Block Hunger Strikes. On this
issue we hosted the National Hunger Strike Exhibition which is touring Ireland as well as respected journalist
and political commentator Danny Morrison. However there is no doubt that our greatest success of the past
year has been the 1981 Hunger Strike Commemoration held in Richardson’s Bar. This event was organised
solely by the college cumann and featured speakers from our cumann as well as entertainment provided by Free
Derry’s own rebel band ‘Pég Mo Thaoin’. This event was extraordinarily well attended and raised a great deal of
awareness of the Hunger Strikers.

What we have achieved by our efforts over the last year is too great to list, what we have still to achieve is much
greater. | would like to take this opportunity on behalf of the D’Arcy/Hurson Sinn Féin Cumann to thank all who
have helped to make this year, the 100th Anniversary of Sinn Féin, the best year in the history of our college
cumann. | would like to extend a special thanks to our activists in the college who have worked tirelessly for our
cause, as well as the college itself who have supported us in all of our endeavours.

Sinn Féin Soc Events
This year the society had a total of 34 events that took place. These events can be divided into two categories:
regular and special events.

Regular Events
This year we held 2 events that ran regularly over a number of weeks. These events were as follows:
Weekly Meeting Open to members ran for 10 weeks in AC203, beginning on Tuesday, 27/9/2005.
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Weekly Meeting for members ran for 12 weeks in IT250, beginning on Tuesday, 10/1/2006.
Frank McBrearty » AM250 on Sunday, 11/9/2005.

Speach by Frank McBrearty on his incarceration by a corrupt Dublin government

Make Partition History March » Baile Ath Claith on Wednesday, 19/10/2005.

Cead Blaine, 100yr Exhibition » Aras na MacLeinn on Thursday, 1/12/2005.

Céad Blaine: 100yr Exhibition » Aras na MacLeinn on Thursday, 1/12/2005.

(')gra Shinn Féin National Congress » Ath Claith on Friday, 3/2/2006.

Bloody Sunday March » Free Derry on Sunday, 5/2/2006.

Frank Stagg Commemoration » Ballina Co. Mayo on Sunday, 12/2/2006.

50th Anniversary of the death of Hunger Striker Frank Stagg, murdered by British policy. Imprisoned in death by the
Fine Gael/Labour Coalition.

Sinn Féin Ard Feis » Ath Claith on Friday, 17/2/2006.

Hunger Strike Commemoration » Richardson's Bar #1 Eyre Sq. on Saturday, 25/2/2006.
National Hunger Strike Exhibition » Aras na Mac Leinn on Monday, 27/2/2006.

Danny Morrison Lecture » Richardson's Bar on Wednesday, 1/3/2006.

Lecture to educate on the impact of the 1981 Hunger Strikes

AGM » [T203 on Tuesday, 28/3/2006.

Committee 2005/2006

Auditor: Aengus O'Dochartaigh Vice-Auditor: Conor McGuinness
Treasurer: Jarlath Tourish Secretary: Daniel Delargy

Committee 2006/2007

Auditor: Eamon Mac an Ri Vice-Auditor: Diane Nolan
Treasurer: Jarlath Tourish Secretary: Fiona Moran

PRO: Amanda Donnellan Ass. PRO: Andrew Hayes

Ass. Treasurer: Amanda Burke Irish Officer: Tomas O'Caidhain
6gra Officer: Conor McGuinness Recruitment Officer: Daniel Delargy
Social Officer: Aengus o'Dochartaigh IT Officer: David Thornton

Final financial details not available at time of print.

Other Information
We held 52 committee meetings during the year and we have held our AGM. Our total membership stands at 65
members.

Sainte Society

The society this year was a very busy one. We began with fundraising for various charities, for example the
Marie Keating Foundation. As well as this, a lot of time and hard work went into the organisation of our largest
project of the year, the Teddy Bear Hospital. This was held in January and was a great success. After this, we
focused of recruiting new members and raising awareness, especially in the area of organ donation just before
RAG Week.

Throughout the year we were kept going with many small projects, such as fundraising, and involving as many
interested students as possible from the college.

We won best event for our Teddy Bear hospital at the NUI Galway Society Awards and our co-founder, Donna
Cummins won best society individual and went on to win national society individual at the BICS awards in Cork.

92



Slainte Society Events
This year the society held a total of 3 events.

Breast Cancer Talk » Campus on Monday, 10th of October.

Teddy Bear Hospital » Aras na MacLéinn on Friday, 13th of January.

Organ Donation Week » Campus on Monday, 13th of February.

In conjunction with the Irish Donor Network, Slainte Soc will be promoting Organ Donation throughout the week by

distributing Organ Donation Cards and providing information on the subject.

Committee 2005/2006
Auditor: Liz Concannon
Treasurer: Caroline Cowley
PRO: Nuala Kane

Slainte Society Balance Sheet

Income
Income Category Amount
Opening Bank Balance 0
Sponsorship €1500
Total €1500

Other Information

Vice-Auditor: Claire Reynolds
Internal Officer: Gerard Healy
External Officer: Donna Cummins

Expenditure

Expenditure Category Amount
Equipment misc €625
Gifts €50
Materials €478.36
Non Alcoholic Refresh €200
Stationary €30
Expenditure Total €1383.36
Cash In Hand €21.64
Closing Bank Balance €95
Total €1500

We held 10 committee meetings during the year. We have not held our AGM yet. Our total membership stands

at 350.

Socialist Workers Student Society

The Socialist Workers Student Society is an affiliate of the Socialist Workers Party. We are a left wing political

society, with a belief that revolution is needed to overthrow the current capitalist system. On campus this year
we held a variety of meetings. We had speakers, showed films and participated in a debate with the Business
society. We participated in protests against the war in Iraq, in support of the Irish Ferries workers. We worked
together with a number of other societies on the anti-war and shell to sea campaigns. We also attended the
annual national SWSS conference in Dublin. This years committee consisted of four members, compared to
three last year. We worked together very closely, all making vital contributions, which helped the society grow in

size and presence on campus.

Socialist Worker Student Soc Events

This year the society held a total of 22 events.

Anti-war Protest » Shannon on Saturday, 24th of September.
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SWSS has organised a bus to the anti-war protest in Shannon. The march will start in Shannon town centre and walk
to the airport. There there will be a rally with local and national activists speaking followed by musical performances by
a number of Irish bands including The Revs.

New Orleans and Iraq » AC274 on Wednesday, 28th of September.

Dan Buckley, member of the Dublin SWP, will speak about the situation in New Orleans after Hurricane Katrina, and
the connection between the damage there and the war in Iraq. As it is our first meeting of the year it will also be a
chance for new members to meet the other members. Meeting will be followed by a wine reception.

Film Showing » SC200a on Wednesday, 12th of October.

Showing the Charlie Chaplin film 'Modern Times'. The film details the dehumanisation of factory workers.

Coffee Morning » The Hub on Tuesday, 18th of October.

A coffee morning with a twist. New members or prospective members are encouraged to come along and find out
about the parties politics in an informal setting.

Stop Global Warming » The Hub on Friday, 28th of October.

Johnathan Neale, an American enviromental activist will speak on the effects of global warming and what we can do
about it.

Film Showing » AC214 on Wednesday, 2nd of November.

Showing The Battle of Algiers. A powerful film about the struggle against imperialism in Algeria.

Socialist Day school » AC201 on Saturday, 5th of November.

Kieran Allen, member of the Dublin branch, and head of sociology department in UCD, will talk about four issues
related to the Socialist Workers Party, revolution, marxism today, need for a new left and left parties and movements.
Benefit Gig » DeBurgos on Thursday, 10th of November.

Benefit gig in support of the shell to sea campaign. Also commemorating the 10th anniversary of Nigerian protester
and prize winning poet Ken Saro-Wiwa. A mix of Irish and African music.

People Before Profit » AC274 on Wednesday, 23rd of November.

Rory Hearne, member of the Dublin branch of SWP, will speak on the issue of People Before Profit and the need for a
new left in Ireland.

Irish Ferries Demonstration » Cathedral on Friday, 9th of December.

A demonstration will take place in support of the workers of Irish Ferries. The demo will start at the Cathedral and will
go down shop street to a rally beside the Spanish arch. This demonstation is one of many happening around the
country. All members should attend as we must stand up for workers rights.

Meeting » Smokies on Thursday, 12th of January.

SWSS Soc Organisational meeting to plan for societies day and the weeks ahead

Anti-War meeting » Smokies on Tuesday, 17th of January.

A meeting between different societies to discuss the anti-war cause and the forthcoming demo on March 18th.

Video on palestine » McMunn Theatre on Wednesday, 25th of January.

Socialist Workers student Society show video Jenin, detailing the Israeli attack on the refugee camp of Jenin.

SWSS SOC: Anti-war meeting » Room E212(civil engineering building) on Wednesday, 1st of February.
Inter-society meeting aiming to set up a broad college alliance against the war.

SWSS Soc: White Phosphorous in Fallujah » IT250 on Thursday, 9th of February.

The SWSS in conjunction with the Galway Alliance Against War and other college societies will be showing the
documentary White Phosphorous in Fallujah. This will be followed by a talk by retired Irish army commandant Ed
Horgan, who has been vocal in his opposition to the occupation of Iraq, and has been arrested on a number of
occasions for plane spotting in Shannon.

Socialism in Latin America » AC215 on Thursday, 16th of February.

A discussion led by Rory Hearne on Socialism in Latin America. The meeting will include a report back from the World
Social Forum.

Globalisation » Larmor theatre on Wednesday, 22nd of February.

Discussion with the Business Society on the issue of globalisation. Speakers for SWSS are Dr. Su-Ming Khoo
(Soc+Pol lecturer at NUIG) and Rory Hearne (Member of geography dept. at Trinity College and member of the SWP).
Speakers for the Business society are Brian O'Boyle(Economics dept) and David Keane(Auditor of Biz Soc).
Marxism Conference » Dublin on Friday, 3rd of March.
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We will be organising to attend the annual marxism conference in Dublin. This conference is made up of a number of
talks by prominent speakers on issues affecting our world today.

American War Veterans » Dillon Theatre on Tuesday, 7th of March.

Two American war veterans from the Vietnam war and first Gulf war speak against the current war in Irag. Organised
by the NUIG Against War group.

Marxism Report » Room E212(in civil engineering building) on Wednesday, 8th of March.

Members who attended the Marxism conference will be giving a report back on the issues discussed there. We will
also be planning for the international day of protest on March 18th.

Anti-war organisational Meeting » The Hub on Monday, 13th of March.

Film Showing » Kirwan Theatre on Wednesday, 15th of March.

Showing a documentary on Fallujah and the Iraq war. Also planning for the Global Day of Protest on saturday.

Committee 2005/2006
Auditor: Kiran Emrich Vice-Auditor: Daniel Burdett
Treasurer: Kate-marie Hearne Secretary: Mary McGuinness

Socialist Workers Society Balance Sheet

Income Expenditure

Income Category Amount  Expenditure Category Amount

Opening Bank Balance 274.97 Affill/Mem fees €20

USC Grant €1414.75 Dinner €50
Hire Bus €300
Society transport €229
Speaker travel €258.8
Expenditure Total €857.8
Does not include Unreconciled Cheque Total (€436.45)
Closing Bank Balance €831.92

Total €1689.72 Total €1689.72

Other Information
We held 6 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
130 members.

Spanish Society

What a year for the Spanish Society! It began in Morgan’s bar where glasses of sangria were toasted as both
Spanish and Irish students chatted to the sounds of Latino tunes. This was to become quite the regular
occurence, as we met up several more times during the year thanks to the hospitality of the staff in
Morgans. The year moved swiftly along with the showing of Spanish language movies every second week in the
college, such as Maria plena de gracia, Como agua para chocolate and Abre los 0jos.

Creative expression was nurtured in February as both Spanish department members and students
collaborated on the writing, production and performance of a unique comedy about the trials and tribulations of
young, modern love Por amor al arte, with special thanks to Pilar Alderete and Sara Alvarez.

Another fun night out was had by all in February when the society hosted a bilingual table quiz in the college bar,

with MC's Alberto Avezuela and Colette Burke. Prizes included gift vouchers, bottles of wine and chocolates,
with even a consolation prize for the losers.
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Spanish Soc Events

This year the society held a total of 4 events.

Get Together » Morgans, Forster Court hotel, Forster St. on Tuesday, 24th of January.

Social evening all welcome with finger food and a chance to meet up after the new year. All welcome

Spanish Soc: Table Quiz Night » THE COLLEGE BAR on Tuesday, 7th of February.

The spanish society is throwing a table quiz with questions in both spanish and english. Everybody is welcome. it will
be a bit of fun for everyone!

Por amor al arte » Bank of Ireland Theatre on Monday, 13th of February.

A original Spanish comedy about love produced, performed and written by the students and staff of the NUIG Spanish
Dept. Runs for three nights from 13th, 15th and 17th February. Be sure to see this novel obra del arte. Price: €2 euros
All Welcome!!

Por amor al arte » Bank of Ireland Theatre on Wednesday, 15th of February.

A spanish comedy about love produced by the students and staff of the NUIG Spanish Dept. Price: 2euros All
Welcomel!!

Committee 2005/2006
Auditor: Colette Burke Vice-Auditor: Claire Murphy
Treasurer: lona Sweeney Secretary: Tony Creavin

Spanish Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance -0.84 Affill/lMem fees €190

Fundraising €120 Bank charge €0.56

USC Grant €290 Prizes €210
Expenditure Total €400.56
Closing Bank Balance €8.6

Total €409.16 Total €409.16

Other Information
We held 3 committee meetings during the year. We have not held our AGM yet. Our total membership stands at
80 members.

Suas Society

Suas society hopes to highlight the importance of education to the creation of a just and fair society. Suas
Nationwide is a registered N.G.O and charity which involves itself in highlighting education and providing a
volunteer program for students to teach abroad. We raise money for our partner schools in India and Kenya
throughout the year and also get involved with volunteering on a local basis. In addition, we run a Development
Education course for students to familiarise themselves with development-related issues. Check out
http://www.suas.ie/!

Suas Society Events
This year the society had a total of 59 events that took place. These events can be divided into two categories:
regular and special events.

Regular Events
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This year we held 3 events that ran regularly over a number of weeks. These events were as follows:

Weekly Meeting ran for 29 weeks in AM107, beginning on Tuesday, 6/9/2005.

DevEd Course ran for 6 weeks in BS001, beginning on Tuesday, 4/10/2005.

Suas Development Education Course ran for 7 weeks in BS001- Cairnes Business School, beginning
on Tuesday, 14/2/2006.

Special Events

This year we held 17 special events. These events were as follows:

Fancy Dress » Bar One, CP's on Monday, 26/9/2005.

Human Rights Lectures » D'Arcy Thompson Theatre on Monday, 14/11/2005.

"Volunteer Locally" Information Evening » Siobhan McKenna Theatre on Tuesday, 15/11/2005.
Make Poverty History » Bank of Ireland Theatre on Wednesday, 16/11/2005.

Stop Violence Against Women » Bank of Ireland Theatre on Wednesday, 16/11/2005.
"Volunteer Abroad" Information Evening » Colm o hEocha Theatre on Thursday, 17/11/2005.
Big Night Out » Bar 903 on Thursday, 17/11/2005.

Meeting » The Hub on Thursday, 12/1/2006.

suas meeting » AM7107 on Tuesday, 24/1/2006.

Suas Meeting » AM107 on Tuesday, 21/2/2006.

Suas Development Education Course » BS007 (New Cairnes Building) on Tuesday, 21/2/2006.
There are still places available in the Suas Development Education Course, you can enrol at www.suas.ie. An
opportunity to deal constructively with development-related issues such as Globalisation, Health, HIV/Aids, Third World
Debt and more! Runs for 6 more weeks- cost €20

Mini Rubber Duck race » Aras na Mac Leinn on Tuesday, 28/2/20086.

Early evening fun » College Bar on Tuesday, 28/2/2006.

Nicaraguan Visitors » O hEocha Theatre on Monday, 13/3/2006.

Alivera Kiiza » /T125 on Tuesday, 14/3/2006.

Paddys Day Fundraiser » All over town on Friday, 17/3/2006.

A.G.M. » AM107 on Tuesday, 21/3/2006.

Committee 2005/2006
Auditor: Yvonne McDermott Vice-Auditor: Clare McQuillan
Treasurer: Patricia McHale Secretary: Niamh OLoughlin

Public Relations Officer: Genevieve

Public Relations Officer: Gillian Lavelle
Joyce

Volunteer Liason Officer (local projects): Lauren

Society Liason Officer: Laura Heneghan
Kierans

Poker Events Manager: Thomas Meehan Volunteer Liason Officer (projects abroad): Darina

Flynn
Public Relations Officer: Sharon
Conneely
Committee 2006/2007
Auditor: Kathryn O'Shea Vice-Auditor: Anna Nic Con lomaire
Treasurer: Yvonne McDermott Secretary: Darina Flynn
0.C.M.: Clare McQuillan 0.C.M.: Patricia McHale
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SUAS Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 0.65 Bank charge €42.5

Fundraising €1381.56 Equipment misc €11.9

Members Contributions €70 Fundraising/charity €1267.22

USC Grant €428 Prizes €30.49
Reception €130
Society transport €106
Speaker travel €89.47
Stationary €6.65
Expenditure Total €1684.23
Closing Bank Balance €195.98

Total €1880.21 Total €1880.21

Other Information
We held 37 committee meetings during the year and we have held our AGM. Our total membership stands at
206 members.

Traditional Music Society

A forum for Traditional Irish music, both learning and listening. All styles catered for. This year we ran classes
and held regular sessions in the Crane Bar and a manic Ceili night in the College bar as well as daily sessions
during Muscailt. We also held a number of workshops at the start of the year in various instruments.

Trad Soc Events
This year the society had a total of 24 events that took place

This year we held 1 event that ran regularly over a number of weeks. This event was as follows:
Sessions ran for 14 weeks in Crane Bar, Sea Road, beginning on Tuesday, 10/1/2006.

Ceol agus craic le do chairde 6n tradsoc. Tunes to bate the band for all that show up, and everyone is welcome to take
part, just bring along your instruments, or even just sing a song, and make sure to bring your friends!! make it a date in
your diary!

Tin Whistle Workshop » with Mick Crehan, SC200A, 1/11/2005.

Manic Ceili» College Bar on Tuesday, 10/11/2005.

Bodhran Workshop » with Brian Flemming, SC200A 15/11/2005.

Cork Trad Intervarsity» Society trip, 3/2/2006.

Trad Session » Smokey Joe's on Monday, 20/2/2006.

Trad session » Smokey Joe's on Tuesday, 21/2/2006.

Trad Session » Smokey Joe's on Wednesday, 22/2/2006.

Trad Session » Smokey Joe's on Thursday, 23/2/2006.

Cavan Trad festival » Society trip, 10/3/2006.

AGM » Crane Bar, downstairs on Tuesday, 28/3/2006.
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Committee 2005/2006
Auditor: Diarmaid Hurley Vice-Auditor: Olive McTague
Treasurer: Liz Coleman Secretary: Cait Nic Fhionnlaoich

Committee 2006/2007
Auditor: David Doocey

Traditional Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance €71.29 Bank charge €1.68

USC Grant €601.50 Dinner €50
Entertainment €100
Gifts €20
Society transport €108
Expenditure Total €279.68
Closing Bank Balance €393.11

Total €672.79 Total €672.79

Other Information
We held 13 committee meetings during the year and we have held our AGM. Our total membership stands at 40
members.

Voluntary Services Abroad Society

Voluntary Services Abroad (VSA) is an NUI Galway based charity which enables medical
students to deliver desperately needed medical supplies and to assist in healthcare to the Third World. All of the
monies raised go directly to towards development and sustained support of these services.

This year’s fundraising efforts included The Naked Calendar, a Travelers Tales event, Table Quiz in the Quays,
The Annual Halloween ball in the Radisson, Flag Day, Selling Santa Hats at Christmas, Carol Singing, NCHD
Swing Ball in the Radisson, Bedpush to Limerick, Cycle to Sligo, bag packing, 90’s night in Cuba and a Golf
Classic. In addition to these fundraisers, all VSA members raised money in their hometowns throughout the
year.

This summer, 32 fifth year medical students are going on self-funded trips to the
Philippines, India, Kenya, Tanzania, Malawi and Zambia to assist in their hospitals and provide medical aid with
the money which has been raised. Going from strength to strength, next year's VSA committee is already
gearing up for anther year of fundraising. The 32 students are taking €98498.35 with them to donate to their
various medical centers and the remaining approximate €40,000 will be accessible to them through our bank
account if any of them see something worthwhile which they can actually purchase while they are there, for
example a much needed piece of medical equipment or materials for a building project. The accounts below do
not include additional sponsorship money which will be coming into our account throughout the summer.

Voluntary Services Abroad Soc Events
This year the society held a total of 3 events in addition to the numerous fundraising events organised by
individual classes and members..
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Christmas Concert » O'Flaherty Theatre on Thursday, 24th of November.
VSA Christmas Party

90's Night » Cuba on Monday, 20th of March.

VSA presents a 90's night in Cuba. Tickets €5 from the Socs Box
Speed-Dating » Living Room on Wednesday, 5th of April.

Committee 2005/2006

Auditor: Roisin Nee Vice-Auditor: Muireann Leonard
Treasurer: Sarah Burke Secretary: Molly MacLoughlin Row
Press Officer: Lisa McAnenna Class Reps Liason: Eoin Storn

Voluntary Services Abroad Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 5982.82 Bank charge €324.85
Balls €6070 Dinner €4630
Fundraising €122662.1 Entertainment €2120
Members Contributions €4909 Equipment misc €420
Socs box €4750 Fundraising/charity €98498.35
Societies day €1046 Hall hire €1100
Sponsorship €8571.06 Materials €3853.7
USC Grant €1445 Non Alcoholic Refresh €210
Printing €55
Prizes €120
Reception €1740
Stationary €174.45
Expenditure Total €113246.35
Does not include Unreconciled Cheque Total (€15172.2)
Closing Bank Balance €42189.63
Total €155435.98 Total €155435.98

Other Information
We held 15 committee meetings during the year. We have not held our AGM yet. Our total membership stands
at 253 members.

Writers Group Society

Over the past year 2005-2006 The Writers' Society of NUI Galway have put on many events for its members
and students of the College. In Semester 1 on 21st September, Societies' day saw the launch of the September
issue of The Sharp Review. The E.G.M took place the following week, on the 28th. Six general meetings took
place in semester 1 on the 5th, 12th and 19th October, and 2nd, 9th and 16th of November, where members got
together to read and discuss each others own writing, and offer advice on how to improve it. Two poetry
readings were held in The Ruby Room, the first on the 11th October, and the second on the 23rd November.
The Sharp Review was published every month, with Halloween and Christmas specials. A Haiku workshop took
place on the 10th November with Gabriel Rosenstock, and a trip to the Blackbox was organised for members,
who went to see 'Waiting for Godot' In Semester 2, five general meetings took place on the 18th and 25th
January, 8th February, and the 8th and 15th March. One poetry reading took place in The Ruby Room on 1st
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February. Muscailt dominated this semesters events with the Literary evening taking place on 20th February,
which awarded the winners of the literary competition, and also saw the launch of Limited Edition Sharp Review.
The 21st saw the unveiling of the poetry wall and launch of the poetry special Sharp Review. On the 22nd a
prose workshop with Susan DuMars took place, and on the 24th the Writers' Society Literary Party was held in
The Kings Head. On the weekend of 10th-12th March the Murder-mystery weekend was held in Achill Island. On
the 20th another trip the theatre was organised. 'The Walworth Farce' was being performed in the Town Hall
Theatre, and there was a pre-show talk from the playwright Enda Walsh.

Writers Group Soc Events

This year the society held a total of 26 events.

E.G.M. » AM 104 on Wednesday, 28th of September.

General Meeting » AM 104 on Wednesday, 5th of October.

Poetry Reading » The Ruby Room on Tuesday, 11th of October.

General Meeting » AM 104 on Wednesday, 12th of October.

General Meeting » AM 104 on Wednesday, 19th of October.

General Meeting » AM 104 on Wednesday, 2nd of November.

General Meeting » AM 104 on Wednesday, 9th of November.

Haiku Workshop » AM 104 on Thursday, 10th of November.

General Meeting » AM 104 on Wednesday, 16th of November.

Waiting for Godot » Black Box on Thursday, 17th of November.

Poetry Reading » The Ruby Room on Wednesday, 23rd of November.

General Meeting » AM 104 on Wednesday, 18th of January.

General Meeting » AM 104 on Wednesday, 25th of January.

Poetry Reading » Ruby Room, The King's Head on Wednesday, 1st of February.
A chance to hear the latest offerings from Society poets and a chance to share your favourite poetry with the house.
General Meeting » AM 104 on Wednesday, 8th of February.

General Meeting » AM 104 on Wednesday, 15th of February.

The Literary Evening » Siobhain McKenna Theatre (AMB) on Monday, 20th of February.
Launch of the Limited Edition of the Sharp Review, Awarding of Prizes for the Literary Competition, Speeches from
Guests and Wine Reception

Launch of "Limited Edition Sharp Review" » Siobhan McKenna Theatre on Monday, 20th of
February.

With readings from the winners of Writers' Soc literary competition and special guests Mike McCormack & Kevin
Higgins

Unveiling the Poetry Wall » The Concourse, near Smokies on Tuesday, 21st of February.

An exhibition of students' poetry, and the launch of the 'Poetry Special' of the Sharp Review. Submissions for the Wall
should be sent to writers@socs.nuigalway.ie before 15th February

Writing Workshop » IT 206 on Wednesday, 22nd of February.

Prose Workshop » IT 206 on Wednesday, 22nd of February.

Live poetry competition with experienced judges and great prizes.

Poetry Slam! » Fottrell Theatre, AMB on Thursday, 23rd of February.

General Meeting » AM 104 on Wednesday, 8th of March.

Murder-Mystery Weekend » Achill Island on Friday, 10th of March.

General Meeting » AM 104 on Wednesday, 15th of March.

The Walworth Farce » Town Hall Theatre on Monday, 20th of March.

Committee 2005/2006

Auditor: Shannon Reeves Vice-Auditor: Ciara Banks
Treasurer: Fiona Gillespie Secretary: Teresa Mooney
SDO: Dara Cussen PRO: Ruth Hamilton

OCM: Eoin Shaughnessy OCM: Maeve Naughton
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Vice-Auditor: Matthew Burke

Committee 2006/2007

Auditor: Shannon Reeves Vice-Auditor: Ruth Hamilton
Treasurer: Fiona Gillespie Secretary: Dara Cussen
S.D.O./P.R.O.: Liz Riedy Vice-Auditor: Dave Rock

Writers Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance 703.58 Bank charge €26.91
Fundraising €20 Dinner €73
Muscailt €1050 Entertainment €326.35
Socs box €831.5 Entry fees €12
Sponsorship €650 Hire Bus €700
USC Grant €1540 Non Alcoholic Refresh €50
Printing €1380
Prizes €360
Reception €254
Society accommodation €1050
Speaker accommodation €50
Speaker travel €33
Teacher fees €500
Expenditure Total €4815.26
Closing Bank Balance €-20.18
Total €4795.08 Total €4795.08

Other Information
We held 12 committee meetings during the year and we have held our AGM. Our total membership stands at
300 members.

Young Fine Gael Society

The year began in September with a successful Societies Day with a large increase in membership from the
previous year. In total we signed up 184 members. We had our first meeting in our new room AC 203
with the new Committee and new members introducing themselves. Fearghal Ryan was elected onto the
Committee as a 1st year rep. In October we were visited by two prominent public representatives, two
Roscommon Fine Gaelers. John Connor, President of the Irish United Nations Association, visited us. He
spoke about the "The Importance of Irelands membership of the U.N". on a largely successful evening. The
following week Senator Frank Feighan spoke about "The state of small business in Ireland today". At this time
Michelle Perry and David Mc Donagh were co-opted onto the Committee.

Towards the end of October we had and interesting discussion on Civil Unions which brought great debate
amoungst those in attendance. The General consensus appeared to be that they should be allowed but with
certain limitations on adoption and personal rights. The President and Vice President of Young Fine Gael; Pa
O'Driscoll and Lizzie Munnely respectively also visited the branch .
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A major event of the year was the "Suicide Awareness Seminar"” held on Tuesday November 8th. The event
was held as part of the YFG organised TALK campaign. A sub committee chaired by Michelle Perry made the
event a great success. YFG National Panel Member Conor Cresham gave his personal account of the impact
Suicide had on himself and his family. Carlow Senator Fergal Browne spoke of the efforts of the Joint
Committee on Mental Health of which he was a member of. A representative of the efforts of The Samaritans
stressed the importance of talking or even listening to someone who appears depressed. Some 80 people were
in attendance.

As Christmas approached, We had our last major meeting of the calender year. Sean McKiernan, member of
the Fine Gael National Executive spoke on "Fine Gael's policy regarding neutrality". There was also a
Christmas Party held, organised by Keith Stevens in late November. There was a great crowd in Murty
Rabittes that night. People travelled from places such as Limerick and Letterfrack for and excellent party.

Semester Two commenced with Societies Day Two where we attracted a further 20 members.

As the National Conferance approached, two members of the branch sought a nomination to run for the
National Executive of Young Fine Gael. Sean Filan was proposed and seconded for the position of
Connaght/Ulster Regional Organiser. David Mc Donagh was proposed and seconded for candidature for the
national Panel. Meanwhile we discussed possible policy motions we could submit for the National Conferance.
An Interesting discusion on "Mandatory Irish for Leaving Cert" was held. The General opinion of the people
assembled was that the system of teaching Irish was failing and needede to be revised. There were mixed
opinions on whether It should be compulsory for Leaving Cert or not.

Over the next two weeks, bringing us into the start of February, the Presidential and Vice-Presidential
Candidates visited the branch to state their intentions. Firstly, the two presidential candidates, John Fitzpatrick
and Lizzie Munnelly adressed the floor and faced probing questions. The following week, the three Vice
Presidential Candidates: Maurice Fitzgerald, Simon Harris and Barry Walsh gave their cases.

The next important event was the visit of Gerry O' Connell, Vice President of Fine Gael and former auditor of
NUIG YFG. He spoke on "The legacy and relevance of Michael Collins". It was a very successful night. Derrick
Geraghty was co-opted to the committee around this time too.
The following week, party leader Enda Kenny T.D returned to the Branch once more. He spoke on his "vision
for Ireland"” but also answered many questions from the assembled. There were 146 people at the meeting.

The National Conferance in the Ramada Hotel at Limerick Juction brought great success for the branch. Three
of our members were elected to the National Executive; Sean Filan to the position of Connaght/Ulster regional
organiser with David Mc Donagh & Keith Stephens elected to the National Panel.

In the last month or so, further speakers have adressed our branch. Clir. Michael Fleming spoke about "The
Undocumented Irish in America". Denis Naughton T.D spoke on "Rural development throughout the B.M.W
region”. The following day Senator Brian Hayes gave an account on "How Seanad Eireann needs to be
reformed"”. Monday week last Jim Higgins M.E.P spoke about the European Parliament and "The direction the
European Union is going in".

As the race for committee Positions was coming to the boil, a hustings was held. The then four candidates in the
race to become auditor: Lorcan Gearty, Emily Hughes, Michelle Perry and Fearghal Ryan responded to
questions from Chairperson Paul Hickey and a few other members. On the 29th of March we held our A.G.M.
It was extremely successful. 14 Committee positions were filled with Fearghal Ryan being elected Auditor for
06/07.
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Young Fine Gael Soc Events

This year the society had a total of 26 events that took place.

Young Fine Gael Meeting ran for 12 weeks in AC 203, beginning on Wednesday, 11/1/2006.
Visit of President of Young Fine Gael » AC205 on Wednesday, 26/10/2005.

Visit of Pa O'Driscoll and Vice President Lizzie Munnelly

Suicide Awareness Meeting » Dillon Theatre on Tuesday, 8/11/2005.

Suicide Awareness Meeting

Visit of Sean Mc Kiernan » AC 203 on Wednesday, 16/11/2005.

Debate on future of Irish Neutrality

Debate on Irish Language » AC205 on Wednesday, 18/1/2006.

Debate on Irish Language

Visit of Gerry O'Connell » AC 203 on Monday, 6/2/2006.

Addressed us on significance of Michael Collins

Hustings Presidential Candidates » AC2714 on Wednesday, 8/2/2006.

Lizzie Munnelly and John Fitzgerald debate as the Natioal Conferance and the Presidential election draw closer
Visit of Gerry O'Connell » AC 203 on Wednesday, 15/2/2006.

Adressed us on significance of Michael Collins

Hustings Vice-Presidential Candidates » AC205 on Wednesday, 15/2/2006.

Simon Harris, Maurice Fitzgerald and Barry Walshe debate

Enda Kenny visit » Darcy Thompson theatre on Monday, 20/2/2006.

Fine Gael Leader Enda Kenny T.D. will discuss his vision for Irish Goveranance after the 2007 general election.
Questions welcomed afterwards. Reception afterwards in Murty Rabbitts (Foster Street). All Welcome to attend!
National Conferance » Limerick Junction on Friday, 24/2/2006.

National Conferance Huge Success

Visit of Michael Fleming » AC 203 on Wednesday, 8/3/2006.

Disscusion on Irish lllegal Immigrants in America

Visit of Senator Brian Hayes » AC 203 on Monday, 13/3/2006.

Debate on Future of the Seanad

Visit of Denis Naughton T.D » AC2714 on Tuesday, 14/3/2006.

Disscusion on Rural Development

Visit of Jim Higgins M.E.P » AC2174 on Monday, 20/3/2006.

Debate on Future of E.U

Committee 2005/2006

Auditor: Paul Hickey Vice-Auditor: Ultan Hayden

Treasurer: Etain Finn Secretary: Lorcan Gearty

First Year Rep: Fearghal Ryan 0.C.M: David Mc Donagh

Membership Officer: Lisa Maher Asst. PRO & Web Designer: Emily Hughes
0.C.M: Derrick Geraghty Joint Treasurer: Chris Cormican

Asst. Secretary: Paul Stanton 0.C.M: Michelle Perry

Campaigns & Events Officer: Keith Stephens Connacht/Ulster Rep: Sean Finan

PRO: David Miskell Policy Officer: Martin Nally

Organiser: Brian Flannery

Committee 2006/2007

Auditor: Fearghal Ryan Vice-Auditor: Lorcan Gearty
Treasurer: Gary Beirne Secretary: Padraig Fallon

0.C.M: Killian Harrington 0.C.M: Lisa Maher

0.C.M: Cathal Masterson Social Secretary: Cian O'Neill
Campaigns Officer: Emily Hughes Membership officer: Maire Spillane
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Corresponding Secretary: Michelle Perry P.R.O: David Miskell
Postering Officer: Jonhaton Pilkington

Young Fine Gael Society Balance Sheet

Income Expenditure

Income Category Amount Expenditure Category Amount

Opening Bank Balance 1373.55 Affill/lMem fees €385

Members Contributions €597 Dinner €462

Sponsorship €804 Entry fees €100

USC Grant €1885 Fundraising/charity €1232
Non Alcoholic Refresh €120
Reception €60
Society accomodation €1205
Society transport €700
Speaker accomodation €155
Speaker travel €40
Expenditure Total €4459
Closing Bank Balance €200.55

Total €4659.55 Total €4659.55

Other Information
We held 21 committee meetings during the year and we have held our AGM. Our total membership stands at
184 members.

Young PDs

This year was the inaugural year of the NUI Galway, Young Progressive Democrats. As a young society a lot of
ground work was covered this year to establish the society with the help of to many people to mention. Our main
focus was to raise our profile on campus by providing an opportunity for students to meet senior members of
government. We also worked to provide a forum for discussion on issues which effect students and explore
possibilities of raising awareness of identified issues.

Young Progressive Democrats Events

This year the society held a total of 3 events.

Inaurgual Meeting of YPD's » The Quad on Friday, 17th of February.

The inaugural meeting of the NUI, Galway Young Progressive Democrats, hosted by Minister for Justice, Michael
McDowell.

Coffee With An Tanaiste » Siobhan McKenna on Friday, 17th of March.

Come meet An Tanaiste Mary Harney over coffee and biscuits. Informal event hosted in conjunction with the Political
Discussion Society.

National Party Conference 2006 » Limerick - SouthCourt Hotel on Friday, 21st of April.

We are delighted to announce the Progressive Democrat National Conference, in the SouthCourt Hotel, Limerick, from
21st - 22nd of April. Arriving on Friday evening - so you won't miss college! All travel and accomodationodation is
FREE! Please contact the society if you would like to attend
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Committee 2005/2006
Auditor: lan Jacob Vice-Auditor: Conor Herlihy
Secretary: Martina Callanan

Committee 2006/2007
Auditor: lan Jacob Secretary: Martina Callanan

Young PD’s Society Balance Sheet

Income Expenditure
Income Category Amount Expenditure Category Amount
Opening Bank Balance €0 Non Alcoholic Refresh €66.4
Greenform €66.4 Travel €48.0
USC Grant €48.0 Expenditure Total €66.4
Closing Bank Balance €0
Total €1144 Total €114.4

Other Information
We held 8 committee meetings during the year and we have held our AGM. Our total membership stands at 42
members.

The Zoological Society
NUI Galway's Zoological Society caters for those who have an interest in Zoology (undergraduate, postgraduate
and staff)and Natural History in general. We host a variety of events each year including talks, field excursions
and social events.

Zoological Soc Events
This year the society held a total of 6 events.
Evolution Lecture » Seminar Room, MRI on Thursday, 2nd of March.

Zoosoc seminar » Siobhan McKenna theater on Thursday, 9th of March.
"Can there be a science of animal welfare?" A talk by Prof Marian Dawkins, University of Oxford. Wine and nibbles
afterwards

Zoosoc seminar » MRI Seminar room on Thursday, 16th of March.

Zoosoc seminar » MR/ Seminar room on Thursday, 23rd of March.

Zoosoc seminar » MR/ Seminar room on Thursday, 30th of March.

"Biodiscovery and sponges" A talk by Dr Grace McCormack, NUIGalway

Dolphinwatch » Shannon estuary on Sunday, 9th of April.

A fieldtrip to carrigaholt, Co. Clare to go dolphinwatching. Leaving from the quad at 8.30am. Returning at 6pm latest

Committee 2005/2006

Auditor: Ricky Whelan Vice-Auditor: Rebecca loftus

Treasurer: Conall Hawkins Secretary: Ishla Seager

PR: Noelle McMahon Postgraduate rep/web Consultant: Alan Poole
PR: Joseph Cawley Staff Treasurer: Dr Colin lawton

PR: Caitriona Meaney PR: Anna Buyan

PR: Niamh McMahon
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Zoological Society Balance Sheet

Income
Income Category Amount
Opening Bank Balance 0.07
Balls €85
Socs box €42
USC Grant €250
Total €377.07

Other Information

Expenditure
Expenditure Category
Affill/lMem fees
Bank charge

Returned Money

Expenditure Total
Closing Bank Balance
Total

Amount
€300
€3.38
€42

€345.38
€31.69
€377.07

We held 8 committee meetings during the year. We have not held our AGM yet. Our total membership stands at

203 members.

107



USC Committee 2005-2006

Chairperson Sr. Avril O'Regan
Societies Chairperson: Damien Corridan
Student Reps:

Departmental Societies: David Geary
Artistic and Performing Societies: Jessica Touhy
Debating and Politics Societies: Robert Rooney
Social and Gaming Societies Rory Donohue

Social Action / Religious Societies: Kieran Emrich :

Staff Representatives
Gar Hartigan (Buildings Office)
Maire Aine Mannion (French dept)
Tim Higgins (Chemestry Dept)
Fionualla gallagher (Arts Officer)

Secretary: Riona Hughes Societies Officer
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NUI Galway Society Annual Awards

The Society Awards were adjudicated by the USC with 139 applications from the societies for the fourteen
possible awards received. The Societies Ball & Awards Ceremony was held in the Galway bay Hotel on Wed
March 29th. A fabulous night was had by the 300 who attended, if the dancing into the small hours is anything to
go by. The night started with music from Choral Society as the crowds made their way down to the Banquet Hall.
Film Socs's film short 'Clown Project' by Henry Martin was shown on the big screen. Choral Soc then took to the
stage and treated the enraptured audience to some beautiful harmonious singing. Then the hungry mob
descended on the sumptuous buffet. During dinner the Documentary on the AIB NUI Galway Event of
Excellence Award was shown. We were joined on the evening by representatives of the AIB who had so
generously sponsored the Event of Excellence Award and who have also sponsored the SocsBox for the year.
Fionnuala Gallagher, Arts officer, presented the Muscailt Awards.

Best originality went to Archaeology for Artaeology-bringing relics to life,

Best Impact went to Trad Soc for their week-long sessions in Smokey Joes and

Best innovation went to Film Soc for their Film Festival in a mobile cinema.

The Societies awards followed and were presented by Vice president Mary O'Riordan and Susanne from Bank
of Ireland who along with CKI and ALIVE were the sponsors of the Society Awards. Thanks to both of them for
making the night possible.

Best small publication went to Fansci for their ITZACON Brochure,

Best Large publication went to Art Soc for their Lunatic Fringe Comic Book,

Best Departmental went to French Soc,

Best Cultural Contribution went to Art Soc for their 'Stranger than Paradise' Exhibition,

Best Intervarsity went to Law Soc & Lit and Deb for the National law Debates.

Best Poster went to Art Soc for their Exhibition poster,

Best Charity Event went to VSA for their halloween Ball,

Best Website went to Juggling Society,

Best New Society went to Business Society,

Best Improved went to GIG Soc,

Best Fresher went to Andrew Murphy of Young Greens,

Best Event went to Slainte Soc for the Teddy Bear Hospital,

Best Individual went to Donna Cummins of Lit & Deb and Slainte Soc.

Best Society went to Juggling Society.

Congratulations to all the winners and to all the societies who submitted the over 120 nominations.

MC's for the evening were Riona and Damien.

Following the excitement of the Awards the Dansoc Irish Dancers took to the floor in a spectacular standing
ovation inducing display of rhythmic aerobatics to rival michael Flatley and Jean Butler at their peak.

Music was then provided by The Guinness Jazz band and DJ Pete and the dancing went on uninterruped until
2.30am.
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BICS National Society Awards

BICS National Society Awards NUI Galway Societies came out on top with three major wins. Best Society went
to The NUI Galway Juggling Society who exemplified all that is best in societies from passion to organization to
promotion of skills and the creation of a vibrant community of members who contribute not only to campus life
but to the wider community, they had an exceptional year under the leadership of auditor Brian McGinley (Phd in
Engineering)

Best New Society went to Business Society who only in their first year have run an extraordinary number and
variety of events and have made a significant contribution to campus life under the auditorship of David Keane
(final year corporate law).

Best Society Individual went to Donna Cummins (second year medical student) who is not only incoming auditor
of the Literary and Debating society, which had a very successful year including hosting the Irish Times Final.
Donna was also instrumental in forming the new Slainte Society who ran the wonderful Teddy Bear Hospital
which saw students of medicine interact with local children.

The remaining NUI Galway candidates who had won at the Galway Society Awards were Best event; Teddy
Bear hospital, Best improved GIG (Gay in Galway) society. Best fresher was Andrew Murphy of Young Greens
Society, All of whom were complemented by their respective judges for their high standard. Best poster was
from Art Soc and Best Website juggling Society. Riona Hughes, NUI Galway Societies Officer and Vice-
chairperson of BICS described the Universities victory as “a recognition of the high standard of the societies in
NUI Galway and the commitment of their very talented and generous members who add immeasurably to the life
of the campus and to Galway city.”

The remaining six BICS awards winners were Best Society in a small college: CIT International Students’
Society, Best improved Society: DCU Saint Vincent de Paul Society, Best Society Event: DCU Style Society for
DCU Fashion Show 2006, Society Fresher: Breege Clarke NUI Maynooth. Best Poster: DIT Artichoke Society
and Best Website: DIT LGBT Society for www.ditlgbt.com

The BICS (Board of Irish College Societies) National Awards, was hosted by Cork Institute of Technology on
April 13th in the Rochestown Park Hotel. The gala evening celebrated the enormous contribution societies and
their members make to the social, cultural and humanitarian life of their respective campuses. Societies offer
their members the opportunity to acquire very valuable life skills, which complement and enhance their
academic programmes and produce well rounded graduates ready to make significant contributions to the wider
community.

Representatives from CIT, DCU, DIT, IT Tallaght, NUI Galway, NUI Maynooth and UCC were present on the
evening. They all presented portfolios and attended interviews during the rigorous process. So important is the
evening that one hundred and seventy society members from forty-one societies were present at a very busy
time during their academic calendar. Mr Mervyn O’Mahony, CIT Societies Officer and awards coordinator
described the evening as “the highlight of the Societies calendar and a wonderful opportunity for the best in the
country to meet and share ideas”

Special guest for the evening was Mr. Pat Cox, former President of the European Parliament, who presented the
nine awards to the winners. During his opening speech Mr Cox praised the members of third level societies and
expressed the opinion that everyone present was a winner by virtue of engagement and that societies offered
their members the opportunity to turn the knowledge they have internalsied into good for their communities. He
warmly welcomed BICS and said how proud Cork was to host the prestigious event. He went on to encourage
the students present, whom he described as young Europeans, to avoid cynicisms in relation to what the EU has
achieved and take pride in the fact that it is now the largest donors of non military assistance and encouraged
those present to become engaged in an Erasmus of solidarity to use their gift of education for the greater good.
Europeans should take pride in the fact that its enlargement promotes the re emerging democracies and gives a
focus for transformation. It is the first time in history that the subcontinent is united and driven by the free will of
free and sovereign governments. His speech was met by a resounding standing ovation.

BICS is a national organisation, constituted in 1995, dedicated to providing a national forum for the societies in
Ireland's Universities, Colleges and Institutes of Education. The Board is responsible for the promotion of
interest in the activities of Irish college societies and of contact and co-operation between them. Website
www.bics.nuigalway.ie.
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AIB NUI Galway Event of Excellence Awards Winners

The new ground breaking initiative between AIB and the Societies Office to promote and support the valuable
work of the societies was a very exciting development for the hardworking society committee members. The aim
of the award was to support the societies in organising events of social, cultural, humanitarian and educational
importance which enhance the community and enrich the society experience. Twenty three societies
participated with six societies receiving a bursary for their event.

1st place - The Political Discussion Society for it's Schools Programme (€800)
2nd place - The Choral Society for it's Sean Fhocail (€600)

RUNNERS UP FOR EVENT OF EXCELLENCE: (€400 each)
Muslim Youth - Islamic Cultural Week
Labour Youth - Workers Rights Awareness week
Film Society - Film Festival
Comp Soc - Youth Outreach Programme
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Society Total Income & Expenditure

Societies Balance Sheet — June 2005- May 2006

Income Expenditure
Income Category /Amount Expenditure Category JAmount
Balls €131,875.44 AffilllMem fees €11,854.66 2.11%
Fundraising €151,015.17 Ball €120,889.34 21.53%
Greenform USC direct

payments €11,581.26 Bank charge €902.22 0.16%
Members Contributions €40,281.38 Costumes €5,353.18] 1.86%
Muscailt €7,988.85 Dinner €21,868.15 3.90%
Socs box €17,265 Entertainment €15,586.48 2.78%
Societies day €5,166.87 Entry fees €17,786.36 3.17%
Sponsorship €64,183.14 Equipment misc €6,995.56) 1.25%
Ticket Sales €16,855.72 Fundraising/charity €184,274.51 32.82%
USC Grant €129,437.52 Gifts €2,161.49 0.39%
Hall hire €5,600 1.00%
Hire Bus €3,011.45 0.54%
Lights €713.60 0.13%
Makeup/Props €1,213.46| 0.22%
Materials €10,810.46 1.93%
Non Alcoholic Refresh €2,705.58 0.48%
Performing rights €4,163.46 0.74%
Phone €420 0.07%
Printing €10,292.31 1.83%
Prizes €9,634.21 1.72%
Promotions €4,340.46 0.77%
Reception €17,046.38 3.04%
Set €2,326.61 0.41%
Society accomm €32,396.47 5.77%
Society transport €41,106.23 7.32%
Socs day expenses €495.88 0.09%
Sound €3,063.50 0.55%
Speaker accomm €8,592.82 1.53%
Speaker travel €4,254.52 0.76%
Stationary €751.51 0.13%
€575,650.35 Teacher fees €10,809.29 1.93%

Income Total €577,550.48 Expenditure Total €561,420.15

Closing Bank Balance

Opening Balance Total €60,228.60 Total €74,026.70

Cash In Hand Total €432.10]

Total €635,878.95 Total €635,878.95)
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MUSCAILT NUIL, GALWAY SPRING FESTIVAL
20-25 February 2006

REPORT

Mduscailt/Awakening

Report from Fionnuala Gallagher, Arts officer, NUI Galway.

Introduction

The 2006 Muscailt Spring Festival in NUI, Galway was financially supported by the Foundation Office, The Arts
Office, NUI, Galway and The Arts Council. The SocsBox/Ticket Desk was supported by the AIB.

The Artistic Directors are Fionnuala Gallagher, Arts Officer and Riona Hughes, Societies Officer assisted by
Andrea Fitzpatrick, Arts office and the Socs Box Staff. The programme represents a strong vibrant mix of
professional artists/musicians/writers alongside the original and exciting societies events that highlight the
creativity and talent on campus.

For Muscailt 2006, the Arts Office in association with the Societies Office endeavoured to strengthen existing
structures and staples e.g. the one act original play series and further develop visual art initiatives and
interactive events. There is a growing interest in Film on campus and this was included and highlighted with the
arrival of the mobile conema on campus as our very own venue/showcase. Dance is also a growing
phenomenon on campus and original pieces were commissioned for the unique opening event in the Bank of
Ireland..

Key Developments of 2006:

(1) The Arts Council awarded the Muscailt Festival €6000 under the Small Festivals Awards Scheme. This is an
important recognition and will allow Muscailt to grow significantly.

(2) The Jerome Hynes Inaugural Award for Best One Act Play served to highlight and deservedly credit the one
act original play series that proves each year to be a stalwart of the festival and a critical moment for defining
new talent in playwrighting, directing and acting within NUI, Galway.

(3) The Aisling Gheal, the mobile cinema was invited onto campus to provide a singular venue for film and a
momentous and inaugural occasion for filmsoc and their original films produced with in-house equipment and
facilities.

(4) The Arts Office commissioned a dance piece by Tanya McCrory in collaboration with ConTempo String
Quartet, Galway Ensemble in Residencefor the opening event. ConTempo played live and Tanya McCrory and
Esti Siles performed 3 original pieces in response to the music of Alec Roth.

(5) There was a parade on campus with MacTeo with an insect theme for Spring that ended in a drumming
event sparked off by Sculptor John Coll and his bodhran.

(6) Outdoor Visuals were on display i.e. Pat Comer’s large black and white photographs in the Quadrangle
(7) Interactive Exhibitions:

-Artaeology Relic-making where the public were invited to make a relic from materials provided

-Doodle Day-Artists Kathryn Crowley and Cindy Anderson set in motion a giant outdoor doodle fest with giant
chalks on the Friday.

(8) Impromptu Music Sessions
Tradsoc played at Smokeys. Buskers popped up everywhere on Busking day.

Description of Arts Office events
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Press Launch

ConTempo String Quartet, Galway Ensemble in Residence played,

Tooth and Nail Theatre Company performed an excerpt from The Bed | Make, a new piece for Muscailt.
President lognaid O’ Muircheartaigh welcomed everyone and introduced guest speaker alumnus and renowned
Sculptor John Coll who gave a rousing speech to launch the Muscailt 2006 Programme. Refreshing colourful
drinks, strawberries and chocolates were served.

Opening Event

*Carnival Parade around campus featuring Town Crier, Insects, Queen, Drummers inviting everyone to come to
Aras na MacLéinn, outdoors at 1.15pm

*Tanya McCrory and Esti Siles performed 2 original dance pieces to music by Alec Roth performed live by
ConTempo String Quartet in the Bank of Ireland Theatre 1pm. Stunning visuals, fresh original choreography
commissioned from Tanya McCrory especially for Muscailt 2006.

*John Coll officially launched Muscailt beside his sculpture Céiluradh and with his bodhran started off the
MacTeo Drummers.

*Muscailt Monster Mash

Fancy dress party in Student Bar 9pm with music from Ghostwood Project and Ghostly projections followed Irish
Zombie movie in Cinemobile.

Aisling Gheal Cinemobile on Campus

Jointly organised by Arts office and Societies Office, the programme included Irish films, American Films,
Experimental Films, Children’s films, original in-house NUI, Galway Filmsoc short films.
The Two-day programme included:

*The Banshee Lives in the Handball Alley

*Darklight Film Shorts

*Goldfish Memory

*Dead Meat

*Mad Hot Ballroom

*Howls Moving Castle

*A History of Violence

*Short and Bitter sweet Programme of New Shorts by Filmsoc premiéered:

Concerts

Emer Mayock and Band, renowned flautist and uilleann pipe player with her own contemporary style performed
a scintillating concert in the Aula Maxima Lower accompanied by Donal Siggins, strings and Robert Harris,
percussion.

Music for Galway-Stephen Kovacevich, piano. Evening concert.

Art Exhibitions, Visual Arts, Performance

Jake Malone, Other Worlds, new paintings, Art Gallery
Extremely colourful, gallery was buzzing all week.

Pat Comer, Same, same but different. Outdooor black and white photographs hanging in Quadrangle. Elegant
and striking from the archway. Provided a backdrop for events in the Aula.

Mary Dempsey, What happened, new sound installation in Archway of Quadrangle with reference to Porter’s
Desk. Reminder of Archway as meeting point.

Declan Shelvey, Killing Heroes, Friars Restaurant. An excellent draughtsman, Declan’s work is current and
interesting. Unfortunately he did not mount and frame the work as was planned and so effect was disappointing.

Kathryn Crowley, Here and There, Kathryn had many plans to create a changing mandala work using natural
materials by the Yellow X, have surprise pieces of art in unusual places and hold a doodle day. The Yellow X
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was cleaned and flowers were planted in the concrete boxes by the Yellow X but the mandala did not happen
due to inclement weather. Instead, Kathryn ploughed her energy into colourful pieces in the trees by Aras na
MacLéinn and gathering materials and promoting what was a hugely successful doodle day on the Friday with
giant chalk drawings and writings decorating the area outside BOI and the Library.

Dominique Mayer, Higher Ground ,Large collages on display looking out from Parking and Information office on
Arts and Science Concourse. Good feedback.

Danny McCarthy, (International Sound Artist), Beyond the threshold of Quite, Performance in Art Gallery,
Lunchtime.

Also illustrated talk, Listen Out Loud in Siobhan Mckenna at 4pm same day. Cross-section of Galway public
attended.

Nigel Rolf (International Performance Artist) Recent Work, an illustrated talk in the
illuminating discourse on origins and attitudes/changes in performance art in Ireland as told by a veteran.

Live Impromptu Performance on Campus

Tradsoc were hired to perform at Smokey Joes at lunchtimes throughout the week. This proved highly popular.
Buskers/Jugglers/Artists performed all over campus.
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Muscailt 2006 Societies Report

Report from Riona Hughes Societies Officer

Muscailt *06 captured the imagination of the Societies, which was evident from the breath
and scope of the events which they organised. Now in its sixth year the festival has matured
and is without doubt the highlight of the artistic and performance societies year. Planning
began early in September and the societies embraced Muscailt as their own. The
combination of home grown talent and the caliber of the invited guests made this one of the
most vibrant festivals to date which according to many independent observers brought
unprecedented life, joy and excitement to the campus. As most of the events were free the
festival was accessible and open to the university and the wider community who joined us
for the week of celebration. The festival is a co-production of the Arts office and the
Societies office with the generous support of the Foundation office and this year for the first
time the Arts council. In addition to this generous sponsorship the Societies were also
successful in raising additional funds and with a healthy box office the festival fared well
financially. The Societies SocsBox in the Hub, acted as information and ticket desk for the
week and thanks are due to the AIB for their sponsorship of the facility.

Society Events:

Drama & Performance:

Dramsoc One act play series. This year for the first time the society took on the challenging
role of producers for the event which included 10 plays over three lunchtimes with an
Omnibus edition on the Friday night. There was capacity attendance at each of the dates and
the standard of the productions was excellent. This year the Alumni Office introduced the
Jerome Hynes memorial trophy for the best play. The productions were adjudicated at the
omnibus edition and the winning play was ‘Basin of Myself” by Henry Martin which is also
being produced as part of project 06. The Hynes family were also present for the award
ceremony which took place at the end of the Omnibus edition. The Alumni office presented
a specially commissioned sculpture by John Coll to the winner. Adjudicators for the evening
were Brendan Murray IDAA, Ron McFeeley Dramsoc Auditor and Riona Hughes. There
was a feed back session after the award ceremony which the participants found very
valuable. The plays were all original written by students, four from the MA in Drama and
Theatre, three from the MA in Writing and three from undergraduates. The process included
a daylong workshop at the start of the three week rehearsal period where all the plays were
read and feed back given.

The productions were:
‘Mary Hegarty Last Mass’ by Shona Mccarthy
‘Basin of My self by Henry Martin
‘Strings’ by Daniel Golden
‘Authors V Characters = Play’ by Thomas Gaffney
‘Empty’ by Candace Driskill
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‘More Dears Than Tears’ by Cliona deBri

‘Tell Tale Tattlers’ by Naomi Moran

‘The Ache’ by Bridget Deevey

‘Earthed’ by Deirdre Sullivan

‘Frozen’ Terry Dineen

Omnibus Edition with award ceremony and wrap up party.
Dramsoc also produced ‘Checkers’, a humerous one act play, directed by Lauren Mikov, an Erasmus student
which was written by one of her fellow students from her home university.

The Fansci Society had a very busy week performning ‘Sandman’ a dramatic adaptation of Neil
Gaiman’s graphic novel directed by Yeolanda o’Brien and performed by a cast of twelve to a large

appreciative audience.

They also performed ‘Men at Arms’ & ‘Guard Guard’ excerpts from Terry Pratchett's Radio-plays 'Guards
Guards' and 'Men at Arms' adapted by Stephen Briggs. Both plays were also produced by the society as radio
plays and were aired on flirt FM. Directed by are Edel Crowley and Padraic Murphy.

An Cumann Dramaiochta Feile na gColaiste.

This two day long event will feature productions from Irish colleges in two venues, culminating with the award
ceremony in Aras na Gaeilge. The festival was organised in conjunction with An Comhlachas Naisunta and was
judged by Brid O’Gallachoir. The plays were:

‘Oiliunt Skinny Spew & Na Cloigne’ le Howard Brenton, Cumann Dramaiochta NUI Galway.

'Greasain’ le Neasa Ni Dhomhnallain, Aisteoiri na Triondide

’Comhluadar’, An Cumann Dramaiochta UCC

'Cogarnail na Pise’, An Cumann Dramaiochta UCC

‘Na Tri Bridies’ -An Cumann Dramaiochta UCC

‘Glér Iseal’- Na Haisteoiri lldaite, UCD

’An Buachaillin Ban’ le Témas 6g 6 Cheilleachair An Cumann Dramaiochta St. Marys Belfast

‘Eile’ le Breandain mac Gearailt, An Cumann Dramaiochta, Colaiste Phadraig, Droim Conrach.

The Musical Society performed a wonderful production of ‘The Little Shop of Horrors’ in the Black Box Theatre.
The production sparkled with a large talented cast, musicians and back stage crew. This year the production
took place the week before the festival to facilitate members of the production attending the events during the
week. The Musical society and Dramsoc went head to head during Muscailt when the Musical crew took on
Shakespeare and the Dramsoc tried their hand at all singing and dancing with hilarious consequences.

The Juggling Society were to be seen impromptu Juggling throughout the week with the highlight of their week
a spectacular outdoor extravaganza which attracted a large appreciative audience.

Members of the Comedy Society presented an evening of original sketches and standup to a very amused
audience.

Visual Art:

Visual art was in abundance with the Art Society colourful exhibition ‘Stranger then Paradise’ which displayed
the fruits of the societies biweekly classes and also saw the society launch their imaginative comic book ‘Lunatic
Fringe’ which was a new departure for the society.

The photographic Society exhibition Focus '06 took place in the student centre and was launched to the
strains of the Orchestra society quartet and displayed works by the society members, many of the pieses having
been developed in the societies own darkroom.

The Archaeology Society explored heritage and relics in their delightful Artaeology project by providing the
materials and the inspiration and inviting passers by to involve themselves in the creative process. The society
set up a table in the student centre and proved very popular with the results of the artistic endeavours proudly
displayed.

Film:

One of the undoubted highlights of the festival was the arrival of a mobile cinema from Co Leitrim which housed
a two day film festival featuring an eclectic mix of Irish and international films and ‘Short and bitter Sweet’ a
collection of five new films written directed and produces by the Film Society. The line up included Film Shorts
from Darklight, Irish made films; ‘Gold Fish Memory’ directed by Liz Gill, ‘The banshee lives in the Handball
Alley’ by Michael fortune and Aileen Lambert, ‘Dead Meat’ by Conor O’Mahony. International features included
French language feature ‘Le grand Voyage’ directed by Ismael Ferroukhi, ‘A History of Violence’ directed by
David Cronenberg ‘Howls Moving Castle’ Japanese animation directed by Havao Miyazaki and ‘Mad Hot
Ballroom’ directed by Marilyn Agrelo. The Film Society also ran a workshop on how to make a low budget movie
for aspiring film makers.
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Music:

Music of all styles was in abundance throughout the week from the Societies, There were performances from the
Orchestra Society, the award winning Choral Society, both of which featured premiers of new works. the
newly formed French Society choir gave their first concert, and sessions from the Traditional Society took
place daily. The music Society ran the week long Witless festival which featured the grand final of the band and
solo competition which ran heats from the beginning of semester two and also a series of gigs during the week
in various locations and a vibrant Busking Day. The DJ Society organised ‘Battle of the DJ’s in which members
battled it out for the honour of representing the College at SPINOFF '06, the first All Ireland Intervarsity DJ Clash
in Dublin. The Students Union hosted the semi final of their talent show ‘So you think you’re famous’ the final of
which was held the following week during rag week.

Dance:
The Dance Society treated their appreciative audiences to tow performances of ‘Rhythm’ which featured a wide mix of dance

styles from the enthusiastic and talented members of the various weekly workshops.

Literature:

There was literature a plenty during the festival with two publications produced, edited and type set. ‘Criterion’
from Literary and Debating Society and ‘Limited Edition’ from the writers society. The ‘Criterion launch featured
special guest playwright and author Patricia Burke Brogan. The Writers Society ran a week long series of events
starting on the Monday with a literary evening which featured the launch of their publication with readings form
the winners of the writing competition and special guests Mike McCormack and Kevin Higgins. They also
organized a prose workshop, a poetry slam, unveiled their innovative poetry wall and hosted a wrap up party.

Miscellaneous:

One of the prestigious highlights of the week was the Literary and Debating Society hosting the Irish times
Final, the two day event saw top debaters from Irish third level battle it out for the all important title.

The Quiz Society intrigued and confused a lively audience in the College Bar with their intriguing Muscailt table
quiz.
The Computer Society up dated the festival website at www.muscailt.nuigalway.ie.

The Societies are already planning for Muscailt '07.
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